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PREFAZIONE

Questo manuale è la seconda edizione di uno precedente, scritto inizialmente per uso 
personale dal sottoscritto, un utente come tanti, che poi, vista la buona riuscita, ha deciso 
di divulgarlo in modo che altri ne possano usufruire.
E’  infatti  esperienza  comune  che,  specialmente  all’inizio,  chi  si  avvicina  a  un  nuovo 
programma, di una certa complessità come questo, trovi difficoltà a proseguire nello studio  
specialmente se scritto in altra lingua, e spesso abbandona per insufficiente perseveranza.
Un manuale, già scritto nella propria lingua, poco prolisso, ma diretto al punto, può essere 
senz’altro un valido aiuto per non abbandonare la prosecuzione dell’apprendimento ed 
arrivare  al  termine,  con  la  soddisfazione  di  essersi  impadroniti  di  un  nuovo  potente  
strumento di lavoro. Il manuale inoltre offre la possibilità di rinfrescare, con una immediata 
consultazione, quello che, appreso in precedenza, si è nel frattempo già dimenticato.
Il  manuale è suddiviso in 13 capitoli,  di  cui  7 si  riferiscono ciascuno ad una specifica 
funzione che TARGET 3001 è in grado di svolgere ( Disegno dello schema, Simulazione,  
Disegno dl PCB ecc. ). Gli altri capitoli sono complementi e Appendici.
L’accesso ad ogni argomento è immediato: basta selezionarlo nell’indice, all’interno del 
capitolo di appartenenza e, con collegamento ipertestuale,  richiamarlo con un click.
Questo manuale non ha la pretesa di essere una guida completa, per la quale si consiglia 
la lettura dei testi originali di TARGET 3001, ma solo un aiuto alla partenza, scritto da “uno  
del gruppo degli interessati” che ha deciso di condividere “i propri appunti”.
Durante  il  lavoro,  ho  trovato  non  solo  utile  ma  anche  avvincente  il  programma  di 
simulazione SPICE integrato in Target. Dapprima fa un bel po’ confondere, finché non si è 
preso un po’ di dimestichezza. Un modo per avvantaggiarsi nel corretto impiego, è quello  
di decidersi finalmente a leggere almeno alcuni argomenti del manuale originale SPICE 
3F5 reperibile sul web che però è composto da almeno 300 pagine in inglese. 
Per questo, al fine di facilitare l’apprendimento e promuovere l’interesse, in appendice B 
ho inserito un estratto condensato per iniziare a usare subito SPICE 3F5, che stimolerà ad 
andare  oltre  nell’apprendimento  di  questo  formidabile  strumento.  Dopo  questa  lettura 
riusciremo facilmente  a  capire  perché  alcuni  modelli  non  ci  funzionavano,  li  sapremo 
correggere e importare. Addirittura sapremo anche scrivere noi stessi dei facili modelli e 
avremo la soddisfazione di vederli funzionare correttamente. 
La simulazione SPICE non è un passatempo. Si possono creare schemi anche complessi 
e vedere con stupore che la simulazione aveva predetto con ottima approssimazione i 
risultati  successivamente  ritrovati  su  circuito  sperimentale  montato  a  banco.  Diventa 
senz’altro un aiuto prezioso nella progettazione di nuovi circuiti in quanto la simulazione 
predice subito la correttezza del progetto. 
Seguono, sempre in appendice, alcuni esempi applicativi.
Nonostante  tutta  l’attenzione  prestata,  e  la  revisione  accurata  partendo  dalla  prima 
edizione,  sicuramente si  troveranno ancora errori  e distrazioni  sparsi  qua e là.  Me ne 
scuso e spero non siano poi così gravi. Sarò grato a chi, accortosene, vorrà comunicarlo 
al mio indirizzo paolo.pacini.0@alice.it

Firenze, Settembre 2013 Ing. Paolo Pacini
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                       1 - DISEGNO DELLO SCHEMA ELETTRICO

1.1 Abbreviazione del mouse e note preliminari: 
M1=Click sul tasto sinistro. M1h= Click sul tasto sinistro e mantenere premuto. M2, M2h lo 
stesso ma sul tasto destro. M12 entrambi premuti. M11 e M22 = doppio click.

Simbologia usata in questo testo per indicare una sequenza di istruzioni.
Es.: File > New Project > Immettere il nome. Significa: fare click sulla casella File, poi su 
New Project, quindi scrivere il nome nella apposita casella che appare.

Nota. In Target 3001 i decimali sono separati da una virgola. Nella simulazione è richiesto  
il punto. Per non cadere in confusione, usare sempre il punto, accettato in entrambi i casi..

1.2 Apertura di un nuovo progetto.
File > New Project > Immettere il nome
Poi  scegliere  il  tipo  di  progetto:  con  schema  elettrico,  oppure  senza  schema,  cioè 
direttamente il disegno del circuito stampato. Entrambe le possibilità prevedono la scelta 
singola o doppia faccia. Una volta fatta la scelta iniziale, non si può più cambiare durante il 
proseguo del lavoro.
Il progetto aperto, deve essere successivamente salvato File > Save project as... in una 
apposita cartella.
Suggerimento! salvare in una cartella contenuta all’interno del programma Target. Seguire 
il  percorso:  C.> Documents  and settings  > Proprio  nome personale già  impostato nel 
computer > Dati  Applicazioni  > ibf  > TarV16 > arrivati  qui creare la cartella “Progetti”. 
Aprirla e salvare il nuovo progetto. Lo scopo di salvare i progetti all’interno del programma 
Target è che se vengono salvati  altrove, durante la simulazione apparirà un fastidioso 
messaggio di errore ( giallo ) che non ci leveremo più di torno.  Il messaggio dice:  Hint:  
Some signal names or component names could cause problems for external simulators. 
Viceversa se salveremo il progetto nella cartella di target, e se il nuovo progetto è corretto, 
quando apriremo la simulazione apparirà un messaggio Assistant incorniciato di verde e 
un circoletto verde OK che informa che non ci sono errori.
Tutta  questa  operazione  di  salvataggio  all’interno  di  Target  può  essere  semplificata 
semplicemente con File > Save project as template. 

1.3 Griglia: 
M1 su simbolo dell’occhio sulla barra di  dialogo orizzontale.  M1 su icona della griglia.  
Scegliere il passo in pollici. Accettare il messaggio di immettere 25 mils, perchè altrimenti  
le linee non combinano col disegno di alcuni componenti. Vi è però un problema: se si 
inserisce ( tasto F5 )  la griglia a linea continua, il disegno sfuma e diviene poco visibile.  
Conviene allora scegliere la griglia a punti “ Grid as points” e il passo di 25 mils. Oppure 
vedi par.1.8.

1.4 Cursore a passi. 
Per legare il cursore alla griglia a passi di 25 mils ( o quelli impostati ) nella stessa finestra 
selezionare “Cursor snaps on grid”. Il cursore appare ancora muoversi in modo continuo e 
non a salti, ma i componenti vengono piazzati  a passi di 25mils ( o altro impostato ).

1.5 Cursore “Cross hair”
Per piazzare i  componenti  allineati,  è utile utilizzare il  cursore tipo  “cross hair”  ( croce 
sottile come capello ). Il cursore si trasforma in una croce sottile che permette di allineare i  
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componenti. Per attivare, premere F8 una volta. Due volte aggiunge anche una croce a 
45° e tre volte ripristina il cursore senza croce.

1.6 Piazzare i componenti 
( chiamati Symbols nel disegno dello schema, Package nel layout del PCB ).
Operazione per inserirli:

• Con icona  -  Click  su  icona  dell’amplificatore  operazionale  al  centro  della  barra 
orizzontale 

• Dalla tastiera - Premere “INS” sulla tastiera del computer. 
• Barra verticale di destra - Selezionare ( con M1 )  “Components”.  Scegliere ( con 

M1) l’icona del  componente che ci  interessa. Il  simbolo si  illumina. ( Se non si 
illumina premere Esc e fare click di nuovo ).

Si apre la grande finestra di dialogo  “Components” con le varie opzioni di ricerca. Tre Tab 
( linguette ) offrono tre diversi modi di ricerca : Quick select, Parametrical e Package
Quick select = ricerca veloce, si basa sulla scelta di una sigla da scrivere nella finestra 
“Search”. Nella parte bassa della finestra sono riportate tre immagini: lo schema elettrico 
del componente, la sua orma sul PCB e la sua immagine tridimensionale ( se esiste).
Parametrical = permette la ricerca sulla base dei parametri del componente. Utile ad es. 
quando si vuole selezionare un componente con caratteristiche specifiche, ad es.: che sia 
simulabile o con immagine 3D.
Package = ricerca basata sul package ( codice del contenitore ) del componente.

1.7 Connessione automatica di un componente
Quando  si  sostituisce  un  componente  con  un  altro  di  identica  geometria,  di  solito  i 
collegamenti non si congiungono automaticamente ai pin del componente. Per collegarli  
fare click due volte ( M11 ) su ciascun collegamento.

1.8 Intensificare il tratto del disegno dei simboli
Se il disegno dei simboli appare troppo tenue e non risalta abbastanza, è possibile 
intensificarne il tratto. Fare M1 sul simbolo dell’occhio, sulla barra orizzontale, e ancora M1 
sull’icona del cerchietto colorato. Appare la finestra di dialogo “Color setting” che offre 
varie possibilità di intervenire sui colori degli elementi dello schema, quali il colore dello 
sfondo ( background ), della griglia ( grid ) dei piedini ( pins ) dei collegamenti ( signal ) e 
dei componenti. 
In particolare per intensificare il tratto dei componenti, scegliere un colore più intenso di 
quello di default. Per.es.: si può scegliere il colore nero $000000 oppure $006600 che è un 
verde scuro piacevole nel disegno.
Altrettanto si può intervenire sul disegno del PCB, come riportato nella parte più bassa 
della finestra di dialogo.

1.9 Finestra del Package
Components > Packages. Nella colonna di destra sono elencati tutti i “packages” cioè il 
disegno delle orme degli involucri dei componenti sul piano del circuito stampato. Per la 
loro selezione, sono filtrabili tramite la scelta effettuabile nelle caselle sottostanti.
Name contains: seleziona il componente in base alle prime lettere del nome inserite nella 
casella.
La casella sottostante “All package types” seleziona il tipo di componente ( appare la lista 
dei tipi )
La casella  sottostante seleziona la  libreria:  From all  package list  cioè da tutte  le  liste 
disponibili  o appartenenti ad una specifica libreria, ad es.: alla sola Libreria Personale che 
avremo precedentemente creato.
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1.10 Le liste dei componenti 
Durante  il  lavoro  incontreremo  varie  liste  di  componenti,  come  My Component,  User  
component,  Libreia  personale  ,  ecc.  Cerchiamo  di  capire  che  cosa  sono  e  come  si 
distinguono tra loro.
Se si  apre la finestra  Components,  si  trovano, in alto a sinistra,  tre linguette:  Search, 
Component types and groups,  e Component list.
Apriamo Component list e troviamo varie liste di componenti: Recently used components,  
User components, New components, …ecc.
Queste liste di componenti che selezionano e distinguono separatamente la totalità dei 
componenti, sono state create per facilitare e velocizzare la ricerca di un componente, ma 
servono anche per comprendere il significato e riconoscere ciascuna di queste liste 
Se ad es.: ci occorre un componente che, ci ricordiamo di aver utilizzato di recente, invece 
di andarlo a cercare di nuovo nelle librerie generali  con grande dispendio di tempo, ci 
conviene aprire la sola lista  Recently used components, scorrerla e trovare subito quel 
componente.
Tornando alla descrizione delle liste,  parliamo subito della spunta  My component,  che 
spesso mettiamo su un componente della libreria di Target  per  evidenziarlo. 
Questa spunta non crea nessuna lista, serve soltanto per indicare che abbiamo identificato 
nella lista di Target un componente di nostro interesse che potremo ritrovare in seguito. Su 
questo componente non potremo fare nessuna modifica o personalizzazione, in quanto è 
proibito modificare i componenti  di Target. Se vogliamo modificarlo e in qualche modo 
farlo nostro, occorre prima crearne una copia, facendo M2 sulla casella del componente e 
selezionando  Create copy of XXX. Poi faremo M2 sulla copia ed inizieremo a modificarla 
scegliendo nella lista che appare, il tipo di modifica che ci interessa. Altrimenti potremo 
utilizzarlo come è importandolo dalla libreria di Target nello schema elettrico
Torniamo adesso alle liste di componenti riportate in Component list.

• Recently used components
Raccoglie  tutti  i  componenti  che  sono  stati  usati  di  recente,  a  qualunque  lista 
appartengano. Serve per velocizzare la ricerca di un componente, grazie alla nostra 
memoria.

• USER components
Contiene tutti i componenti che abbiamo inserito in precedenza nella lista USER, o  
facendo copia e modificandoli dalla lista di Target, o che abbiamo creato noi di sana 
pianta e li abbiamo inseriti nella lista USER. Quando si copia un componente da 
Target, automaticamente il componente viene assegnato alla lista USER.

• New components
E’ la lista  dei  componenti  che sono stati  di  recente creati  o modificati.  Serve a 
velocizzare la ricerca.

• Recently edited components
Analoga  alla  precedente  con  la  differenza  che  si  riferisce  ai  soli  componenti 
modificati.

• Libreria personale
Questa  libreria  (o  con  nome diverso  a  nostra  scelta)  la  abbiamo creata  noi  in  
precedenza  e le abbiamo assegnato quel nome. Raccoglie tutti  i  componenti di 
nostro  interesse  ricorrente  che  abbiamo  o  prelevato  da  Target  e  modificato,  o 
creato ex novo da noi stessi. E’ simile  alla lista USER, ma non è la stessa. Infatti 
può non contenere tutti i componenti che sono stati assegnati a USER, ma solo una 
selezione di quelli più ricorrenti.

Nota n°1: Quando si apre la finestra generale  Component, in alto sulla destra appaiono 
due caselle: TARGET components e My components.

11



La prima casella apre la libreria di tutti i componenti di Target che andranno poi selezionati 
con i filtri messi disposizione. Esclude i componenti USER.
La  casella  My  components  raccoglie  tutti  i  componenti  USER e  solo  quelli  di  Target 
etichettati in precedenza con la spunta My components.

Nota n°2. Ogni tanto i componenti TARGET vengono aggiornati e modificati dagli Editori  
Un cartello ci avvisa che è disponibile l’aggiornamento e chiede se lo vogliamo effettuare. 
L’aggiornamento modifica i componenti originali Target, ma non tocca i componenti USER.

Nota n°3 -  Per creare una libreria personale andare nella finestra di dialogo principale 
“Component”. Selezionare Package > Package sulla barra orizzontale > Enter package in  
list > New list > Name of the list > Inserire un nome a propria discrezione per es.: Libreria 
Personale.
Per aggiungere un componente dalla libreria di Target alla libreria personale, selezionarlo 
nella  libreria  Target  Components,  fare  M2  e  scegliere  “Import  component  in   My  
component list > Libreria personale.

1.11  Inserimento  rapido.  Se  si  vuole  semplicemente  riportare  sullo  schema  un 
componente raffigurato fra le icone della barra verticale a destra, fare M1h sul simbolo e 
trascinare nel disegno. In questo modo si sposta il componente selezionato con lo stesso 
valore della volta precedente. Invece, facendo sopra M1 si apre la finestra con la ricerca 
parametrica di quel componente. 
Vi sono anche altre modalità per piazzare un componente, tutte facilmente intuibili: 

• Dalla barra orizzontale alta Components  > Import symbol. 
• Oppure premere il Tab F2.

Il  componente sullo schema elettrico riporta disegnata una crocetta  che rappresenta il 
“punto di manipolazione o manico” del componente stesso. In quel punto va posizionato il  
cursore per selezionare o movimentare il componente.

1.12 Selezionare un componente sul disegno. 
M1 sulla crocetta del componente ( manico ). Se appare selezionata solo una parte del  
componente, e si vuole invece selezionare tutto il componente, premere M2 e spuntare 
“Always select entire component”.

1.13 Tracciatura dei collegamenti. Sulla barra orizzontale selezionare l’icona di una Z di 
colore verde. Scegliere, nella freccetta a destra, il  movimento del collegamento: prima 
orizz,  prima  vert.  dritto,  ecc.  Se  si  vuole  che  all’apertura  dello  schema  sia  subito 
disponibile  l’opzione “collegamento dritto”  che è la  più  usata,  impostarlo  con M1 sulla  
freccetta. Attenzione: quando si chiude e riapre lo schema, occorre impostare di nuovo.
Collegare  ogni  componente.  Dopo  ogni  collegamento  ciascun  componente  perde  le 
crocette rosse presenti nei punti di collegamento. Controllare!
Gli incroci con nodo avvengono facendo M1 quando si passa sul conduttore. Se non si  
vuole  il  collegamento  basta  passarlo  senza  click.  Per  inserire  un  nodo  dimenticato, 
scegliere la freccetta accanto alla icona dei collegamenti e selezionare in basso il disegno 
del nodo.

1.14 Simboli  di  riferimento:  massa,  terra,  +Vcc + 12V ecc.  scegliere  Components > 
Place  reference symbol. Oppure tasto “r”.
Attenzione! +5V,+12V, -12V, ecc. sono riferimenti che non forniscono una vera tensione al  
circuito, durante una simulazione, ma servono solo in disegni complessi, per  indicare che 
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in quel punto va applicata quella tensione senza stare a effettuare il collegamento con la 
sorgente di tensione.
1.15 Etichette di riferimento per collegamenti: 
Servono a semplificare il disegno sostituendo collegamenti quali alimentazioni ripetitive ed 
altro con etichette di uscita e di ingresso. Esempio uscita di una tensione di alimentazione 
e ingressi della stessa in vari punti dello schema. 
Selezionare sulla barra alta orizzontale:  Components > Place reference symbol. Oppure 
tasto “r”. Scegliere fra !Sign-IN e !Sign-out. Si apre una finestra in cui sono elencate tutte 
le possibilità di collegamento. Scegliere quella che interessa. Ad esempio Vcc. Il  nome 
Vcc viene riportato dentro il rettangolo del simbolo.
Attenzione : le etichette di riferimento, al pari dei simboli di riferimento, non effettuano dei  
veri  collegamenti  riconosciuti  dalla  simulazione.  Infatti  non  hanno  un  modello  di 
simulazione e quindi non sono simulabili.

1.16 Alimentazione di circuiti integrati.
Per collegare le alimentazioni dei circuiti integrati, selezionare sulla barra orizzontale:
Import  components > Import  rest  of  components.  In  alternativa si  può premere l’icona 
dell’amplificatore  operazionale  sulla  barra  orizzontale,  accanto  a  quella  dei  conduttori.  
Premendo la freccetta appare un pop up che contiene l’icona REST. Appare la lista dei  
singoli  stadi  del  circuito  integrato  non  ancora  importati  nello  schema  e  quella  della 
alimentazione che è contrassegnata con una P che segue la sigla, es.: IC1P. Importarla e 
collegarla alla o alle sorgenti di tensione. Questo collegamento è effettivo e consente la 
simulazione.

1.17 Componenti speciali non facilmente reperibili.
Sorgente di tensione: Finestra principale “Components” > M1 su linguetta  “Components 
types and groups “ > Voltage and Current > Voltage source ( simulation ).
Oppure:  M1 su icona del  generatore di  tensione nella  barra verticale  fra  i  simboli  dei  
componenti. Nella finestra che appare, selezionare il tipo di sorgente.
Altro esempio di ricerca: Ponte raddrizzatore. Linguetta “Component types and groups”  
nella finestra principale della libreria dei componenti > Diode > Bridge rectifier.

1.18 Inserire un testo
Barra  orizzontale  >  Elements  >  Insert  text.  Questo  per  scrivere  con  il  carattere  già 
impostato in precedenza.
Se invece si vuole prima impostare il carattere e poi scrivere, premere il tasto delle doppie 
virgolette ( ” ) sulla tastiera. Appare una finestra con tutte le opzioni.

1.19 Muovere un componente. Click M1h sulla crocetta del componente ( manico ) e 
spostare. Se si sposta solo una parte del disegno, > M2 > M1 su “Always select entire  
component”.

1.20  Trascinare  parte  del  disegno. Raggruppare  con  M1h  la  parte  da  trascinare. 
Attenzione: i collegamenti interessati al trascinamento sono quelli definiti a destra nella 
finestra “Settings”. Se si selezionano più tracce, queste vengono trascinate.

1.21 Muovere solo il testo di un componente. M2 e deselezionare “Always select entire  
component”. Poi M1h sul testo da muovere.

1.22 Ruotare. Click sulla crocetta ( manico ) e tenendo premuto ( M1h ) premere anche il 
tasto destro.
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1.23 Cancellare. Click M1 sulla crocetta ( manico ) del componente poi premere il tasto 
con le forbici sulla barra orizzontale. Nel caso di linee di collegamento, scegliere prima 
quanto di questo collegamento si vuole cancellare. (Vedi par.3–11).

1.24 Assegnare il valore a un componente. 
Quando si importa un simbolo già nel disegno del circuito elettrico, le scritte che appaiono 
sono il codice progressivo corrente ( Prefix ) e il valore !Value. Per assegnare il suo valore 
es.: 33K, occorre fare M11 sulla crocetta dello schema del componente. Appare la finestra 
Change Symbols; inserire il valore nella casella Value. 

1.25 Interrompere un’azione non voluta. 
• Premere il tasto di Stop sulla barra orizzontale, oppure 
• Esc sulla tastiera o M12.

1.26 Undo – Redo ( Non fare – Rifare )
Sono due funzioni molto utili che servono a cancellare l’ultima azione fatta o a ripristinarla. 
Le relative icone si trovano sulla barra orizzontale rappresentata da una freccia che volge 
a sinistra e una che volge a destra rispettivamente.

1.27 Zoom sul disegno
Per ingrandire il disegno “a riempimento della pagina” fare M1 sul quadrato con 4 freccette 
arancione sulla barra orizzontale. Per ingrandire o diminuire, Zoom + e Zoom – è accanto, 
sulla  stessa  barra.  Più  semplicemente  si  può  usare  la  rotella  del  mouse:  in  avanti 
aumenta, indietro diminuisce. La rotella è molto pratica durante il  disegno: se si  vuole 
ingrandire un particolare, basta mettere il puntatore in centro zona e girare la rotella: verrà 
ingrandita / ridotta con continuità quella zona centrata intorno al puntatore.

1.28 Selezione di un gruppo di elementi di un disegno
Per selezionare un gruppo di elementi  al  fine di  modificarli  tutti,  si  racchiude il  gruppo 
dentro un rettangolo con M1h. Poi si rilascia e si preme il tasto ( e ) che significa edit.
Appare una finestra “Edit  the selected elements” con due sezioni,  destra e sinistra.  In 
quella  di  sinistra  sono elencati  tutti  gli  elementi.  Quelli  da  modificare  possono essere 
selezionati tramite una spunta. Selezionarli e premere OK. Appare ora la finestra; es. se si 
è scelto Lines, la finestra è “Change lines”. Premere OK. Poi appare una seconda finestra 
es. Change toruses da modificare, ecc.

1.29 La funzione REO ( Reorganization )
La funzione REO svolge funzioni di riordino e di pulizia sia nello schema elettrico che nel  
PCB. E’ accessibile 

• facendo M1 sull’icona della bacchetta magica sulla barra orizzontale, 
• con M1 su Action > Reorganization.

- Rinumerazione dei componenti. 
Succede spesso che un componente venga eliminato in fase di progetto. Ad esempio in 
un progetto con 30 resistenze, viene eliminata la settima. Tutte le resistenze successive a 
questa  debbono  essere  rinumerate,  scalando un passo  indietro.  Per  evitare  un  lungo 
lavoro  manuale,  il  procedimento  è  automatizzato  dalla  funzione  REO.  Nella  finestra 
“Reorganization”  si  seleziona  nel  riquadro  di  sinistra  con  M1,  prima  il  simbolo  della 
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resistenza “R”. Poi si sceglie con M1 su “According to schematic” se questa numerazione 
si riferisce allo schema o al PCB. Infine si seleziona una delle caselle:

• Only fill  gaps:  Se, in una successione, manca un numero, la successione viene 
rinumerata eliminando il vuoto. Es.: R1,R2,R4,R5….> R1,R2,R3,R4…..

• Sort by X coordinates: i prefissi verranno rinumerati ordinati da sinistra a destra
• Sort by Y coordinates: i prefissi verranno rinumerati ordinati dall’alto al basso

A questo punto siamo pronti per lanciare la riorganizzazione. M1 su “Start prefix reo”.

- Riorganizzazione del progetto ( Area colorata in verde )
Serve a cancellare la memoria interna. Durante le funzioni Undo e Redo rimangono 
memorizzate le immagini precedenti ogni azione in modo da essere sempre disponibili per 
un richiamo. Perciò lo spazio di memoria rimane occupato anche se gli elementi non sono 
visibili. La funzione REO cancella questa memoria e gli elementi memorizzati non sono più 
disponibili. Per attivare questa funzione M1 su “Start project reo. Attenzione: l’azione è 
irreversibile.
Inoltre è possibile anche selezionare: Cancella le doppie tracce sia nello schema Delete 
double trace segment ( schematic), che nel nel PCB, e cancella i segnali non utilizzati 
nello schema Delete futile signals.
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2 – SIMULAZIONE

Il programma supporta modelli primitivi e sintassi di SPICE 3F5 e , in parte, PSPICE.
SPICE3F5 è il programma messo a punto dalla Università Berkeley in California. ( 1984 ).
PSPICE ( Personal Simulator Program with Integrated Circuit Enphasis ) è un discendente 
del precedente, cui è stata implementata la versione digitale.

2.1 Modelli. 
La simulazione si  svolge con una lista di  istruzioni (  Net list )  scritte con una sintassi  
accettata da Spice, che forniscono al programma le informazioni dei componenti, dei loro 
collegamenti e le istruzioni  per eseguire la simulazione. 
I componenti sono rappresentati da un modello, che può essere o un “modello primitivo” o 
un modello più complesso descritto dal cosiddetto “sub-circuito”.
I MODELLI PRIMITIVI già contenutI nel programma, sono modelli che descrivono con loro 
parametri iniziali di default, il comportamento di una tipologia di componente, passivo o 
attivo, ( resistenza, condensatore, induttanza, diodi, transistori bipolari, Jfet ecc. ). 
Per  effettuare la  simulazione,  a detti  parametri  di  default  dovranno essere assegnati  i  
valori reali specifici del componente. Appena trovato il modello SPICE di un componente 
da  simulare,  per  esempio  tramite  ricerca  nel  web,  TARGET  si  impossessa 
immediatamente dei suoi parametri specifici e li sostituisce automaticamente a quelli  di 
default del modello primitivo, rappresentati in una lista detta MODELCARD. Si ottiene così 
un modello di componente che rispecchia le caratteristiche di quello da simulare.
Vedere un esempio di modelcard? Icona ampl.operazionale > BC547 > Search > M2 su 
BC547 a sinistra >  Symbol, Package, 3D,Simulation > Show simulation model >  Edit. 
Appare la modelcard con i valori specifici del transistore NPN BC547.
Quando  si  tratta  di  un  componente  non  compreso  nella  lista  dei  primitivi,  ad  es::  un 
trasformatore,  un  diodo  Zener,  un  diodo  Varicap,  un  Triac,  un  SCR,  una  valvola 
termoionica, ecc.. esso può essere rappresentato con un sub-circuito. 
I SUB-CIRCUITI sono modelli realizzati con componenti primitivi che formano un circuito 
che si collega all’esterno con terminali di ingresso e uscita. Al loro interno i componenti  
sono  collegati  tra  loro  con  nodi  interni  e  formano  una  rete  che  intende  riprodurre  il  
comportamento del componente non primitivo. In alcuni casi la rete di componenti interni 
riproduce il circuito equivalente del componente ( trasformatori ) in altri casi vengono usate 
sorgenti  non  linearmente  dipendenti  per  simulare  le  caratteristiche  del  componente 
(  valvole  termoioniche ).  La  rete  di  componenti  viene vista  dal  programma come una 
macro governata dagli algoritmi di SPICE secondo le istruzioni fornite nel listato ( Net list ). 
I  parametri  dei  subcircuiti  verranno  sostituiti  manualmente  a  quelli  di  default  in  una 
apposita tabella.
Tutti  i  componenti  dello  schema  che  vogliamo  simulare,  debbono  avere  registrato  in 
libreria un modello. Se manca un modello, la simulazione non funziona. 
Per vedere se un componente ha già un modello, selezionare la linguetta “Quick select” 
della  finestra  della  libreria  dei  componenti  Components.  Nella  casella  a  sinistra  del 
componente in questione, procedere così: M2 sulla fascetta nera User > Symbol,package 
3D simulation > Show simulation model. Verificare in Edit che siano impostati i parametri 
di simulazione.
Attenzione! Show simulation permette solo di vedere il modello di simulazione, ma non di 
modificarne i valori.
Per modificare i valori e renderli permanenti, occorre selezionare Edit simulation model e 
non Show.
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2.2 Fornire una tensione di alimentazione.
Prima di iniziare la simulazione occorre dare tensione al circuito e applicare in ingresso i 
segnali di stimolo che occorrono.
Selezionare (  M1 )  il  simbolo della  sorgente di  tensione nella barra verticale  a destra  
Components.  Nella  finestra che appare scegliere  Vconst.  Poi  importare il  simbolo nel 
disegno. Fare M11 sulla crocetta e assegnare un valore di tensione nella casella “Value” 
della finestra “ Change Symbol “.

2.3 Fornire un segnale esterno di stimolo. 
Agire come sopra per trovare un generatore, ma scegliere la forma d’onda richiesta.
Attenzione! Quando si  sceglie una tensione sinusoidale, e si vuole assegnare il  valore 
della ampiezza e della frequenza occorre fare M11 sul disegno della sorgente. Si apre la 
finestra “Change symbol”. Poi M1 su Simulation value, infine  Edit.
Nella finestra che appare, i valori che interessano sono nella colonna centrale, cioè VA = 
Ampiezza e FREQ = frequenza. Vo è l’eventuale componente continua. Non è necessario 
scriverla la lettera V che indica una tensione.
Nella  colonna di  sinistra,  AC (  ampiezza della  sinusoide )  va  messa a  zero.  Si  deve 
assegnare un valore solo quando si esegue  Extended  simulation > AC analysis,  ( vedi 
8.7 ).
Nella casella Value della prima finestra che si apre quando si selezione il simbolo, occorre 
mettere a mano il  valore scelto, ma non ha alcun effetto nella simulazione. E’ solo un 
riferimento mnemonico nel disegno.
Viceversa,  se  si  vuole  dare  un  effetto  a  Value,  occorre  inserire  la  scritta 
COMPONENTVALUE  nella  casella  del  valore  di  VA.  In  questo  modo  il  programma 
assegna automaticamente a VA quanto scritto nella precedente finestra Value.

2.4 Iniziare la simulazione. 
• Selezionare l’icona con la bacchetta magica, sulla barra orizzontale, poi scegliere 

l’icona con le sinusoidi. Oppure
• Selezionare l’opzione “Actions” sulla barra orizzontale e scegliere “Start simulation”. 

Oppure
• Premere semplicemente il tasto F9. 

Si  apre la finestra della simulazione.  Scegliere prima la durata della simulazione nella 
casella “seconds”, es.: 10m cioè 10 ms, poi premere il  tasto di start.  Appaiono tutte le 
forme d’onda del circuito. Premere il tasto View > Show none per oscurarle tutte per poi 
selezionare con una spunta sul quadratino, solo quelle che interessano.
Per modificare i valori degli assi sia verticale che orizzontale del grafico, andare su View > 
Zoom e selezionare.
Per una selezione preventiva dei soli segnali che interessa vedere, nella finestra iniziale 
Simulation,  scegliere “  Select particolar voltages and currents  ” a destra della finestra. 
Nella parte inferiore della finestra bianca che appare fare click destro ( M2 ) e premere 
“add”. Appare la finestra “ Simulation probe”. Scegliere “Voltage against ground”, tensione 
riferita a massa. Sul disegno dello schema elettrico appare il simbolo della tensione (V) 
che va posizionato sul conduttore che interessa. Fare click M1. Infine “Back to the probe” 
per continuare ( click sul quadratino del simbolo). Per attivare la selezione, M2 e click nella 
casellina rispettiva di  “Show immediately”.

17



2.5 Possibili cause di mancato funzionamento.
Assicurarsi che tutti i componenti siano effettivamente collegati. Provare a spostarli con il 
mouse: gli elastici dovrebbero seguire gli estremi del componente.
Se  dopo  aver  lanciato  la  simulazione,  all’oscilloscopio  appare  uno  schermo  nero,  
controllare la base dei tempi e le unità di misura ad es.: “s” invece di “m” , oppure se in 
View vi sono dei segnali pre-selezionati; cancellarli e visualizzare quelli che interessano.
Quando si imposta la tensione della sorgente sinusoidale, non selezionare “Value” che 
non ha effetto, ma scegliere Simulation value > Edit  > e impostare VA. 

2.6  Assegnare ad un componente un modello di simulazione
La maggior  parte  dei  componenti  non ha un modello  di  simulazione già  assegnato in 
libreria.
Per assegnare ad un componente un modello di simulazione operare come segue:
Fare due volte click ( M11 ) sul simbolo del componente già riportato nello schema; appare 
la finestra  “Change symbol” e a volte,  una finestra sovrapposta,  con un messaggio di 
warning che ci avvisa che la libreria non dispone di un modello per quel componente. 
Click su “OK I understand the message”.
Click su “Simulation values”.
Appare la finestra “Models for X1,2...(numerazione progressiva di quel componente) “. 
Questa è la finestra base di smistamento da cui partono tutte le operazioni della procedura 
per l’assegnazione del modello di simulazione, che si svolge nelle seguenti fasi:

2.7 - Ricerca ->  Search
1° Fase: ricerca del modello. 
Click su Search. Appare la finestra “ Simulation model Browser” divisa in due pannelli.
A destra appare un cartello giallo che dice che si può importare un modello, o cercandolo  
su Google o cercandolo su file già creati appositamente o  testi copiati in clipboard.
Scegliamo ad esempio di cercare tramite Google. Fare click sulla freccia blu del pannello  
di  destra;  si  presenta l’alternativa “Reload from”  e “Search by Google”. Scegliamo la 
seconda opzione.
Veniamo automaticamente messi in collegamento su Internet. 
La pagina che appare è “Search a Spice model by Google”.
Nella finestra model Spice…… aggiungere la sigla del componente, es.:1N4007. Questo 
serve a restringere la ricerca al  solo componente e non ad un tipo generico. Premere 
Search.
Entriamo in Google, e qui tocca a noi trovare il modello.
Se si trova, consiglio di copiare i dati originali in un file  *.txt che avremo appositamente 
creato col nome del componente e salvarlo nella cartella superiore che chiameremo  ad 
es.: Spice Models o nella nostra bella lingua “Modelli di  simulazione”.
Si torna alla finestra  Simulation model browers  con i due riquadri destro e sinistro. Nel 
riquadro destro fare click sulla freccia blu e scegliere  Reload from > Files with Pspice 
models > Cercare il nome del file in estensione txt che abbiamo in precedenza scritto.
I parametri di simulazione del modello vengono automaticamente caricati e nel riquadro 
appare  scritta  la  sigla  del  componente.  Se  ci  sono  errori  o  incompatibilità,  Target  lo 
comunica con un quadratino rosso; seguendo le istruzioni è possibile trovare la causa. Per 
la correzione e la modifica del listato del modello, leggere Cap. 10 – Appendice B.
Per visualizzare il modello importato, M11 sul nome del componente appena caricato e 
scegliere Edit/show. Controllare.
Ora si deve importare il componente nella finestra di sinistra, per inserirlo nella libreria di 
modelli  di  Target.  M2 sul nome del componente nella finestra di  destra,  e selezionare 
“Import”.  Nella  finestra  di  sinistra  appare  la  sigla  del  componente.  Inoltre  appare  una 
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finestra che dice: The view of the Model Browser is not updated. Now refresh? Rispondere 
yes. Con questa azione i parametri del modello vengono trasferiti nella finestra di sinistra.  
Si possono rivedere i parametri a sinistra, facendo M2 sul nome del componente e poi  
scegliendo Edit/Show.
A questo punto si chiude la doppia finestra. 

2.8 – Assegnazione del  modello -> Select

2° Fase: Assegnazione del modello: primitivo o sub-circuito. 
Nella  finestra  “Models  for  xx” fare  M1 nella  casella  “Select”.  Appare  la  finestra  “New 
models for” che mostra una lista di modelli. Partendo dall’alto, il primo ci riconduce alla 
ricerca del modello. Segue un gruppo Circuit di tre icone: corto circuito, insiemi di sub 
circuiti  e sub circuiti.  Infine segue il  gruppo dei  Primitive models,  cioè la lista di  tutti  i 
modelli primitivi disponibili. 
Se il componente appartiene a questa lista, scorrerla e fare M1 sull’cona corrispondente. 
Appare  la  lista  dei  parametri  di  default.  Nella  casella  Modelcard cercare  il  nome  del 
modello che abbiamo precedentemente importato e selezionarlo. Immediatamente i valori  
di default vengono sostituiti da quelli specifici.
Poi occorre passare alla casella “Pinassignment “ che consente di collegare i terminali del 
modello a quelli del componente.
Per un “Subcircuit” si fa M1 sull’icona Device subcircuit e si seleziona il nome assegnato al 
subcircuito fra quelli riportati nella casella Subcircuit. I dati vengono ora automaticamente 
caricati.
Poi occorre passare alla casella “Pinassignment “ che consente di collegare i terminali del 
componente rappresentato nello schema elettrico agli ingressi/uscite del sub-circuito. Nel 
listato  del  modello  in  alto  è  spiegata  la  chiave  di  collegamento,  a   volte  non  molto 
chiaramente.
Per circuiti integrati multipli, o componenti attivi multipli, Es.: operazionale multiplo, circuito 
integrato digitale contenente 6 inverter, o 4 AND, o valvola doppio triodo  ECC81... tutti  
contengono al loro interno più stadi uguali. Per questi si usa il modello “ Device List” , terzo 
dall’alto, che contiene al suo interno una lista di sub circuiti uno per ogni stadio contenuto  
nell’integrato. Gli stadi possono anche non essere uguali. ( Vedi Cap. 13 )
Device list > Model as a list of submodels > Add > Device subcircuit .Cercare in Subcircuit 
il modulo dello stadio del componente multiplo che abbiamo precedentemente importato 
nella  lista  dei  modelli  e  selezionarlo.  Poi  eseguire  il Pinassignment cioè  collegare  i 
terminali del modello ai piedini del componente. OK. Di nuovo selezionare Add e ripetere il 
procedimento di.Pinassignment per il secondo modulo, assegnando i terminali dello stesso 
modello ai corrispondenti piedini degli altri stadi contenuti nell’integrato, e OK.
Ad esempio per un amplificatore operazionale multiplo il cui modulo è composto da uno 
stadio  con  due  ingressi  e  una  uscita,  questi  terminali  verranno  collegati  ciascuno  ai 
rispettivi piedini di ogni stadio identico racchiuso nel circuito integrato.

2.9 – Modifiche -> Edit
3° fase (eventuale). Questa casella serve per modificare i valori assegnati al componente. 
Serve soprattutto nel caso dei sub-circuiti quando in un nuovo progetto, occorre assegnare 
nuovi parametri al modello oppure quando occorre correggere un listato errato.
Per  cambiare  i  parametri  su  un  componente  primitivo,  M11  >  Change  symbols  > 
Simulation value > Edit  > modificare.
Per cambiare i parametri di un sub circuito M11 > Change symbols > Simulation value >  
Edit > Parameter. > modificare.
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Per  effettuare  delle  correzioni  al  listato  che  non funziona:  M11 >  Change symbols  > 
Simulation value > Edit  > Edit  >  Edit/Show as text.  Appare il  listato precedentemente 
importato. Dei messaggi rossi ci informeranno che il  listato è errato e in fondo c’è una 
sezione Errors, che riporta la lista degli errori di sintassi. Con M11 su ciascuna, appare un 
quadretto nero sulla riga in cui si trova l’errore.
Possiamo correggere l’errore e vedere subito se la correzione è giusta:  SPICE > Reload.
Se le correzioni effettuate hanno avuto successo, il programma lo segnala. In tal caso fare 
M1 > SPICE > Save. Il nuovo listato corretto diventa ora operante.

2.10 – Assegnazione del Livello -> Level

4°  Fase: Il  livello  (  casella  “Level”  )  serve  al  programma per  eseguire la  simulazione 
secondo quanto interessa analizzare del comportamento del componente, ad es.: se si 
vuole  in  bassa  frequenza,  LOWFREQ  oppure  in  alta  frequenza,  HIGHFREQ  oppure 
semplicemente in DC, se trattasi di un componente attivo, ACTIVE ecc. 
Tuttavia ai fini del funzionamento iniziale, e in prima istanza si può lasciare in bianco.
Con  questo  passo  il  procedimento  è  terminato  e  si  chiudono  tutte  le  finestre.  Il 
componente è stato finalmente dotato del suo modello e può essere eseguita e provata la  
simulazione.

2.11 Attribuire un modello a un componente di libreria.
La procedura sopra descritta, serve ad attribuire un modello di simulazione ad uno 
specifico componente  già rappresentato in uno schema elettrico. E’  preferibile invece 
assegnare il modello direttamente al simbolo da importare, quello della libreria dei 
componenti, senza dovere tutte le volte ripetere la procedura di assegnazione quando si 
richiama quel componente. In uno schema.

2.12 Esempi: Resistenza 
Ricercare il componente ancora privo di modello, nella finestra Components facendo click 
sulla linguetta “Quick select”. 
M2 sulla casella del componente trovato. M1 su “Simbol, package, 3D…”. Scegliere “Edit  
simulation model”. 
Models for > Select >Device resistor> OK
Edit > Value > COMPONENTVALUE. Questo informa il programma che deve assegnare 
al modello, il valore che sarà specificato ogni volta nella finestra iniziale Change symbol  
nella casella Value.
Completare il “pinassignment” trascinando i rispettivi valori da sinistra a destra.
Nella finestra precedente “Models for” inserire il level “ANALOG “. Chiudere tutto.

2.13 Condensatore
Ricercare il nuovo componente facendo click sulla linguetta “Quick select”. Click M2 sulla 
casella del componente trovato. M1 su “Simbol, package, 3D…”
Scegliere “Edit simulation model”
Nella  finestra  “Models  for”   fare  M1 su  “Select”.  M1 sul  simbolo  del  condensatore  in 
Primitive  models.  Nella  casella  Value scrivere COMPONENTVALUE. Questo  serve ad 
assegnare il valore direttamente nella casella Value della finestra iniziale Change Symbol. 
Assegnare alla casella IC = Default il valore di tensione applicata al condensatore all’inizio 
della  simulazione  ( Initial  Conditions  )  in  genere  “0”.  Completare  il  “pinassignment” 
trascinando i rispettivi valori da sinistra a destra. Nella finestra precedente “Models for C1” 
inserire il level “ANALOG “. Chiudere tutto.
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2.14 Rappresentazione di segnali digitali
Nel  caso  in  cui  vengano  generati,  in  uscita  di  circuiti  integrati,  dei  segnali  digitali,  la 
rappresentazione della simulazione si sdoppia automaticamente in due riquadri: 
uno superiore in cui viene rappresentata, in un quadro molto stretto, la sola uscita digitale, 
il cui nome è preceduto dalla lettera “D”.
Un riquadro inferiore, molto più alto, in cui si rappresentano gli altri segnali.
Questa  rappresentazione  può  apparire  poco  utile,  in  quanto  si  perdono  alcune 
caratteristiche del segnale digitale, quale la sua ampiezza e la sua forma, le quali, nella 
rappresentazione digitale, appaiono come “stilizzate”. 
Per evitare questa rappresentazione sdoppiata e vedere il segnale digitale di uscita come 
realmente è, basta inserire una resistenza di carico di valore adeguato (es.: TTL = 1K, C-
Mos=10K )  sull’uscita  digitale.  Occorre  poi  ri-controllare  i  nomi  dei  collegamenti  nello 
schema elettrico, e riadattarli  nella casella  Edit Selection,  della finestra di Simulazione. 
Quindi  far  ripartire  la  simulazione.  Il  quadro  ora  non  è  più  sdoppiato  e  il  segnale  è 
rappresentato compiutamente.

2.15 Formatore di stimoli digitali personalizzati
Per la simulazione digitale, è possibile costruire dei segnali digitali contenenti un codice 
personalizzato a piacere. Si può cioè creare un generatore virtuale che genera segnali,  
validi solo per la simulazione, costituiti da treni di impulsi secondo un codice programmato 
da noi e che si ripetono nel tempo con un periodo anch’esso da impostare.
Il primo passo è quello di cercare, nella libreria dei componenti di Target, il formatore di  
impulsi, già presente col nome STIM. 
Aprire la finestra dei componenti e selezionare la casella Components types and groups  > 
Generic,simulation and modeling > Digital stimulus. 
Se  si  è  in  precedenza  creato  una  Libreria  personale,  conviene  inserirvi  questo 
componente. M2 sulla casella Component name > STIM. M2 su Import component in my 
component list > Nome della libreria personale già creata in precedenza.
A  questo  punto  possiamo  assegnare  al  componente  un  nome  in  italiano  facilmente 
riconoscibile,  ad  es.:  “Formatore  impulsi”.  M2  nella  casella  STIM  >  Edit  component  
properties > Nella casella Name > English inserire il nome es.: Format Imp.
Nella casella sottostante Description scrivere “Formatore virtuale di impulsi”.
Abbiamo creato in questo modo un generatore, adatto per la sola simulazione, che genera 
un segnale digitale ancora da impostare.

2.16 Impostazione di uno stimolo digitale.
Per programmare il formatore, si va nello schema nel quale occorre tale generatore e si 
importa dalla libreria dei componenti, facendo M1 sul simbolo  “Form Imp”.
M11 sul simbolo importato. Si apre la finestra Change symbol > Simulation Values > Edit  
> Stimulus editor. Si apre la seguente immagine:
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fig. 2.1
Sulla barra orizzontale si nota l’immagine dell’occhio che consente la visione del segnale 
digitale che andremo a costruire. Segue l’immagine del lapis, che permette la costruzione 
del segnale. Fare M1 su questa icona.
Posizionare il puntatore all’interno della striscia nera in basso che rappresenta l’asse del 
tempo,  e  facciamo  M2  in  corrispondenza  approssimata  del  tempo  in  cui  intendiamo 
iniziare il treno di onde dello stimolo. Poi M1 nella finestrella alla scritta Edit/Add state.
La casella Label richiede un nome a nostra scelta che identifichi l’onda. 
La casella sottostante richiede di impostare esattamente il tempo di inizio, ad es.: 0 m.
Segue la spunta Absolute o Relative che significa tempo assoluto o relativo al precedente 
stato impostato. Attenzione! la scelta,  Absolute  oppure relative, deve essere mantenuta 
per tutta la programmazione, non è ammessa una combinazione di entrambi, altrimenti 
possiamo incorrere in simulazione non corrispondente ai tempi programmati:  il  periodo 
dell’onda simulata apparirebbe maggiore di quanto impostato.
M1 su Absolute. Infine nella casellina identificata da # inserire lo stato logico 0 oppure 1.
Il lavoro di creazione si ripete fino al completamento del treno di impulsi desiderato. 
Per impostare il periodo di ripetizione, ci posizioniamo col cursore nella barra nera bassa 
dei tempi, circa in corrispondenza del termine del treno di impulsi creato, quindi faremo M1 
in Edit/Add Goto.
Nella finestra che appare, nella casella  Goto Label, inserire il nome assegnato all’inizio 
dello stimolo. Nella casella  Repetitions inserire il numero di volte che il treno di impulsi 
deve essere ripetuto. Per infinito si imposta -1.
Nella casella Time si mette il tempo in cui termina la serie di impulsi che dovrà essere 
ripetuta. Questo punto rappresenta quindi il periodo T del treno di impulsi.
Per vedere la serie di impulsi che si ripete con periodo T, fare M1 sull’icona dell’occhio ed 
eventualmente usare i tasti dello Zoom per adattare l’immagine.
Prima di uscire, salvare con M1 sulla icona del floppy disk. Si ritorna così alla finestra 
Stimulus.
Il lavoro non è finito, perchè dobbiamo ancora impostare il Pinassignment, cioè assegnare 
il modello di simulazione ai piedini del generatore. 
M1 sulla casella  Pinassignment.  Trascinare il  nome del  nodo $G_DPWR (a sinistra in 
basso  ),  che  rappresenta  l’alimentazione  digitale  DPWR,  nella  casella  gialla  a  destra 
digital power. Allo stesso modo trascinare nella casella digital ground il nodo $G_DGND.
Infine trascinare nella casella gialla di destra nodes1 il Pin num 1 di sinistra.
Quindi si apre la linguetta I/O e nella finestrella I/O Model si imserisce I/O_Default.
Si raccomanda di seguire alla lettera queste indicazioni. Chiudere tutte le finestre e tornare 
allo schema.
Inserire  una  resistenza  di  carico  all’uscita  del  Formatore  e  provare  la  simulazione. 
Dovrebbe apparire in uscita la serie di impulsi, con la tempistica come programmata.
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2.17 Significato dei tasti del formatore di impulsi

La figura seguente è quella della finestra del formatore di stimolo nella modalità Visione 
del segnale, tasto dell’occhio.

fig.2.2
Descrizione completa dei tasti:

• Il primo tasto da sinistra, New, Delete all signals, serve per cancellare una 
impostazione precedente e iniziarne una nuova.

• Il tasto del floppy disk serve per salvare la programmazione appena terminata e 
tornare alla simulazione

• Il tasto dell’occhio serve per visualizzare lo stimolo generato, senza disegnarlo.
• Il tasto del lapis serve per disegnare lo stimolo ( Edit ).
• Il tasto del testo, attivo solo quando in modalità di impostazione ( Edit ), serve a 

scrivere in formato “testo” il treno di impulsi da rappresentare. Codice di facile 
intuizione è utile ad es.: per modificare a mano una impostazione già attuata.

• Il tasto della griglia serve ad impostare i decimali del passo nella casella Time della 
finestra Add new state. Ad es.: se si vuole il tempo rappresentato comprendendo i 
decimi di millisecondo ( 3,1m 3,2m ecc. ) occorre impostare un passo di 0.1 ms.

• Il tasto Zoom+ ingrandisce l’immagine. M1 sul tasto e fare M1h sulla parte di 
immagine che si vuole ingrandire. 

• Il tasto Zoom- serve per scalare in diminuzione tutta l’immagine dello stimolo.
• Il tasto col rettangolino azzurro serve per visualizzare un solo periodo dello stimolo 

a riempimento di schermo.
• I tasti a forma di Z verde ( Time scroll bar: statewise, Time scroll bar : transitionwise 

) servono per ingrandire una zona racchiusa con M1h.
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2.18  Elementi interattivi per simulazione
TARGET  contiene  anche  alcuni  strumenti,  solo  per  simulazione,  quali  amperometri, 
voltmetri,  Wattmetri,  LED  e  lampade,  interattivi,  cioè  che  è  possibile  introdurre  nello 
schema e vederli funzionare. 
Gli strumenti hanno un display in cui appare il valore misurato, mentre i led e le lampade 
cambiano colore quando percorse da corrente.
Per trovarli, aprire la finestra generale Components, selezionare la linguetta Parametrical  
search >  Generic simulation and modelling > Measuring instruments  > M1 sulla spunta 
Simulation  model.  Search.  Appare  nella  finestra  di  sinistra  la  lista  degli  strumenti 
disponibili che è possibile importare nello schema e collegare nei punti di interesse.
Gli strumenti con sigla OSZI sono dei piccoli oscilloscopi che mostrano la forma d’onda del 
punto in cui vengono inseriti. Offrono varie possibilità di ingresso e possono visualizzare 
tensioni e correnti. Non danno tuttavia la misura del segnale, solo la forma.
Per  attivare  la  simulazione,  una  volta  collegati  gli  strumenti,  fare  M1  sull’icona  della 
bacchetta  magica,  poi  su  quella  delle  sinusoidi.  Appare  il  cartello  seguente.

                                             
Fig.2.3

Premendo la freccia di sinistra parte la simulazione. Il tasto rosso la interrompe prima che 
finisca. 
Il tasto con la figura della sinusoide ed il circoletto più, serve a visualizzare l’immagine 
delle grandezze selezionate all’oscilloscopio
Il tasto col quadratino a destra apre la finestra generale della simulazione tradizionale.

2.19 LED interattivo
Con l’esempio seguente si vuole indicare come impostare un LED interattivo, tale cioè che 
al supero di  un certo valore impostato della corrente che lo percorre si  accenda, cioè 
assuma un colore diverso. Si disegni lo schema di fig.2.4, utilizzando gli elementi interattivi  
diodo LED e m-amperometro. Sim 1 è un generatore di tensione continua da impostare a 
20V..
Occorre prima di tutto assegnare nomi riconoscibili ai collegamenti di ingresso e uscita,  
come ad es.: gen e out.
Poi M1 su icona della bacchetta magica e delle sinusoidi. Appare il cartello di fig.2.3. M1 
sul  tasto a destra del  quadratino per  raggiungere la  finestra Simulation e  impostare  i 
parametri che interessano. In questo caso interessa la corrente del LED. Edit selection > 
Add  >  Current e  selezionare  la  corrente  entrante.  Poi  attivare  con  M1  su  Show 
immediately > OK. Per tornare al cartello di simulazione di fig.2.3 fare M1 sulla linguetta 
Interactive.
Ci proponiamo ora di impostare la corrente del LED al di sopra della quale si accende.
M11 sul simbolo del diodo > Interactive(Sim) > Edit.

Nella finestra  Value cancellare quanto già scritto e scrivere  I(#,1)-5m. OK > OK: Il 
codice che abbiamo scritto significa che intendiamo impostare la corrente “ I “ del diodo 
che entra nel piedino 1 ( #,1) e il valore per l’accensione deve superare 5 mA. Attenzione 
alla sintassi.
A questo punto possiamo passare alla simulazione.
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M1 su icona della bacchetta magica poi su quella delle sinusoidi. Appare la fig.2.3. M1 su 
tasto sinistro con freccia verde. Il  risultato è quello di fig. 2.4. Il  LED è rimasto spento 
perché la corrente è insufficiente ( 1,933mA ). 

                                           
Fig.2.4

Assegnamo ora a R1 il valore 3.7K. e ripetiamo la simulazione.  Quello che vedremo è 
riportato nella figura seguente 

                       
Fig. 2.5

Avendo ora superato 5mA impostati, il LED si accende.
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3 - DISEGNO DEL CIRCUITO STAMPATO

3.1 Apertura
Se si vuole disegnare il solo circuito stampato, senza schema elettrico preliminare, occorre 
avere fatto la scelta all’inizio del progetto, dopo New project.
Se si è scelto con schema elettrico, una volta disegnato il circuito e provato, per passare al 
disegno  PCB  si  usa  il  tasto  sulla  barra  orizzontale  con  un  poligono  e  una  freccia 
arancione.

3.2 Disegno del bordo del PCB
Actions > PCB Outline wizard. Si apre la finestra con le opzioni per disegnare il bordo.
Scegliere la misura in mils o in mm. per disegnare un rettangolo. Per altre forme utilizzare 
il tasto con l’icona del lapis. In ogni caso il bordo può essere rivisto nel corso del lavoro.
Il colore di default per il perimetro del PCB è il rosa. Se il disegno del perimetro venisse di 
un colore diverso, dopo averlo disegnato, premere M11 sopra, e scegliere il layer  23 nella  
finestra che appare. 

3.3 Cambio di unità di misura 
Premere il tab F4. Si vede il risultato nella casella in basso a sinistra dove è rappresentata 
la posizione del cursore nel foglio.

3.4 Scelta del Layer 
Facce del  circuito stampato: Copper bottom è la superficie del rame, ove vengono stese 
le tracce. Copper Top la superficie della basetta ove sono inseriti i componenti. 
Nella rappresentazione PCB, il circuito stampato appare come se fosse trasparente e i 
componenti saldati sul lato rame appaiono visti  da sopra attraverso la basetta. Così le 
tracce appaiono visibili dal sopra, e i componenti SMD disposti sul lato rame, come se la 
basetta fosse trasparente. Così del componente SMD, saldato sul lato rame, si vede la 
superficie di sotto. Pertanto, attenzione alle polarità! Controllare dopo, con l’utile visione 
3D, che il componente sia collegato nel modo giusto.
Per la scelta del layer ove stendere le tracce, sulla barra verticale a destra, selezionare 
Layers > Layer for tracks e nella finestra che appare selezionare il layer. Layer 2 per il lato  
“rame” o layer 16 per il lato “componenti”. Sulla barra orizzontale al centro circa, ci sono 
dei rettangolini colorati col numero dentro: il primo che appare, un pò distanziato dagli altri 
verso sinistra, è il layer selezionato. Quelli a destra sono quelli usati di recente.
Inoltre, sempre sulla barra orizzontale, c’è un’icona col simbolo dei layers sovrapposti. M1 
Apre una finestra con tutte le opzioni esposte in modo chiaro.

3.5 Posizionamento dei componenti ( Packages ) sul PCB. Autoplacer
Posizionamento a mano 
Soluzione preferibile perché i componenti vengono disposti con un ordine razionale scelto 
dall’operatore. I motivi di questa scelta sono: 1 - problemi di spazio e conseguente ottimale 
posizionamento  dei  componenti  ingombranti.  2  -  rispecchiare  lo  schema  elettrico  per 
facilitare  la  localizzazione  delle  funzioni,  3  -  criteri  che  evitino  reciproche  influenze  e 
accoppiamenti  EMC. 4 – Criteri  per un miglior  smaltimento del  calore e per evitare di 
concentrare componenti che sviluppano calore e creare zone in cui vi è accumulo di calore 
e conseguente aumento della temperatura.
Selezionare  l’icona  del  circuito  integrato  nella  barra  alta  orizzontale.  Appare  Import  
packages  che riporta la lista dei componenti impiegati nello schema elettrico: posizionare i 
componenti uno per uno nel perimetro del PCB prima disegnato.
Via via che si immettono i componenti, la lista diminuisce fino ad esaurirsi.
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Altrimenti si può usare l’Autoplacer: 
Actions > Launch autoplacer. 
Si apre la finestra Autoplacer. Rispondere alle domande: Place components inside (dentro 
il ) the PCB, opzioni su SMD ecc.  In particolare quando chiede:
Additional  space between components,  scegliere  la  distanza che si  vuole  tra  i  singoli 
componenti usando il  lato della griglia come unità di  misura. Es. 10, 20 volte il  lato di  
griglia. Comunque, dopo il posizionamento automatico, i componenti si possono sempre 
spostare dove ci pare.
Se  un  componente  è  posato  sul  PCB,  esso  avrà  automaticamente  nel  disegno  dello  
schema elettrico, un segno di spunta accanto alla crocetta di manipolazione ( manico ).
Se un componente inserito nel PCB non appare collegato con gli  elastici (collegamenti 
ideali corrispondenti a quelli realizzati nello schema elettrico ) , controllare lo schema e 
che sia stato regolarmente collegato. Premere  Packages > Import packages sulla barra 
orizzontale e controllare nella lista che appare, che tutti i componenti siano stati importati  
( lista vuota ).
Per spostare un componente da una faccia all’altra del PCB: M1 e tasto (m ), ( funzione 
specchio mirror )

3.6 Copiare un oggetto: M1 sul componente. Icona del taccuino con la freccia che entra, 
sulla barra orizzontale alta. Per rilasciare la copia usare il taccuino con la freccia uscente.

3.7 Piazzole ( pads )
Per posizionare le piazzole scegliere “Elements” sulla barra orizzontale e poi  Place pad. 
Oppure premere semplicemente il tasto 1 della tastiera.
Per cambiare la forma e le dimensioni: M11 sulla piazzola e rispondere alla domande della 
finestra che si apre.

3.8 Scelta del layer per disegnare una traccia.
Sulla  barra  orizzontale  al  centro  destra,  ci  sono una fila  di  quadratini  colorati  con un 
numero  interno  rappresentante  un  layer.  Per  disegnare  una  traccia  in  un  dato  layer,  
selezionarlo con un click. Il simbolo si sposta all’inizio della fila. Si può ora deporre una 
traccia in quel layer.
Per passare con una traccia da un lato all’altro del PCB tramite un “via” ( metallizzazione 
passante in un foro da un lato all’altro ) premere il tasto del punto (.) poi M1.
Si può cambiare il layer su cui si vuole stendere una traccia tramite due punti (:). Si apre  
una finestrella che offre tre possibilità: cambiare layer senza via, con apertura di finestra di 
dialogo e scelta, oppure con traccia su tutti i layers.

3.9 Tracce
• tasto 2 della tastiera oppure 
• icona sulla barra orizzontale col disegno in rosso e blu delle tracce, oppure
• Elements> Draw track

3.10 Cambiare larghezza di una traccia 
Possibilità immediata: M11 sulla traccia per aprire la finestra di dialogo  
Oppure: Elements > Draw tracks (2) > tasto ( o ) options > Scegliere.
Oppure se la traccia è già disegnata, si seleziona prima la traccia . Poi si va su  Edit > 
Edit.... oppure tasto (e). Si apre la finestra delle tracce, con tutte le opzioni.
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3.11  Aura di una traccia
Le tracce devono osservare una distanza tra loro per evitare il rischio di archi elettrici. Per 
questo  il  programma prevede uno  spazio  intorno sia  alle  piazzole  sia  alle  tracce  per  
prevenire questa possibilità. Questo spazio circostante si chiama “Aura “.
Per attivare o scegliere la larghezza dell’aura circostante, fare M11 sulla traccia. Nella 
finestra che appare selezionare la voce Track aura.

3.12 Selezione della estensione del percorso di una traccia
Questa funzione permette di cancellare, quando occorre, la sola parte di traccia che ci 
interessa eliminare.
Sulla  barra  verticale  a  destra  andare  su  Settings.  Appaiono  delle  icone  con  varie 
possibilità: un singolo tratto di una traccia, due tratti consecutivi senza piazzola, più tratti 
con piazzole, oppure l’intero percorso. 

3.13 Inserire un ponte di attraversamento su di una traccia
Elements  > Place a bridge oppure “b”.  Posizionarsi  prima da un lato  della  traccia  da 
attraversare, nel punto ove dovrà essere rilasciata la piazzola di partenza, poi M1h fino 
alla piazzola sull’altro lato della traccia. Se si vuole un ponte sul lato componenti [ Top 
layer, (16) ] fare doppio click ( M11 ) sopra la traccia del ponte e scegliere il layer nella 
finestra che appare ( Change track ).

3.14 Funzione Autorouter
Usarlo per uno sbroglio iniziale, poi modificare  al meglio dopo l’auto stesura. 
Occorre che prima siano stati piazzati i componenti. 
Percorso: Actions > Hybrid autorouter. Si apre una finestra di dialogo con tre linguette. 
Per scegliere la larghezza delle tracce, linguetta Signals e Click su Minimum track width. 
Nella casella inserire la larghezza minima delle tracce in mils.
Per scegliere su quali  layers (  lato,  faccia o strato )  stendere le tracce, fare M1 sulla  
linguetta Route Layers. A sinistra si sceglie il lato, a destra si seleziona. Se non si vuole 
tracce su quello strato, M1 su Is blocked for all signals,
Per cancellare tutte le trace auto-disegnate prima, fare M1 su Actions>Autorouter> Delete  
all tracks routed automatically.
Durante l’operazione di  Autorouter,  si  apre una finestra ove un recipiente a sinistra si  
colora di verde e uno a destra si svuota di rosso. Solo se il recipiente si è completamente 
svuotato di  rosso l’operazione ha avuto buon esito. Se rimane del rosso, vi  è qualche 
traccia non eseguita ed è necessario o modificare la posizione di alcuni componenti o 
usare due layers anziché uno solo, cioè PCB doppia faccia anziché monofaccia, oppure 
anche più layers.
Attenzione! E’ possibile che alcune tracce non vengano disegnate, specialmente in zone 
anguste, perché la loro aura è troppo larga e non lo consente. Ridurre l’aura della traccia; 
selezionare la traccia con M11, premere (o ) e ridurre l’aura.

3.15 Groundplanes
E’  il  riempimento di  massa steso sul  lato  rame del  PCB. Si  usa come schermo nelle  
realizzazioni in alta frequenza

• Actions > Groundplanes  > Generate PCB groundplane. oppure
• Icona della bacchetta magica e poi quella rossa con la traccia.

Per riempire le piazzole di terra, selezionare pad con una crocetta nel pannello che 
definisce le caratteristiche del groundplane.
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3.16 Inserire un testo sul PCB
Premere sulla tastiera il tasto delle doppie virgolette ( “ ). Appare una finestra con tutte le  
opzioni. Se interessano simboli speciali, scegliere un numero ANSI corrispondente nella  
finestrella Ansi extra character . Accanto appare in chiaro il simbolo e la freccetta permette 
di inserirlo nel testo che si sta scrivendo.
Per scegliere il layer ove scrivere, selezionare la finestrella Layer e selezionare il numero 
corrispondente. Es.: lato rame = 2.

3.17 Evidenziare il percorso di una traccia ( Highlight )
Questa  funzione  è  utile  quando,  a  lavoro  finito,  occorre  controllare  la  correttezza  dei  
collegamenti. Occorre premettere che se il progetto prevede uno schema elettrico e un 
PCB, le tracce nel  PCB corrispondono automaticamente a quelle  dello schema senza 
possibilità di errore. Tuttavia, per controllare personalmente il tracciato, agire così:

• Scegliere  il  colore  da  assegnare  alla  traccia  che  si  vuole  evidenziare.  Barra 
orizzontale > icona dell’occhio > circoletto  colorato > PCB. Selezionare  On this 
color.  Accanto appare il colore. Se non piace, si può cambiare con M1 >  Select  
color > Spostare le slitte Red, Green, Blue riferendosi al campione a sinistra.

• Nella barra verticale destra in Settings, selezionare la estensione della traccia.
• M1 su un tratto della traccia da evidenziare

3.18 Air wires e Ratsnest  - Elastici
Air  wires sono  chiamate  le  sottili  linee  verdi  che  collegano  i  componenti  nel  PCB, 
conformemente a quanto disegnato nello schema elettrico, e che seguono il componente 
se si sposta col mouse. Chiamati in italiano elastici. Sono selezionabili ( deselezionabili ) 
nell’icona della bacchetta magica, facendo M1 sulle tre X verdi.  L’intera rete di  elastici  
forma la Ratsnest ( nido dei topi ).

3.19 Coordinate Assolute / Relative
Le  coordinate  assolute  si  riferiscono  all’intero  foglio  di  lavoro.  Quelle  relative  sono 
impostabili  in  un  qualsiasi  punto.  Per  impostare  lo  zero  delle  coordinate  relative, 
posizionarsi nel punto e premere il tasto Home della tastiera. ( Quello che porta all’inizio di  
un documento ). Vale il viceversa. Questa opzione è molto utile per disegnare il contorno 
della basetta dello stampato, o per posizionare con precisione componenti ingombranti.

3.20 Misura di una distanza nel PCB
Nel PCB è possibile misurare una distanza:

• Icona della bacchetta magica > Icona del righello, oppure
• Posizionarsi sul punto di partenza. Tasto “u” della tastiera. M1 sulla destinazione, 

spostare il mouse e M1. Appare una finestrella con la misura .

3.21 Calcolo delle spaziature e delle geometrie dei conduttori e max correnti
        ammesse.
Premendo Help nella barra alta orizzontale, le prime 4 righe aprono una finestra ( Tools ) 
che calcola e fornisce come risultato le seguenti utili risposte:

• Codice dei colori di resistenze, condensatori di varie fogge e dimensioni
• La distanza di isolamento tra le tracce in funzione della tensione  applicata per 

evitare archi
• La resistenza delle tracce in base alle loro geometrie.

29



• La corrente massima consigliata in funzione dello spessore dei conduttori, sia 
tracce del PCB che conduttori di rame tondi pieni . 

I risultati calcolati dal programma si riferiscono a correnti continue o lentamente variabili 
nel tempo, non viene cioè considerato l’effetto pelle, le capacità e le induttanze distribuite 
nelle tracce.
Note: Engineering s esprime le grandezze nel sistema MKS. ( metro, kilo, secondo). 
Ad es:.per le capacità, se la casella è selezionata sono espresse in Farad. Se non 
selezionata in pF.
L’espressione with, without solder stop significa con o senza vernice protettiva. Si noti 
l’importanza dell’effetto. 

3.22 Visione in 3D del PCB finito
Premere il tasto 3D nell’icona in alto a destra sulla barra orizzontale. Affinché l’immagine 
del PCB assuma una dimensione adeguata allo schermo, usare la rotella del mouse. 
Per ruotare la basetta del PCB e vederla anche di sotto, fare M1h con il mouse.
L’icona in  alto  a  sinistra  con la  crocetta  serve  a  posizionare  il  PCB con i  tre  assi  in  
posizione iniziale.
A  sinistra  appare  una  barra  verticale  che  contiene  tutti  i  componenti,  suddivisi  per 
categoria.
Per  trovare  un  componente,  M1  sul  nome:  il  componente  si  colora  di  azzurro.  Per 
deselezionare, M1 fuori della scritta.
Per fare scomparire momentaneamente un componente e leggere quanto scritto sotto, 
fare M1 sulla relativa spunta nel quadratino a sinistra. M1 per farlo riapparire.
La visione in 3D non è una frivolezza, ma, al contrario, a parte il piacere di vedere subito 
realizzato  il  nostro  lavoro,  è  incredibilmente  utile  per  verificare  eventuali  errori,  per 
esempio di spaziatura tra componenti o quando abbiamo creato noi stessi il disegno 3D di 
un nuovo componente e non appare corretto. 

3.23 Controllo del progetto
Prima di passare alla realizzazione è possibile effettuare un controllo di progetto con due 
funzioni: La funzione REO già trattata al par. 1.29, e la funzione Check Project. 
Icona della bacchetta magica sulla barra orizzontale > Icona del fulmine.
Si apre una finestra di dialogo con tre colonne: quella di sinistra controlla lo schema 
elettrico, quella centrale il PCB e quella di destra le spaziature minime.
Ogni colonna prevede una serie di controlli da attivare con una spunta, poi > Check.
Comunque, prima di eseguire questa funzione, è bene aver effettuato il controllo REO.

3.24 Disegno di pannelli di alluminio
Una volta disegnato il  circuito stampato, è possibile disegnare pannelli  di alluminio per 
frontalini di  armadietti  o in genere di contenitori del progetto che si sta realizzando.
Si apre un nuovo progetto: New project > Aluminium front panel > OK.
Appare una finestra che richiede larghezza, altezza, spessore del pannello. >  Generate 
Front Panel.  Appare il pannello con le misure richieste. A sinistra c’è una colonna con 
tutte  le  icone  rappresentanti  disegni  di  forature  consuete   e  altre  possibilità   tutte 
facilmente intuibili.
Le scritte possono essere stampate ( T sopra Imprinted ) o incise (T sotto Engraved ) con 
ampia scelta di caratteri.
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4 - CREARE UN NUOVO COMPONENTE

La procedura per la creazione di un nuovo componente si svolge in tre fasi: 
1 - prima si disegna l’orma del componente sul foglio del circuito stampato, dotata delle 
piazzole a cui si collegheranno le tracce.
2  -  poi  si  disegna lo  schema elettrico  con i  piedini  numerati  che verranno riferiti  alle 
piazzole precedenti
3 - Infine si concatena lo schema elettrico del componente con la sua orma sul circuito 
stampato e si immette nella libreria.

4.1 Disegno del componente sul circuito stampato

1  -  Aprire  un  nuovo  progetto  File  >  New  Project.  Scegliere  Single  sided  PCB  with  
schematic.

2 – A foglio aperto, selezionare la modalità PCB, e scegliere le dimensioni della pagina  
ove  rappresentare  il  componente.  Impostare  una  quadrettatura  del  foglio  in  mils,  per 
esempio 50 mils per quadretto con griglia a linee.

3 - Disegnare ( icona della matita ) con misure esatte in mils, l’ingombro massimo che 
rappresenta l’orma del componente sul PCB. Conviene disegnare l’oggetto centrato sulla 
croce tratteggiata  nel centro del foglio. Ciò renderà più facile la misura dei lati metà a 
destra e metà a sinistra della croce, metà sopra e metà sotto.

4 - Inserimento delle piazzole. Premere il tasto “1”  della tastiera, poi M11 per impostare le 
opzioni delle piazzole da disegnare. Consiglio: disegnare piazzole ragionevolmente grandi 
per un miglior sostegno meccanico dei componenti. Attenzione! Il layer per le piazzole è il  
n° 100 che si collega a tutti i layers. Se si imposta un numero diverso, il programma non 
accetterà i collegamenti.
Per  componenti  polarizzati,  creare una piazzola di  riferimento con forma diversa dalle 
altre, per es.: quadrata e le altre tonde.

5 – Assegnazione della sigla e del numero progressivo del componente. Posizionare il  
puntatore nel punto più adatto per inserire il codice progressivo. Digitare sulla tastiera le 
virgolette ”. Appare la finestra  Text Options. Scegliere “Component Name”. Chiudere la 
finestra. Con questa operazione nel disegno del PCB su ogni componente sarà indicata la 
sua sigla e il numero progressivo.

6 - Racchiudere in un rettangolo ( M1h ) tutto il disegno. Poi posizionare il puntatore del  
mouse nel centro del disegno e premere il tasto “x”. ( = E x port ). Col tasto x abbiamo 
creato un nuovo package e aperto la finestra “Export Package”. Inoltre, nel punto ove è 
posizionata la freccetta del puntatore,  viene posizionata la crocetta di manipolazione del 
componente.

7  –  Ora  dobbiamo  caratterizzare  il  nuovo  package  assegnandogli  un  nome  ed  altre 
caratteristiche. Nella casella “Package Type” scegliere il tipo. Per es. Transformer.
Assegnare un nome al package. Poi OK
Appare  ora  la  finestra  della  libreria  dei  componenti.  Premere  Edit.  Il  package  è  ora 
realizzato e esportato nella libreria. 
In basso a destra appare la casella dell’immagine 3D.  Fare M2 sull’immagine e M1 su 
Edit. Appare la finestra del disegno 3D. Se conveniente, accettare una immagine estrusa 
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preconfezionata  del  componente.  Altrimenti  disegnare  il  tutto  seguendo  le  istruzioni 
esposte nel capitolo 5.
Per ora abbiamo creato solo un “Package” del nuovo componente. Di seguito creeremo un 
disegno nello schema elettrico e lo assoceremo a quel package. 

4.2 Disegno del componente sullo schema elettrico
1 - Aprire un nuovo progetto e selezionare il foglio dello schema elettrico.
Per il disegno dello schema elettrico del componente, si può o sceglierne uno già esistente 
in libreria e modificarlo, o, in mancanza, disegnarne uno nuovo ( icona della matita ).

2 - Inserire i terminali per i collegamenti esterni e che dovranno corrispondere alle relative 
piazzole  del  componente  nel  PCB.  Controllare  la  corrispondenza  della  numerazione. 
Posizionare il puntatore sul punto del disegno ove occorre mettere il terminale e premere il  
tasto “1” della tastiera.

3 - Assegnare un nome al componente e un valore. 
Posizionare il cursore ove si vuole la lettera progressiva indicativa del componente.
Premere il tasto virgolette (  “ ). Appare la finestra “Text Options”. Nella casella centrale 
bassa  dove  è  scritto  Normal  text selezionare  Component  name e  OK.  Sullo  schema 
appare la scritta !COMPONENT.  Poi selezionare Component Value e OK. Ora appare la 
scritta !VALUE. A queste due variabili verrà poi assegnato durante il lavoro la sigla reale 
col numero progressivo e il valore del componente.

3  –  Raggruppare  tutte  le  parti  disegnate.  Racchiudere  con  M1h  tutte  le  parti  da 
raggruppare.  Poi  posizionare  il  cursore  sul  punto  dove  si  vuole  la  crocetta  di 
manipolazione e premere “y” ( da sYmbol ). Le parti sono ora raggruppate.

5 – Inserimento nella libreria e associazione al package. Tasto “x” da “ eXport” .
• Racchiudere il simbolo completamente con M1h e premere “x”. Appare la finestra 

Export Symbol.
• Selezionare “Only own components” per assegnarlo alla libreria personale.
• Scegliere il tipo di componente es. Transformer.
• Inserire i parametri del componente, n° spire tensione corrente potenza.
• Inserire il nome del package realizzato prima nel PCB. Es.:  EE42x15x12.
• Selezionare “Manufacturer not clear”
• Inserire la sigla che si desidera per individuare il componente es.: Trf
• Save component

A questo punto la  procedura è terminata e si  può andare a cercare il  componente in 
libreria.

Attenzione! Per far accettare !Component name e !Value ad un componente ricavato da 
un altro, occorre sempre 

1. Nello  schema  cancellare  le  parti   e  le  scritte  non  necessarie  del  componente 
origine,

2. Racchiudere  l’intero  disegno  e  premere  “y”  per  indicare  al  programma  che 
disegniamo un nuovo componente.

3. Inserire le scritte come al punto 4.
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4. Selezionare di nuovo l’intero simbolo e premere “y” sulla crocetta per assegnare le 
scritte al simbolo.

5. Infine racchiudere di nuovo e premere “x” per inserirlo in libreria, rispondendo prima 
alle domande.

Nota: Quando, a operazioni finite,  le precedenti  scritte !COMPONENT e !VALUE nello 
schema elettrico rimangono, mentre scompare solo il simbolo, significa che non sono state 
acquisite.
In tal  caso, premere il  tasto di ritorno indietro, per far apparire di nuovo il  disegno del  
simbolo,  senza doverlo  ridisegnare  daccapo;  racchiudere  tutto  il  disegno compreso le 
scritte  e  premere  “y”  di  nuovo.  Poi  ancora  racchiudere  e  premere  “x”.  Riempire 
nuovamente le caselle e salvare.
Ricordarsi che la procedura ora esposta si riferisce solo al foglio dello schema elettrico e 
non a quello del PCB! Nel PCB occorre racchiudere il disegno e premere solo  “x”! 

4.3 Assegnare un componente alla Libreria personale
Si va sulla finestra del Package. Click M2 nella colonna di destra sulla casella nera “User” 
del componente interessato > Import component in My list > Scegliere la lista interessata. 
Per deselezionare da una lista, fare click sulla lista stessa.

4.4 Disegno di un nuovo componente SMD
Di solito un componente SMD e la sua orma vengono disegnati sul lato rame del PCB, 
però per evitare errori, conviene prima disegnare tutto sul lato componenti e poi ribaltare 
sul rame. 
Si comincia con il disegno delle piazzole, prima quella di sinistra cui verrà assegnato il n°1, 
poi  quella di  destra.  Sul lato rame, verranno rappresentati  invertiti  da destra a sinistra 
perché il lato rame è visto in trasparenza dal lato componenti.
Con M11 su una piazzola, si apre la finestra “Change Pads” e si modificano le caselle:

1. Le dimensioni delle piazzole, per 1206, per es.: 70 x 70 mils.
2. La forma è rettangolare
3. Arrotondamento:  “0”
4. Layer : 16 ( lato componenti )
5. Rotazione: 0
6. Foro del trapano Drill hole: 0

Poi, se si vuole, si memorizzano questi dati nella finestra Change pads; sulla colonna di 
destra; click sulla freccetta della prima casella libera, scegliere il nome ( SMD ) e OK. Ora,  
premendo semplicemente il tasto di quella casella, si richiamano i dati impostati che si 
applicano alle piazzole successive, senza doverli riscrivere per ciascuna.

Disegno dell’orma del componente.
Prima si imposta il layer n° 21, andando sulla barra orizzontale sull’icona dei layers. Nella  
finestra che si apre, nella casella in basso a destra intitolata “ For other drawing elements” 
impostare il layer 21 .
Si seleziona il simbolo della matita sulla barra alta orizzontale e si esegue il disegno. 
A disegno ultimato, racchiudere il tutto con un rettangolo M11, e posizionare il cursore ove 
si  vuole  la  crocetta.  Quindi  premere  “x”.  Alla  fine  le  piazzole  devono  apparire  blu,  il 
disegno dell’orma nero e la crocetta nera.
Successivamente, disegnare la figura in 3D del componente e salvare. Vedi cap.5.
Per  trasferire  sul  lato  rame  il  nuovo  componente  SMD,  fare  click  sulla  crocetta. 
Selezionare “Edit “ sulla barra orizzontale alta. Click su “Mirror flip horizzontally; oppure 
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click  sulla  crocetta  e  tasto  “m”.  Il  componente  passa  sul  lato  rame.  Verificare  con 
l’immagine del PCB finito in 3D che tutto sia a posto.

4.5 Creazione di un nuovo circuito integrato ancora non presente in libreria.

1. Procurarsi un campione fisico o il data sheet del circuito integrato.
2. Aprire un nuovo progetto “PCB with schematic”.
3. Selezionare la griglia più adatta, es. 25 mils a punti.
4. Selezionare il layer 21 ( click sulla casella 21 nella barra verticale ). Nel caso di 

componente SMD il layer è il n° 7.
5. Disegnare un rettangolo centrato sulla croce tratteggiata del  foglio,  seguendo le 

misure del package del data sheet del CI.
6. Sul lato verticale sinistro inserire la chiave del package, cioè un semicircoletto o 

una V orizzontale. ( selezionare il lato sinistro verticale, fare M2 e Insert corner.
7. Piazzare le piazzole: Selezionare il simbolo della matita sulla barra orizzontale e poi 

quello della piazzola. Premere “o” per le opzioni e selezionare. Fra queste scegliere 
il  layer  100  che  comprende  tutti  i  layers.  Per  gli  SMD  scegliere  il  layer  di  
deposizione ( 2 ).

8. Posizionare le piazzole premendo il tasto 1. Una volta depositate, controllare bene 
le misure con quelle del data sheet.

9. Salvataggio del package: Racchiudere in un rettangolo ( M1h ) tutto il disegno. Poi  
posizionare  il  puntatore  del  mouse  nel  centro  del  disegno:  in  quel  punto  verrà 
posizionata la crocetta del componente. Premere “x” per aprire la finestra “Export  
package”. Nella casella Package Type scegliere il tipo. Per es. THT ( Through Hole 
Technology ). Assegnare un nome al package ad es: DIP14. Poi OK.

10. Appare ora la finestra della libreria dei componenti. Premere Edit. Il package è ora 
realizzato e esportato nella libreria.

Per completare il lavoro occorre ore creare uno schema elettrico del componente con i 
relativi piedini di collegamento che dovranno essere associati alle rispettive piazzole del 
package.

4.6 Disegno del circuito integrato sullo schema elettrico
1. Aprire un nuovo progetto e richiamare il foglio dello schema elettrico. Disegnare il  

simbolo elettrico del componente.
2. Poi  si  debbono  inserire  i  pin  per  i  collegamenti  esterni  e  che  dovranno 

corrispondere ai relativi pad ( piazzole ) nel PCB:.Tasto 1 “Place free pins”. OK
3. Appare una lista di pin numerati con accanto le scritte Pin1, Pin2, Pin3 ecc.
4. Fare doppio click M11 sul pin rosso n°1. Appare la finestra “Change pins”.
5. Selezionare “Edit pin name” e inserire la sigla della funzione del pin: GND, IN, VCC, 

CLK ecc. Ripetere per tutti i pins.
6. Click M1 su ogni pin e poi con M1h spostare ciascuno nella giusta posizione sul  

simbolo.
7. Assegnare un nome e un valore al componente: posizionare il cursore ove si vuole 

la  scritta.  Click  su  “  .  Selezionare  !COMPONENT NAME poi  OK e  di  nuovo  ! 
COMPONENT VALUE.

8. Cancellare provvisoriamente i  piedini  di  alimentazione Vcc e GND che verranno 
assegnati a parte. 

9. Racchiudere completamente il disegno con un rettangolo tramite M1h. posizionare 
il  cursore  nel  punto  ove  si  vuole  la  crocetta.  Premere  il  tasto  “y”.  Ora  tutti  gli 
elementi del disegno sono assemblati per permettere di esportarli in libreria.
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10. Piedini di alimentazione. Disporre i due piedini come riportato in figura, uno sopra e 
uno sotto. Premere il tasto “ per assegnare un nome al componente come fatto per 
il circuito.

11.
12. Il nome dei piedini Vcc e GND può essere cancellato con la funzione Delete. 
13. Racchiudere in un rettangolo i piedini tramite M1h. Poi posizionare il puntatore nel 

centro.
14. Premere il tasto”y” per piazzare la crocetta.
15. M11 sulla crocetta per aprire la finestra di dialogo “Change Symbol”. 
16. Nella finestra Symbol number mettere: 2 per significare due liste una per le funzioni 

logiche del C.I e una per l’alimentazione. Suffix = p per power supply. Insert = Extra 
insert as Rest vuol dire inserimento a parte con la funzione Rest of the component.

17. Ora  raccogliere  con  un  rettangolo  sia  lo  schema  del  circuito  integrato  che  le 
alimentazioni  Con M1h. Premere “x”  per esportare il  simbolo in  libreria.  Appare 
“Export component into library”.

18. Selezionare  New library per creare la libreria personale. Aggiungere la sigla del 
nuovo circuito integrato e OK. Appare “Prefix and proposal for the package.”

19. Selezionare IC nella casella Prefix e assegnare la proposta es.: DIL8. Premere OK.

La creazione del nuovo IC è finita. Controllare nella libreria il risultato. Per circuiti integrati  
logici con vari ingressi occorre una procedura particolare da leggere nel sito apposito.

4.7  Circuito integrato contenente più stadi uguali
1. Aprire la pagina dello schema in un nuovo progetto.
2. Disegnare con l’icona della matita, tante figure geometriche rappresentanti 

ciascuno uno stadio. Per esempio per un amplificatore operazionale con 4 stadi 
uguali, disegnare 4 triangoli. Per velocizzare l’operazione e disegnare i triangoli con 
le stesse misure, disegnare il primo e poi copiare da questo ( Edit > Copy ) tutti gli 
altri ( Edit Paste ).

3. Con il tasto1, deporre tutti i terminali (pin) degli stadi, eccezion fatta per i terminali 
della alimentazione comune.

4. Se si vuole, si può sostituire alle scritte Pin1,Pin2…dei terminali, le sigle delle 
singole funzioni, ad es.: in+, in-, out, oppure cancellare Pin1,Pin2... Per questa 
operazione fare M11 sulla scritta del pin poi Change text > Content > scrivere la 
sigla, es.: in- ,in+ , out. Poi OK.

5. Inserire la crocetta di manipolazione, selezionando con M1h ciascuno stadio 
racchiudendo anche le relative scritte. Quindi porre il puntatore ove si vuole la 
crocetta, ad es.: nel centro dello stadio, e premere il tasto y. Questa operazione va 
ripetuta per ogni stadio.

6. E’ giunto il  momento di  disegnare le alimentazioni.  Disporre i  due piedini  come 
riportato in figura, uno sopra e uno sotto. Posizionarsi in un punto e premere il tasto  
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“ per assegnare un nome al componente come fatto per il circuito. Selezionare !
COMPONENT.

7. Sostituire la numerazione dei piedini con quella corretta.
8. Racchiudere in un rettangolo i piedini tramite M1h. Poi posizionare il puntatore nel 

centro. Premere il tasto”y” per piazzare la crocetta. 
9. M11 sulla crocetta per aprire la finestra di dialogo “Change Symbol”. Nella finestra 

Symbol number, se vi sono due stadi, mettere: 3 per significare tre liste, due per gli 
stadi e una per l’alimentazione. Suffix = P per power supply. Insert = Extra insert as 
Rest vuol dire inserimento a parte con la funzione Rest of the component.

10. Ripetere l’operazione per i singoli stadi inserendo un numero progressivo a Symbol 
number ,  Suffix = A,B,… ,  Insert = Automatically insert as next. Swap N°.=0

11. A questo punto raccogliere ( M1h) con un rettangolo sia lo schema dei singoli stadi  
che le  alimentazioni  e  premere “x”  per  esportare  il  circuito  integrato  in  libreria. 
Appare “Export  symbol”.  Rispondere alle domande, tipo del  componente,  nome, 
Manufacturer ( not clear ), Package e sigla ( Prefix) del componente ( IC ). Save.

Per  assegnare  il  componente  alla  libreria  personale  andare  nella  grande  finestra 
Components, M2 nella casella del componente, Import component in my component list >  
Libreria personale.
La creazione del nuovo IC è finita. Controllare nella libreria il risultato. 

4.8 Modifiche successive
Per  effettuare  modifiche  su  componenti  già  creati,  package  o  schematic,  si  va  nella 
finestra dei  componenti,  si  seleziona il  componente e si  fa  M2 nella casella a sinistra 
Component  name,  poi  Edit  component  properties o  Symbol,Package,3D,Simulation  a 
seconda di cosa si deve cambiare.
Per assegnare un nuovo Package alla Libreria Personale, click sulla linguetta “Package”, 
click sul componente nella colonna di destra, poi Package nella barra orizzontale > Enter 
package in list.
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5 - COSTRUIRE IMMAGINI IN 3D DEI COMPONENTI

5.1 La creazione di immagini di componenti in 3D
Per dotare un componente dell’immagine in 3D del suo involucro, si deve avere prima 
disegnato il  package e salvato nella libreria personale. Altrimenti  se si  vuole dotare di  
immagine 3D un componente  già  pronto  di  Target,  andare  nella  finestra  Components 
selezionare il componente fra quelli di Target e fare M2 nella sua casella sinistra.
Simbol,package,3D,simulation > Edit 3D.  Nel riquadro in basso con gli assi che ruotano, 
fare M2 su Edit, poi M1.
Il programma ora richiede di creare una copia per l’utente  User del componente scelto. 
Rispondere si e poi ancora si per fare una copia anche del simbolo. 
Si  richiede ora  se  il  programma deve disegnare automaticamente  un modello  estruso 
dell’orma del componente prima disegnata. Se non interessa > No. Appare la finestra con 
in basso lo spazio per scrivere il codice.
Le coordinate sono espresse in mm. I decimali sono separati da un punto.
L’asse X ( rosso ) rappresenta le ascisse e positivo punta a est, negativo a ovest.
L’asse Y ( verde ) rappresenta le ordinate. Positivo a nord e negativo a sud.
L’asse Z ( blu ) positivo punta verso l’alto e negativo verso il basso. E’ ortogonale al piano 
XY.
Ogni coordinata espressa è separata da una virgola, in successione x,y,z.
Esempi:
0,0,0 è il puto di origine degli assi sulla superficie superiore della basetta.
0,0,0.5 è un punto 0,5 mm sopra l’origine
Gli angoli sono espressi in gradi 0.0  -  360.
Sul piano della basetta, gli angoli positivi sono antiorari, cioè girano dall’asse X a Y e nel 
piano XZ, dall’asse X all’asse Z, nel piano YZ dall’asse Y allo Z

I  colori  sono  definiti  da  tre  byte  esadecimali  da  0  a  FF  preceduti  da  $  e  ciascuno 
rappresentante  l’intensità  di  uno  dei  tre  colori  in  ordine  blu,  verde,  rosso.  A  numero 
maggiore corrisponde intensità di colore minore.
Esempi:
$FFFFFF bianco
$0000FF rosso
$00FF00 verde
$FF0000 blu
$000000 nero
$888888 colore stagno

La sintassi di scrittura del codice per ogni elemento è scritta linea per linea.
Per il solido parallelepipedo tutte le scritte dopo il raggio di smussatura, sono interpretate  
come commenti e non hanno alcun effetto sul modello.
Per tutti gli altri corpi tutte le scritte dopo quella del colore e virgola sono interpretate come 
commenti e non hanno alcun effetto sul modello.
 
Sono definiti i seguenti solidi:

5.2 Solido S (parallelepipedo). 
Si introduce di seguito il concetto di “asse mediano” valido per i solidi parallelepipedi e per  
i cilindri. Si considerino due punti nello spazio P1 = X1,Y1,Z1 e P2 = X2,Y2,Z2 che distano  
tra loro “d”.  Per i  due punti  passa un asse mediano. La distanza “d” rappresenterà la 
larghezza  del  parallelepipedo  che  si  vuole  disegnare.  Si  consideri  la  superficie  
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rettangolare larga “L”  e alta “H” perpendicolare all’asse, centrata su di esso. (cioè l’asse 
passa nell’incontro delle due diagonali del rettangolo ). Se si sposta idealmente questa 
superficie  da  un  punto  all’altro  percorrendo  la  distanza  d,  essa  raffigura  un  solido 
parallelepipedo. Il solido nasce dal movimento della superficie L x H per una larghezza d. 
Per  realizzare il  solido,  occorre  partire  dai  due punti  P1 e P2 per  cui  passa l’asse e 
assegnare larghezza e altezza della superficie mobile perpendicolare all’asse mediano.
Gli spigoli del parallelepipedo sono arrotondati da un raggio di curvatura. 
Con un segno – davanti a S il corpo diventa trasparente e si vedono solo i lati.

Sintassi: SX1,Y1,Z1,X2,Y2,Z2,L,H, colore, raggio di curvatura.
S informa il programma che si vuole disegnare un parallelepipedo. Seguono le coordinate 
dei due punti,P1 e P2 sull’asse mediano centro delle due superfici laterali di dimensioni L x 
H.
Esempio: S0,0,15,25,0,15,20,10,$0000FF,0.2 Parallelelepipedo di superfici laterali 20 x 10 
e distanti 25 mm. Colore rosso con spigoli arrotondati con raggio 0,2mm.

5.3 Cilindro C
Cilindro dotato di superfici laterali circolari. L’asse mediano di cui sopra passa per i loro 
centri.  La distanza dei  centri  rappresenta l’altezza del  cilindro. Occorre poi indicarne il 
diametro D.
Sintassi:
CX1,Y1,Z1,X2,Y2,Z2, D ,colore,
Esempio: C5,0,10,5,0,40, 7,$888888 cilindro verticale di diametro 7mm, sollevato 10mm 
dal piano XY, alto 40-10=30mm.

5.4 Toro T 
Volume ottenuto dalla rotazione di un cerchio di diametro “d”  intorno ad un asse, con 
centro di rotazione distante “R” dall’asse.
Sintassi:
TZ ha un asse di rotazione parallelo all’asse Z. Pm(Xm,Ym,Zm) è il centro di rotazione per 
cui passa l’asse di rotazione parallelo a Z, R il raggio di rotazione intorno all’asse,  “d” il 
diametro del cerchio che ruota. 
Sintassi:
TZXm,Ym,Zm,R, d, angolo iniziale,angolo finale, colore.
Esempio: TZ8,5,10,6,4,0,180,$0000FF. Toro sollevato 10 mm dal piano XY con centro di 
rotazione X=8 Y=5, raggio di rotazione R = 6, diametro del cerchio 4, inizia a ruotare a 0°  
e termina a 180°. Colore rosso.
TX ha un asse di rotazione parallelo all’asse X. Pm(Xm,Ym,Zm) è il centro di rotazione per 
cui passa l’asse di rotazione parrallelo a X, R il raggio di rotazione intorno all’asse,  “d” il  
diametro del cerchio che ruota. 
Sintassi:
TXXm,Ym,Zm,R, d,angolo iniziale,angolo finale,  colore.
Esempio: TX10,10,10,6,4,0,18,$888888

TY ha un asse di rotazione parallelo all’asse Y. Pm(Xm,Ym,Zm) è il centro di rotazione per 
cui passa l’asse di rotazione parrallelo a Y, R il raggio di rotazione intorno all’asse,  “d” il  
diametro del cerchio che ruota. 
Sintassi:
TYXm,Ym,Zm,R, d, angolo iniziale,angolo finale,  colore.
Esempio: TY10,10,10,6,4,0,18,$888888

39



Disegnare una sfera: basta mettere R=0. d = diametro della sfera.
TZXm,Ym,Zm,0, d, angolo iniziale,angolo finale,  colore.
X,Y,Z dopo T è indifferente, non ha più senso l’asse di  rotazione, come pure l’angolo 
iniziale e finale.

5.5 Poligono estruso E
Si tratta di realizzare un solido con base poligonale nel piano XY e altezza h = Z2 – Z1. 
L’estrusione del poligono si svolge solo nella direzione dell’asse Z partendo dalla base a 
quota Z1 alla copertura a quota Z2. La sintassi è: 
EN,X1,Y1,X2,Y2,X3,Y3,...,Z1,Z2,colore
Con N numero dei vertici del poligono, Xn,Yn coordinate degli n vertici, Z1 quota della  
base e Z2 l’altezza del poligono estruso e non la quota partendo da zero.
All’apertura del programma si richiede “Shell  an extruded polygon be created? Infatti  il 
programma  è  in  grado  di  creare  automaticamente  una  estrusione  dell’orma  del  
componente come disegnata precedentemente nel package. Basta solo assegnare una 
quota per la base ed una per la copertura. Ovviamente si  crea un corpo monolitico di 
altezza  h,  senza  differenziazione  delle  varie  parti  componenti.  Altrimenti  si  rifiuta  la 
proposta e si scrive il programma da soli. Per creare un solido con varie altezze, come ad 
esempio un trasformatore tipo a mantello, occorre suddividere il volume in parti di solidi 
che hanno uguale altezza, e costruirli utilizzando più volte la funzione E.

5.6 Testo TT o Text
E’ posizionato sempre parallelo alla superficie XY.  La sintassi è:

TTX,Y,Z,altezza del carattere,larghezza del carattere,angolo,tipo di font,testo,colore.

XYZ sono le coordinate di  partenza del  testo.  Segue altezza,  larghezza del  carattere, 
angolo, carattere usato, testo , colore.
Le  variabili  "!Component",  "!Value"  ,”!Symbol“  nel  testo  da  scrivere  sono  variabili  che 
rappresenteranno i valori assunti volta volta dal componente. Altrimenti si può inserire un 
testo fisso.
Esempio:  TT0,0,16,4,4,45,TARGET,TARGET 3001!,$0FFFFF scrive  la  parola  TARGET 
con font TARGET.

5.7 RC Fascette dei colori di identificazione
Fascette colorate identificative del valore del  componente, es.:  resistenza e tolleranza, 
secondo il  codice delle resistenze. Due punti  P1 e P2 rappresentano i  centri  destro e 
sinistro delle basi del cilindro che rappresenta la fascetta, e la loro distanza è la larghezza 
della fascetta.
Sintassi :
RCnumero progressivo da 1 a 5, X1,Y1,Z1,X2,Y2,Z2, diametro,colore

RC5,15,0,0,16,0,0,5,$00FF00,  fascetta  di  5mm  di  diametro,  larga  1  mm.  con  asse 
parallelo a X e di colore verde.

5.8 Copiare l’immagine 3D di un componente per assegnarla ad un altro.
In libreria selezionare il componente con l’immagine da copiare e aggiungerlo alla lista di  
quelli personali ( M2 e Assign to my components ).
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Si seleziona il tab (la linguetta)  Quick select. Poi si fa M2 sulla riga del componente. Si 
apre una finestra con varie opzioni. Scegliere  Symbols, package, 3D simulations >Edit 3D
Si apre un’altra finestra: Create a user copy of the component? > Yes.
Sulla copia User, ripetere M2,Symbols..., Edit 3D.
Si apre finalmente la finestra Edit 3D model.
In basso appaiono le file dei codici, Selezionarle tutte con M1h e copiare ( copy.)
Poi si cerca il componente cui si vuol assegnare l’immagine.
Ripetere la procedura per questo componente, M2,Symbols..., Edit 3D.
Appare la finestra  Edit 3D model.  In basso, nella finestra dei codici  che deve apparire 
vuota, incollare ( M2 e paste ) il codice precedentemente copiato. Appare ora l’immagine 
del componente. Premere “save” e il gioco è fatto.

Suggerimento: E’ consigliabile creare una cartella da qualche parte, assegnarle il nome 
“Immagini 3D” e inserirvi tanti file di testo *.txt contenenti ciascuno un disegno 3D di quelli  
personali, faticosamente costruito, e salvarlo.

5.9  Copiare un oggetto 3D  “n” volte nello spazio.

Esempio: piedini dei circuiti integrati
Selezionare la riga o le righe rappresentative dell’oggetto con M1h. 
M2 e scegliere nella lista che appare “Copy form and move by pitch”. Appare la finestra 
Automatically create further pins. Rispondere alle domande.
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5.10 Immagine 3D di un package tipo DIL8
Copiare e eventualmente modificare l’immagine di un package DIL8.

S-1.15,3.81,2.11,8.65,3.81,2.11,6.48,3.2,$888888,0.2

S0,0,0.1,0,0,-2.0,0.53,0.36,$888888

S0,0,0.1,0,0,2.11, 0.9,0.36,$888888

S0,0,2.11,0,0.63,2.11,0.9,0.36,$888888

C-0.45,0,2.11,0.45,0,2.11,0.36,$888888

S2.54,0,0.1,2.54,0,-2,0.53,0.36,$888888

S2.54,0,0.1,2.54,0,2.11, 0.9,0.36,$888888

S2.54,0,2.11,2.54,0.63,2.11,0.9,0.36,$888888

C2.09,0,2.11,2.99,0,2.11,0.36,$888888

S5.08,0,0.1,5.08,0,-2,0.53,0.36,$888888

S5.08,0,0.1,5.08,0,2.11, 0.9,0.36,$888888

S5.08,0,2.11,5.08,0.63,2.11,0.9,0.36,$888888

C4.63,0,2.11,5.53,0,2.11,0.36,$888888

S7.62,0,0.1,7.62,0,-2,0.53,0.36,$888888

S7.62,0,0.1,7.62,0,2.11, 0.9,0.36,$888888

S7.62,0,2.11,7.62,0.63,2.11,0.9,0.36,$888888

C7.17,0,2.11,8.07,0,2.11,0.36,$888888

S7.62,7.62,0.1,7.62,7.62,-2,0.53,0.36,$888888

S7.62,7.62,0.1,7.62,7.62,2.11, 0.9,0.36,$888888

S7.62,7.62,2.11,7.62,6.99,2.11,0.9,0.36,$888888

C7.17,7.62,2.11,8.07,7.62,2.11,0.36,$888888

S5.08,7.62,0.1,5.08,7.62,-2,0.53,0.36,$888888

S5.08,7.62,0.1,5.08,7.62,2.11, 0.9,0.36,$888888

S5.08,7.62,2.11,5.08,6.99,2.11,0.9,0.36,$888888

C4.63,7.62,2.11,5.53,7.62,2.11,0.36,$888888

S2.54,7.62,0.1,2.54,7.62,-2,0.53,0.36,$888888

S2.54,7.62,0.1,2.54,7.62,2.11, 0.9,0.36,$888888

S2.54,7.62,2.11,2.54,6.99,2.11,0.9,0.36,$888888

C2.09,7.62,2.11,2.99,7.62,2.11,0.36,$888888

S0,7.62,0.1,0,7.62,-2,0.53,0.36,$888888

S0,7.62,0.1,0,7.62,2.11, 0.9,0.36,$888888

S0,7.62,2.11,0,6.99,2.11,0.9,0.36,$888888

C-0.45,7.62,2.11,0.45,7.62,2.11,0.36,$888888

TT0.7,3,3.75,1.5,1,0,TARGET,DIL8,$123456
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6 - ESPORTARE – IMPORTARE LIBRERIE

6.1 Finestra di gestione
E’ possibile esportare librerie personali contenenti componenti creati personalmente, o 
importarli da altre fonti. Ad esempio se si cambia computer, può essere utile esportare la 
Libreria Personale faticosamente creata e importarla nel nuovo computer. Oppure può 
essere prudente salvare il file di tale libreria e custodirlo da qualche parte sicura. 
Può essere anche necessario esportare/ importare solo determinati componenti e non 
tutti, oppure esportare/ importare alcuni componenti di cui interessa solo il package o solo 
il disegno dello schema, o occorre importare solo alcune caratteristiche di un componente.
Per queste operazioni esiste una apposita finestra che gestisce l’operazione.
Per accedere a questa finestra, occorre aver aperto un progetto. Entrare nella finestra dei 
componenti premendo il tasto “Ins” della tastiera. Nella barra orizzontale in alto, 
selezionare “Import/Export”. Appare: Export Database, Import Database, Import libreries.

6.2 Esportazione
Export Database permette di creare un file con estensione *.db che può essere salvato in 
qualche supporto di memoria ( per esempio una memoria rimovibile ) per poterlo poi 
importare in altro computer o semplicemente conservarlo in altra posizione nel computer 
stesso.
M1 su “Export Database” consente di aprire una lista di opzioni:

• “Selected components and packages”. 
• “All components from the current search”. 
• “Component and packages from the list > Libreria personale … Nuova lista”.
• “USER / My components and packages”. 

6.3 Esportare singoli componenti. 
“Selected components and packages”. 

Tradotto: Componenti ( Schema ) e Packages ( Involucri ) di componenti selezionati. 
Permette di esportare singoli componenti, sia lo schema elettrico che l’involucro fisico.
Occorre prima selezionare nella finestra dei Componenti, quello che si intende esportare. 
Poi M1 su Import/Export della barra orizzontale alta > Export Database > “Selected 
components and packages > M1 > Appare una finestra su cui salvare il Database, di solito 
in Documenti. Scegliere una cartella di proprio gradimento e salvare indicando il nome del 
componente nella apposita casella. Il componente è salvato con quel nome in un file con 
estensione *. db, quindi non è apribile per leggerlo. Occorre importarlo in Target  per 
poterlo esaminare. Se tutto ha funzionato appare il messaggio “ Export was successful “

6.4  Esportare tutti i componenti di un gruppo. 
“All components from the current search”. 

Tradotto: Tutti i componenti della attuale ricerca. Consente di creare un file in 
estensione*.db contenente tutti i componenti di un gruppo, per esempio tutti i diodi o tutti i 
condensatori. Occorre selezionare una casella nella finestra dei componenti, ad es: 
“Components types and groups” o “Component list” ecc. e cliccare M1. 
Poi Import / Export > Export Database > “All components from the current search” > M1 > 
Appare una finestra su cui salvare il Database, di solito in Documenti. Scegliere una 
cartella di proprio gradimento e salvare indicando il nome della lista  nella apposita 
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casella. La lista è salvata con quel nome in un file con estensione *. db, quindi non è 
apribile per leggerla. Se tutto ha funzionato appare il messaggio “ Export was successful “.

6.5  Esportare una libreria
Component and packages from the list > …..
Tradotto: Componenti e involucri dalla lista > ……ad es.: Libreria personale o altro nome.
E’ questa forse l’opzione più ricorrente in quanto serve a esportare ad es.: su un supporto 
di memoria estraibile una intera libreria che abbiamo precedentemente creato per poterla 
poi esportare ad es.: in un altro computer o conservarla in un supporto di memoria sicuro.
Supponiamo di aver chiamato questa libreria col nome “ Libreria personale “ o altro.
M1 su Import/ Export > Export Database > “Component and packages from the list > 
Libreria Personale > Appare una finestra in cui poter memorizzare il nuovo file della 
Libreria personale. Assegnare un nome al file e salvare. Se tutto ha funzionato appare il 
messaggio “ Export was successful “.

6.6  Esportare USER / My components and packages. 
Tradotto : Utente / Miei componenti e involucri. Serve per esportare precisamente la lista 
User o My Components che è stata creata precedentemente quando abbiamo prescelto 
dalla lista dei componenti di Target quelli che ci interessavano e li abbiamo etichettati “My 
Components”, oppure quando abbiamo creato noi stessi nuovi componenti e li abbiamo 
inseriti nella lista “ My Components.
M1 su Import/ Export > Export Database > USER / My components and packages > 
Appare subito una finestra in cui poter memorizzare il nuovo file della Libreria personale. 
Assegnare un nome al file e salvare. Se tutto ha funzionato appare il messaggio “ Export  
was successful “.

6.7  Importazione
Per importare “data base” si va nella finestra dei componenti e si fa M1 sulla barra 
orizzontale alta su Import/Export. Selezionare Import. Appare una finestra, ad esempio dei 
Documenti, ove precedentemente sono stati copiati i database dei componenti, o 
comunque è possibile scegliere la cartella dove si trovano i database da importare. Fare 
M1 su Apre.  Appare un finestrone di dialogo. 

6.8 Quando una finestra appare più grande dello schermo
Può succedere che questa finestra sia più grande del riquadro dello schermo e se ne 
perda l’intestazione e/o la parte bassa. Se ciò avviene, il motivo è il basso numero di 
pixels del nostro computer rispetto a quanto richiesto da TARGET V16, che è dato per 
funzionare con almeno 1024 x 800 pixels. Ad ogni modo anche se siamo in questa 
situazione, è possibile trascinare la finestra e visualizzare anche quanto non visibile. Per 
questo M1 sul quadro ridotto, icona in alto a destra. Premere Alt + barra spaziatrice: 
Appare un popup con varie scelte. M1 su Sposta. Quindi usare Freccie su/ giù per 
spostare la finestra, oppure anche il mouse.

6.9 Selezione delle caratteristiche non volute
Come si vede, la finestra è divisa in tre ampie colonne.
La colonna di destra riporta in testata il nome del database del componente / i che si vuole 
importare e contiene tutte le caratteristiche appartenenti al componente stesso, simbolo 
elettrico, package, immagine in 3D se presente, e in basso la descrizione delle altre 
caratteristiche.
Tutti questi dati possono essere importati, eccetto quelli che selezioneremo nella colonna 
centrale. Infatti questa colonna, che rappresenta quella delle “proposte”, appare identica a 
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quella di destra, ma permette di escludere quello che non interessa importare. Fare M1 
nelle caselline della barra verticale gialla nel mezzo, su quelle caratteristiche che si 
vogliono escludere. Una spunta apparirà in quelle caselle.  Quindi M1 su “Save with 
acception of the selected dates”. Se invece non interessa effettuare alcuna restrizione, 
fare direttamente M1 nella casella “ Import all”. I componenti si ritroveranno ora nelle 
librerie di Target.
Questa operazione di importazione di librerie è frequente ed utile ad esempio se si cambia 
computer con uno nuovo in cui è già stato installato TARGET, ma le librerie personali, 
faticosamente realizzate nel vecchio computer, sono ancora vuote. Un’altra occasione si 
presenta quando si rinnova la versione di TARGET con una più recente.

6.10 Esportare importare propri progetti.
Se vogliamo esportare / importare dei progetti che abbiamo realizzato, l’operazione è 
molto semplice. Sicuramente questi progetti saranno stati memorizzati in una libreria di 
Target. Quando si apre Target appare la selezione dei progetti da aprire. Si apre Open 
user folder dove avremo salvato i nostri progetti. Per esportarne uno o più, basta copiare il 
file, per poi incollarlo nel supporto di memoria desiderato. Il file salvato si presenta così.

                                                         
Fig.6.1

Ad  es.:  se  salviamo  il  file  in  un  diverso  computer  o  anche  nel  desktop  dello  stesso 
computer,  quando  lo  riaccenderemo,  selezionando  questa  icona  si  provoca 
automaticamente l’apertura di Target e appare subito il progetto che abbiamo incollato.
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7 – ANALISI EMC
7.1 Introduzione
La riproduzione dello schema elettrico su PCB può dare risultati completamente diversi a 
seconda di come viene disegnato il circuito stampato.
Si possono verificare malfunzionamenti e in certi casi anche mancati funzionamenti se il 
circuito stampato non è stato progettato correttamente. I motivi ricorrenti sono: 

• Errata disposizione dei componenti sulla basetta
• Eccessiva vicinanza tra di loro 
• Errata deposizione delle tracce 
• Non adeguate dimensioni fisiche delle tracce.
 

Una  progettazione  errata  del  PCB,  oltre  a  difficoltà  di  funzionamento  per  mancata 
immunità, ( componenti, tracce, sensibili a campi di disturbo esterni ) può provocare anche 
l’emissione di disturbi, sia di natura elettro magnetica dovuti alla influenza reciproca degli 
elementi in esso contenuti, ( si pensi all’innesco di autooscillazioni ) sia per conduzione di 
segnali spuri generati dal circuito e immessi sulla rete elettrica di alimentazione.
Questi  effetti  dipendono  strettamente  dalla  frequenza  dei  segnali  di  disturbo,  ed 
aumentano con essa, ma non si creda che occorra raggiungere i MHz per vederli apparire; 
già a 50KHz possono creare malfunzionamenti e disturbi. Si pensi ad es.: agli alimentatori  
switching specialmente quelli alimentati a tensione di rete.
Tutte  queste situazioni  vengono contemplate  e regolamentate da Direttive  emesse da 
autorità nazionali e Internazionali, come la direttiva europea EU-law 89/336/EWG, tendenti 
a risolvere i problemi connessi alla Compatibilità Elettro Magnetica ( EMC ).
Target contiene integrata la possibilità di effettuare una analisi approssimativa preventiva 
di tipo EMC sul circuito stampato prima che sia realizzato.
Le funzioni svolte dal programma sono:

1. Calcolo dell’accoppiamento galvanico,  cioè l’effetto della corrente che scorre nel 
conduttore di ritorno della traccia sotto esame.

2. Calcolo  dell’accoppiamento  induttivo:  dovuto  alle  variazioni  di  flusso  magnetico 
generato dalla corrente che scorre in una traccia, ed al loro effetto sugli elementi 
elettrici circostanti. Legge di Faraday  ( e = -dΦ/dt )

3. Calcolo dell’accoppiamento capacitivo: dovuto alle variazioni di campi elettrici sulle 
capacità parassite distribuite fra tracce. ( C = dQ/dV )

4. Calcolo  del  fattore  di  accoppiamento:  consideriamo  una  traccia  del  PCB come 
elemento trasmittente ed un’altra come ricevente. Il fattore di accoppiamento è il 
rapporto  fra  il  flusso  magnetico  concatenato  con  la  traccia  ricevente  rispetto  a 
quello totale generato dalla traccia trasmittente. Il  suo valore è un numero puro 
compreso nell’intervallo da 0 a 1. Uno rappresenta il  limite teorico del  massimo 
accoppiamento: tutta l’energia generata viene ricevuta.

5. Calcolo dell’accoppiamento per energia irradiata: dovuto alla irradiazione di energia 
elettro-magnetica generata da ogni traccia. Caso ricorrente ad es.: in presenza di 
segnali digitali con ripidi fronti di salita/ discesa.

6. Calcolo della lunghezza massima della traccia: nel campo delle alte frequenze una 
traccia  sul  circuito  stampato  si  comporta  come  una  induttanza  il  cui  valore  è 
tutt’altro  che  trascurabile.  Pertanto  la  lunghezza  della  traccia  non  può  essere 
illimitata e va valutata in termini di lunghezza d’onda.
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7.2  Principio su cui si basa il programma

Il programma prende in esame tutte le tracce che sono state stese sul PCB e confronta 
ciascuna di essa con una delle altre selezionate dall’utente. 
L’operazione consiste prima nel  calcolo,  in base alla geometria e dimensioni  fisiche di 
ciascuna traccia, della induttanza e capacità relativa alla traccia con cui si vuole fare il  
raffronto. Poi esegue il calcolo degli accoppiamenti relativi. Viene fornito come risultato il  
“Grado percentuale EMC” espresso in % con un colore secondo la seguente tabella:

• Blu: 100%
• Verde 90% - 99%
• Giallo 50% - 89%
• Porpora 1% - 49%
• Rosso 0%

Il colore rosso 0% rappresenta la situazione peggiore ed è quella in cui sono stati superati  
I limiti imposti dalle normative. Il colore blu 100% rappresenta una situazione di nessuna 
influenza tra una traccia e l’altra e non crea problemi. 
Il  risultato  apparentemente  bizzarro  per  cui  allo  zero  corrisponde  il  massimo 
accoppiamento,  scaturisce da questa formula

Grado percentuale EMC = 100 - ( Vdist  : Vsegn ) x100

Vdist = tensione di disturbo. 
Vsegn = tensione del segnale
Il grado percentuale fornito dal calcolo rappresenta la  differenza espressa in % fra una 
situazione di disturbo massima in cui il disturbo è uguale al segnale, e la situazione reale  
attuale  disturbo/segnale.  Praticamente  i  valori  bassi  del  grado  percentuale  fornito  dal 
calcolo  sono quelli da evitare in quanto rappresentano una situazione prossima a quella  
proibita.

7.3 Procedura: impostazione dei dati 
Apertura: si va nel foglio di disegno del PCB.

• Action > Start EMC Check, oppure 
• Icona della bacchetta magica > Icona del grafico.

Si  apre  una  finestra  di  dialogo  divisa  in  due  colonne.  Quella  di  sinistra,  nella  prima 
linguetta  Signals   contiene  elencati  tutte  le  tracce  dello  schema  (signals).  Si  può 
selezionare una di loro e confrontarla con una delle stesse rappresentate anche nella 
colonna di destra.
M11 sul nome del segnale ( traccia ) apre una finestra  ” Set the EMC properties of the  
signal”
Occorre rispondere alle voci di questa finestra.

Type (fine ) Elenca il tipo di circuito che stiamo analizzando, TTL,CMOS, Analog 
switching ecc.

Type (rough) Livello di potenza in gioco.
Current Picco massimo di corrente
Voltage Picco di tensione
Analog Circuito analogico. Inserire la frequenza di lavoro
Digital Inserire il tempo di salita del fronte dell’onda, la durata dell’impulso, 
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il periodo.
Inner resist. Resistenza interna equivalente della linea
Allowed dist.volt Massima tensione ammessa del disturbo
Back conductor Nome del conduttore di ritorno. 

Importante  specificare  il  nome  del  conduttore  di  ritorno  rispetto  a  quello  che  si  sta 
analizzando, per es.: la massa stessa ( GND ) del circuito, o un altro conduttore riportato 
nell’elenco.  Questa  assegnazione  serve  per  il  calcolo  di:  Accoppiamento  induttivo, 
capacitivo e fattore di accoppiamento.
La seconda linguetta della finestra Signal types serve nel caso si vogliano aggiungere altre 
caratteristiche. Per aggiungere altre caratteristiche sceglierle e poi premere New. In 
genere questa linguetta si può trascurare.
La linguetta Options è importante e serve per assegnare le caratteristiche della basetta del 
PCB, spessore della basetta in µm e spessore del rame delle tracce in µm. Sono già 
inseriti i valori più comuni.

7.4 Calcolo degli accoppiamenti
Si passa adesso nella finestra di destra e si seleziona il segnale ( la traccia ) su cui si 
vuole vedere l’effetto provocato dal segnale ( traccia ) di sinistra di cui abbiamo specificato 
le caratteristiche.

Accoppiamento per energia irradiata
Attivare la funzione facendo M2 sulla casellina. Poi M11 su Radiation coupling. Appare un 
grafico. I risultati vengono inseriti dal programma nel grafico, disegnato secondo la 
normativa Europea EN55022 e Tedesca VDE0871/B, intitolato “Radiation Coupling” che si 
potrebbe tradurre liberamente “Grado di accoppiamento elettro-magnetico”.

Il grafico riporta in ascisse (X) la frequenza in scala logaritmica. In ordinate (Y) riporta:
a sinistra l’intensità di campo elettrico “ E ” generato dalla traccia espresso in dB(µV/m) 
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a destra l’intensità di campo magnetico” H “ espresso in dB(µA/m).
Nello stesso grafico sono riportate le linee limite ammesse dalla normativa per i due 
campi, quella verde rappresenta il limite per il campo magnetico e quella marrone il limite 
per il campo elettrico. A seguito del calcolo vengono generate due curve rappresentanti il 
campo elettrico e quello magnetico generato. Per il rispetto delle normative, le curve non 
possono superare i limiti segnati.
Nell’esempio sottostante la curva rossa che rappresenta il campo elettrico generato per 
ogni valore della frequenza, sfiora in un punto a circa 300 MHz il limite ammesso. Il campo 
magnetico si mantiene sempre al disotto dei limiti massimi.

L’esempio si riferisce a un segnale di tipo digitale in cui lo spettro di emissione continuo 
copre un ampio campo di frequenze. Infatti un segnale digitale si comporta come una 
fonte di disturbo molto fastidiosa perché genera uno spettro di frequenze continuo esteso, 
che aumenta con il diminuire del tempo del fronte di salita e discesa (rise/fall time).

Nella figura sottostante è riportato invece il caso in cui la sorgente è un segnale analogico, 
la frequenza è fissa ed è quella impostata nel campo di sinistra della finestra di dialogo.
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Pertanto otterremo non più una curva continua ma un punto che rappresenta il massimo 
disturbo alla frequenza fissa impostata.
L’esempio riportato in figura mostra una situazione in cui sono state violate le normative, 
perché sia il campo elettrico ( crocetta rossa ) che quello magnetico ( crocetta verde ) 
superano i limiti rispettivi dettati dalla normativa.

Accoppiamento galvanico.
Due conduttori, uno di andata ed uno di ritorno della stessa corrente si accoppiano sia per 
il campo magnetico generato dalla corrente che scorre in uno e che induce una corrente di 
disturbo nell’altro, sia per le capacità distribuite fra le tracce che generano passaggi di 
corrente alternata. Il calcolo fornisce: 

• la resistenza DC della traccia di rame, 
• la sua induttanza 
• Distortion voltage: tensione di disturbo sulla traccia disturbata e prodotta 

dall’accoppiamento galvanico. 
• Infine fornisce in percento il grado EMC.

Lunghezza della traccia
Fornisce 

• la lunghezza della traccia, Lt

• la massima lunghezza ammessa, Lm

• grado EMC espresso in %, così formulato: 
Grado EMC % = 100 – (Lt : Lm x 100 )

Rappresenta lo scostamento da una situazione di disturbo non consentita.
Per cui se il rapporto Lt : Lm  è prossimo ad uno, cioè situazione di rischio, il grado 
percentuale della formula è basso. Alto rischio => basso valore percentuale. 

Accoppiamento capacitivo
Vengono elencate tutte le altre tracce e per ciascuna di esse il calcolo fornisce:

• La capacità di accoppiamento (pF)
• La corrente e tensione di distorsione del disturbo (mA) (mV). La corrente è quella 

che circola nella traccia disturbata per effetto della azione di quella disturbante.
• La tensione è quella che si stabilisce ai capi della resistenza interna Ri del circuito 

della traccia disturbata percorsa dalla corrente generata dalla traccia disturbante 
attraverso la capacità di accoppiamento.

• Il grado percentuale EMC per verificare se ambedue le tracce rientrano nei limiti 
delle norme.

Accoppiamento induttivo
Vengono elencate tutte le altre tracce e per ciascuna di esse il calcolo fornisce:

• La mutua induttanza (nH)
• La tensione del disturbo (mV) indotta in quella disturbata generata da quella 

disturbante.
• Il grado percentuale EMC per verificare se ambedue le tracce rientrano nei limiti 

delle norme.
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Fattore di accoppiamento
Vengono elencate tutte le altre tracce e per ciascuna di esse il calcolo fornisce:

• Il fattore di accoppiamento K tra la traccia disturbata e quella disturbante per effetto 
induttivo e capacitivo reciproco.

• La resistenza d’onda (ohm)
• Il grado percentuale
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8 - COMPLEMENTI SULLA SIMULAZIONE

8.1 Modalità di analisi disponibili

Il  programma  di  simulazione  comprende  una  modalità  Standard  accessibile  tramite 
l’omonima  linguetta  nella  finestra  principale,  e  una  modalità  Extended  individuata 
anch’essa dalla linguetta adiacente.

8.2  MODALITA’ STANDARD
Consente di vedere i segnali del circuito in funzione del tempo. Il programma calcola tutte  
le forme d’onda, ma è possibile non rappresentarle tutte insieme, ma fare una selezione 
secondo quanto interessa vedere.
Il primo passo è quello di assegnare dei nomi intuibili ai vari collegamenti dello schema. 
Infatti il programma assegna di default dei nomi non significativi. Occorre fare M11 su ogni 
collegamento dello schema e assegnare il nome intuibile, come gen per generatore, cc per 
tensione di alimentazione, g per gate ecc.
Quindi si accede alla simulazione e appare la finestra principale “Target3001 Simulation”.
Per impostare la modalità standard si procede come segue:
Impostare il tempo massimo nella casella “Simulation for”. Se si vuole visualizzare non 
tutto il tempo impostato, ma solo la parte finale, dopo il transitorio, si fa M1 sulla casella a  
destra “Extended settings for transient analysis “ e si imposta il tempo totale, e sotto quello 
della sola parte finale che si vuole visualizzare. 
Sotto ancora si  definisce la durata dello step di  campionamento. Il  primo è quello alle 
condizioni iniziali al tempo t=0. Segue un passo di campionamento che non è fisso, ma 
viene deciso automaticamente dal programma secondo quello che sta rappresentando: 
es.: minimo per tempi di salita e discesa, massimo per tratti orizzontali. Per questo motivo 
viene definito anche un passo massimo che il programma non deve superare. Se il passo 
si fa troppo lungo la rappresentazione appare una serie di rette spezzate, se troppo corto 
la durata della analisi si allunga. 
La spunta Use initial condition, consente di includere la rappresentazione delle condizioni 
iniziali, ad es.: quelle di un condensatore già carico alla partenza.
Attenzione!  Se  non  necessario  deselezionare  il  quadratino  delle  condizioni  iniziali, 
altrimenti il programma calcola partendo dalla impostazione delle condizioni iniziali ( es.: 
condensatori impostati con IC=0 ) di ogni singolo componente e non da quelle di regime, 
rappresentando immagini in transitorio e non immagini a regime raggiunto.
La casella sottostante a destra “Edit Selection” apre la finestra “Probe” che permette di 
selezionare i soli segnali da visualizzare. Nel riquadro si fa M2 > Add > Voltage against  
ground /  Voltage/  Current.  Selezionare se si  vuole una tensione riferita  a  massa,  una 
tensione  flottante,  una  corrente.  Appare  sullo  schema  elettrico  una  freccetta  da 
posizionare sul  conduttore che interessa :  selezionare con M1. Poi  si  va sul  secondo 
conduttore e via di seguito. I segnali selezionati appaiono nella finestra con accanto una 
casella vuota. Per renderli  visibili  M2 >  Show immediately.  Per disattivarli  si fa click di 
nuovo su “Show immediately”.
La sottostante casella Oscilloscope, visualizza il grafico secondo quanto impostato.

8.3  Frequenza. 
Il difetto di questa modalità standard è che non consente di valutare a colpo d’occhio la 
frequenza dei  segnali,  come del  resto avviene nei  vecchi  oscilloscopi.  Per  valutare la 
frequenza, occorre misurare il periodo e fare l’inverso. Una valutazione precisa del periodo 
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si ottiene selezionando nello schermo dell’oscilloscopio “Edit  > Couple cursor to graph > 
Graph. Si legge sulle ascisse la distanza fra due punti omologhi sulla curva, corrispondenti  
a un periodo. Da qui, calcolando l’inverso, si risale alla frequenza.

8.4  Calcolo di curve
Si può rappresentare una curva risultante da un calcolo effettuato su una già esistente. 
Sulla barra dello schermo dell’oscilloscopio si seleziona “Graph calculator” > Editor. Nella 
casella “Graph” si inserisce la curva che interessa, scelta tra quelle disponibili. Il suo nome 
viene  riportato  anche  nella  casella  orizzontale  alta.  Col  tastierino  di  destra  si  esegue 
l’operazione sulla curva richiamata. 
Se invece si vuole applicare ad un grafico una espressione matematica tra quelle riportate 
nel tastierino di sinistra, prima si preme il tasto relativo alla espressione, poi si fa M1 sulla 
freccetta della casella di “Graph” e si sceglie la curva operanda. Questa appare come 
argomento della espressione. Quindi si preme OK. Nello schermo appare ora la nuova 
curva calcolata applicando l’operatore matematico alla curva operanda.
Per rappresentare un’altra funzione,  dalla barra orizzontale dello schermo si  seleziona 
nuovamente “Graph calculator > New (Analog).

8.5 MODALITA’ EXTENDED
Questa  modalità  permette  di  effettuare  varie  analisi:  Analisi  dei  transitori,  Analisi  AC, 
Analisi DC, Imposizione di condizioni iniziali, Posizione della sonda (Probe ), ecc.

8.6 Analisi dei transitori
Questa  analisi  fornisce  un  grafico  in  funzione  del  tempo,  mettendo  in  evidenza  il 
transitorio. I segnali che vengono analizzati sono quelli  impostati e attivati nella casella 
“Edit selection” vista prima, oppure andando in modalità “Extended”, nella casella “Probe”.
Procedura: 
Impostare le grandezze da analizzare. Finestra principale > “Edit selection” e attivarle.
Finestra principale > M1 su casella “Extended” > M2 > Add > Transient analysis. 
Nella casella “Simulation end” inserire la durata del transitorio. Sotto inserire il passo di 
campionamento “Step” e quello massimo. ( vedi 8.2 )
M1 su casella “Create target Cir >  Start simulation.  Appare il transitorio in funzione del 
tempo.
Muovendo il cursore sulla curva si possono leggere in basso I corrispondenti valori di x ed 
y, cioè l’ampiezza (y) in funzione del tempo (x).

8.7 Analisi AC ( banda passante )
Questa analisi fornisce un grafico che riporta le ampiezze in funzione della frequenza del 
segnale applicato in ingresso, fornisce cioè il grafico della banda passante del circuito.
Procedura. 
Prima  di  tutto  occorre  impostare  l’ampiezza  del  segnale,  selezionando  con  (M11)  il 
generatore  sinusoidale  che  la  fornisce  >  M1  su   Simulation  value  >  M1  su  “Edit”. 
Assegnare un valore a “AC magnitude” che non sia superiore alla ampiezza VA. Oppure 
inserire  “COMPONENTVALUE”  così  che  sarà  possibile  variarlo  semplicemente  nella 
casella “Simulation value” della prima finestra.
Ora, se non già fatto, occorre assegnare nomi intuibili ai collegamenti. ( vedi 8.2 )
Poi si apre la finestra della simulazione. Impostare le grandezze da valutare nella casella  
“Edit selection” come descritto prima.
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Nella finestra “Extended” si fa M2 nel riquadro, poi M1 > Add AC analysis > Impostare la 
frequenza iniziale, quella finale e i punti di campionamento. In genere si mette 100.
Quindi  “Create  Target  Cir”  >  “Start  simulation”.  Il  programma varia  per  ogni  punto  di 
campionamento  la  frequenza  del  segnale  AC  in  ingresso,  mantenendone  costante 
l’ampiezza  in  ingresso,  e  riporta  in  ordinate  l’ampiezza del  segnale  impostato  in  Edit  
selection, che di solito è l’uscita del circuito in esame. 
Appare  il  grafico  riportante  in  ascisse  il  campo  di  frequenze  impostato  e  in  ordinate 
l’ampiezza delle grandezze scelte in funzione della frequenza. 
Per cambiare le impostazioni della banda, fare M1 nella finestra “Extended”  e scegliere 
Edit. Poi di nuovo Create Target Cir > Start simulation.
Per oscurare o attivare una grandezza, basta selezionare direttamente sulla barra sopra al 
grafico View > Graph . Per variare la scala delle ampiezze selezionare Zoom.
Per ottenere un grafico con l’asse delle  frquenze logaritmico,  M1 su  View  nella  barra 
orizzontale della finestra della immagine, poi selezionare  X-axis logarithmic

8.8 Analisi DC

Serve a valutare le condizioni di riposo del circuito, cioè i valori delle grandezze corrente o  
tensione in regime continuo in cui cioè i condensatori sono circuiti aperti e le induttanze 
corti circuiti.
Viene realizzato un grafico che riporta in ascisse (x) il campo di variazione di tensione ( o 
di corrente ) di una sorgente presente nel circuito, per esempio una tensione continua 
siglata  Sim1,  che  si  fa  variare  in  un  campo  da  impostare,  e  in  ordinate  (y)  tutte  le  
grandezze che sono state selezionate, e che si modificano in funzione del valore x della 
sorgente.
Occorre prima di tutto definire nella casella “Edit selection” le grandezze che si vogliono 
analizzare. Poi si procede così
Si va in Extended > M2 > Add > DC Analysis.
Sempre in Extended > M2 > Edit . Appare la finestra “DC Analysis”.
Riempire le caselle Source, Start value, End value, Increment.
La casella Source riporta le sorgenti presenti nel circuito, Sim1, Sim 2 …una delle quali va  
selezionata, cioè quella in funzione della quale si vogliono osservare le altre grandezze.
Infine “Create target cir > “Start simulation. Appare il grafico .
Questa analisi si presta a disegnare le caratteristiche statiche dei componenti quali diodi, 
transistori, valvole ecc. Un esempio è il seguente.

8.9 Rilevare la caratteristica di un diodo zener con l’analisi DC.
Aprire una pagina nuova e disegnare il seguente schema

                                           
Fig.8.1
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I componenti debbono essere dotati di modello di simulazione. Il diodo zener è ZPD5.1V.
M11 sul collegamento dell’anodo e assegnare un nome ad esempio “anodo”.
Icona bacchetta magica > icona sinusoidi > Extended settings for.. > 5 – 0 – 1m - 50m. 
Casella sottostante Edit selection > M2 > Add > Current  selezionare l’anodo del diodo e 
M1.  M1 su casella I(D1,1) > Show immediately
A questo punto si passa alla simulazione. 
Extended > M2 > Add > DC Analysis. Assicurarsi che anche Probe sia selezionato.
Edit > Source > VSim1 Start = - 5.4 End = 1 Increment = 0.01 OK
Create Target Cir > Start Simulation
Deve apparire la seguente imagine

       

Fig.8.2

In ascisse è riportata la tensione fornita da Sim1, applicata al diodo, che il programma fa 
variare tra -5.4 e 1 V come impostato.
In ordinate è riportata la corrente nel diodo in funzione di VSim1. Il campo delle correnti è 
esagerato a valori che nella realtà sarebbero insopportabili per il diodo ( - 60 / 60 A ). 
Serve solo per dare un effetto dimostrativo.

8.10 Rilevare la caratteristica dei transistori.
Si possono rilevare analogamente anche le caratteristiche di componenti attivi : transistor 
BJT, FET, Mosfet  diodi a vuoto triodi, pentodi . 
A titolo di esempio rileviamo la caratteristica diretta Ic-Vce del transistore NPN BC547A.
Per prima cosa in una pagina nuova disegnamo lo schema seguente.
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Fig.8.3

Fra collettore ed emettitore è applicata una tensione continua di 5 V.
Poiché il transistore è pilotato in corrente, dobbiamo crearci una sorgente di corrente. Una 
sorgente di corrente si ottiene con un generatore di tensione con in serie una resistenza di  
alto valore. Nella fattispecie la resistenza è di 1 Meg, e la tensione 1000V. Otteniamo una 
corrente  di  1mA che inietteremo nella  base (  la  Vbe diventa  trascurabile  rispetto  alla 
sorgente Sim1 ). Avremmo potuto usare anche un generatore di corrente già disponibile in 
Target, ma questo ci crea problemi di polarizzazione. 
Andiamo a simulare il  circuito prima in modalità  Standard.  Assegnamo nomi intuibili  ai 
collegamenti  Andiamo in Extended setting e impostiamo 1 – 0 - 1m - 50m.
Poi in Edit selection > M2 > Add > Current e selezioniamo  la corrente di collettore I(Q1,2).
Poi M2 > Show immediately. Infatti quello che vogliamo vedere è la corrente di collettore in 
funzione della Vce fissato un valore della corrente di base Ib. Passando alla simulazione 
standard, con i valori impostati, leggiamo una corrente Ic = 103 mA a Vce =5V e per Ib = 
1mA. Già da qui possiamo trovare il guadagno di corrente continua ad emettitore comune, 
rappresentato dal parametro ibrido hFE = Ic/Ib = 103 per Vce = 5V.
Per rappresentare la caratteristica andiamo in modalità Extended e selezioniamo Probe e 
DC-Analysis.  Poi  Edit > Source = Vsim2 > Start value =0, End value = 5  Increment =  
0.1V.   Per  avviare la  simulazione  Create  Target  Cir  > Start  simulation. Vedremo una 
singola curva, quella per corrente di base Ib = 1mA.
Noi però vorremmo vedere nello stesso piano anche le altre curve relative ad altri valori di 
Ib.  Vogliamo cioè che per ogni  incremento della Vce, vi  sia la possibilità di  variare la 
corrente di base ad esempio con passi di 0,1 mA, da zero a 1 mA. L’analisi DC offre anche 
questa possibilità. 
Mettere una spunta alla casella Nested DC analysiss ( inner ) a destra  della finestra DC 
Analysis. Poi riempire le caselle come segue. Source= VSim1, Start value = 0, End value  
= 1000,  Increment = 100. Significa che all’interno del campo di variazione della Vce come 
impostato prima, vogliamo far variare la tensione Sim1 da 0 a 1000 V con incrementi di 
100 V.  In questo modo la corrente di base varierà da 0 a 1mA con incrementi di 0,1mA.
OK > Create Target Cir > Start simulation. Quello che otterremo è l’immagine di Fig.8.4. 
Appaiono le note caratteristiche del transistore BJT.
Partendo dall’alto si legge la curva per Ib= 1mA, poi quella per Ib = 0.9, per Ib = 0.8…fino 
a Ib = 0.
La funzione Nested (letteralmente: contenuto l’uno dentro l’altro) ci ha fornito un grado di 
libertà in più che ci ha consentito di variare anche il parametro Ib ( inner = interno ) 
durante la variazione di Vce..
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Fig.8.4

E’ possibile anche vedere in uno stesso grafico le caratteristiche di trasferimento ( Ic-Ib )
e quelle di ingresso ( Vbe-Ib ), entrambe con Vce come parametro.
Nella stessa finestra di DC-Analysis, fare M11 su Probe e selezionare oltre alla corrente di 
collettore I(Q1,1) già presente, anche la Vbe. con M2 > Add > Voltage against ground .
Per impostare i nuovi valori > M1 su DC-Analysis > Edit . 
A sinistra impostare Source=VSim1,  Start value= 0 , End value= 1000, Increment = 100. 
A destra impostare Source=Vsim2,  Start value= 0 , End value= 5,  Increment = 1
Si ottiene il grafico di fig.8.5 in cui in ascisse è riportata la corrente di base che varia nel  
campo da 0 a 1K ovvero da 0 a 1mA ove 1K corrisponde a 1mA.
In ordinate sono rappresentate in verde la tensione Vbe nel campo 0 - 900mV e in rosso la 
Ic nel campo 0 -900mA. M1 su View ed escludere o l’una o l’altra per vederne una sola.

                         
Fig.8.5
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9 – APPENDICE A

Tasto 
“F”

Funzioni richiamate con i tasti “F”

F1 Richiesta di aiuto
F2 Ricerca in libreria
F3 Cambio foglio da schema a PCB e viceversa
F4 Unità di misura  ( mm, μm, Inch and e mil )
F5 Griglia visibile / invisibile
F6 Puntatore a passi di griglia
F7 Immagine su schermo intero
F8 Inserisce/disinserisce croce sul puntatore
F9 Avvia Autorouter / Simulatore

F10 Menu “Mode “

Funzione dei caratteri della tastiera
Carat-tere Espressione

in Inglese
Descrizione della funzione

0 Circle (fill ) Disegna un cerchio ( pieno )
Cntr+0 Circle Disegna una circonferenza

1 Place pin/pad Inserisce un piedino nello schema o una piazzola nel PCB
2 Signal / Track Inserisce un segnale o una traccia

Cntr+2 Line Disegna una linea
3 Triangle (fill) Disegna un triangolo pieno

Cntr+3 Draw triangle Disegna il perimetro di un triangolo
4 Rectangle (fill) Disegna un rettangolo pieno

Cntr+4 Rectangle Disegna il perimetro di un rettangolo
5 Poligon Disegna un poligono
a Arc/ Torus Disegna un arco nello schema o un toro nel PCB
b Bus/Bridge Nello schema un bus, nel PCB fa un ponte con una traccia
c Capture window Finestra di cattura
d Displace/move M1 su oggetto e “ d “ -> Muove l’oggetto
e Edit M1 su oggetto poi “e” -> Edit, cioè cambia le caratteristiche
f Find Trova un componente e lo seleziona
g Drag M1 su linea, curva, arco poi “g”  -> Piega stretta , trascina
i Insert Inserisce un simbolo nello schema o un package.

L Air wire Inserisce un elastico nel PCB senza schema.
m Mirror O Funzione specchio. M1 poi m -> ribalta orizzontalmente

Shift+m Mirror V Funzione specchio. M1 poi Shift + m -> ribalta verticalmente
n Signal name M1 preciso su segnale -> assegna un nome a un segnale
o Options Apre la finestra delle opzioni
r Reference Apre la finestra dei simboli di riferimento

Cntr+r Resto of symbols Inserisce il resto dei simboli ( integrati )
s Select element Seleziona un singolo elemento di un simbolo.
t Rotate M1 e “t”   -> Ruota 
u Measure distance Misura distanze: u su partenza, u su arrivo, u per visualizz.
v Rename signals Rinomina i segnali
w Draw air wires Nel PCB senza schema disegna gli elastici
x Export Esporta un simbolo/package nella libreria
y Merge to symbol Raggruppa gli elementi selezionati (con M1h) in un unico simbolo
“ Enter Text Apre la finestra delle opzioni del testo e inserisce ( M1 su OK )
. Node Nello schema mette un nodo. Nel PCB > traccia > via + cambia layer

Esc Exit mode Interrompe una funzione
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10 – APPENDICE B  
SPICE 3F5 e TARGET

10.1  Introduzione
Il  programma di simulazione adottato da Target è SPICE 3F5 che rappresenta l’ultima 
versione del programma originale edito dalla Università di Berkeleys in California.
TARGET legge anche simulazione scritta in PSPICE.
Esistono nel web i manuali 3F5 solo in lingua inglese per quanto di mia conoscenza, ma 
necessariamente sono lunghi almeno 300 pagine, e all’inizio manca la voglia di sorbirseli.
Queste note iniziali scritte per mio uso personale, non hanno certo l’ambizione di essere 
esaustive, ma servono solo per iniziare a saper leggere i modelli di simulazione scritti da 
altri,  e  questo è già  molto  utile.  Inoltre  ci  permettono anche di  scrivere  nostri  modelli  
personali,  magari  semplici,  e  allora  queste  note  diventano  sicuramente  interessanti.  Il  
terzo vantaggio è che rendono appassionante il programma di simulazione e stimolano a 
saperne di più. E’ a questo punto che ci assale la voglia di sorbirsi il manuale in inglese, di 
cui prima ci mancava lo stimolo 

10.2  Il modello di simulazione
Il modello di simulazione è un listato di istruzioni ( netlist ) che vengono interpretate dal  
programma per simulare lo schema elettrico che ci interessa. 
La prima riga contiene necessariamente il titolo. L’ultima riga è sempre .END ( punto end )  
e informa il programma che la descrizione è finita. Fra queste due righe ci sono le altre  
che descrivono chi sono e come sono collegati i componenti dello schema da simulare e 
assegnano loro un valore.
Ciascun componente del circuito è rappresentato in una sua riga nella quale sono indicati  
il codice di individuazione, i nodi di collegamento e il valore. 
Un asterisco all’inizio di una riga indica che trattasi di un commento e non avrà effetto sul 
programma di calcolo. Il punto e virgola in una riga rende invisibile al programma tutto 
quello che è scritto a destra.

10.3  Scrittura dei numeri e dei fattori di scala.
I  numeri  possono  essere  interi  e  decimali,  se  necessario  seguiti  da  un  elevatore  a 
potenza.
Modi di scrittura ammessi: 
Esempio: 1000   1000.0   1000Hz   1e3  1.0e3   1KHz   1K Tutti rappresentano lo stesso  
numero che nell’esempio è 1000 Hz. 
Notare che la lettera “e”  qui è usata per indicare l’elevazione a potenza e non va confusa 
con il numero di Nepero e= 2,718. 
Notare anche che non è riconosciuta l’espressione 103 perché SPICE non capisce che 3 è 
l’esponente. Per farglielo capire occorre scrivere  10^3 ove “^” informa che il numero che 
segue è la potenza. Così sono validi 10^2  3^3 n1^2 a^b.

Fattori di scala ammessi

T = 1012 (tera) G = 109 (giga) Meg = 106(mega)  K = 103 (kilo)    m = 10-3 (milli)

 u = 10-6 (micro) n = 10-9 (nano) p = 10-12 (pico)  f = 10-15 (femto)
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Attenzione:  per  indicare  Mega,  usare  l’espressione  “meg”.  Se  si  usa  M come  siamo 
abituati a scrivere, il programma, dato che non riconosce la differenza tra maiuscole e 
minuscole, lo interpreta come m = milli

10.4  Convergenza
Abbiamo  appreso  fino  qui  che  per  simulare  un  circuito  reale,  SPICE  interpreta  i 
collegamenti  fra  nodo  e  nodo  dei  componenti  inizialmente  dotati  di  valori  di  default,  
costruendo una rete che rispecchia il circuito reale.
Una volta che avremo assegnato i valori reali a quelli di default di ciascun componente, il  
programma calcola tutti i valori di tensione applicata ad ogni nodo verso massa e i valori di 
corrente che scorrono in ogni componente e li mostra in uscita.
Per trovare le soluzioni del circuito sotto esame e mostrare il risultato il programma utilizza 
per ogni componente il relativo algoritmo di calcolo, ma non arriva a una soluzione netta. Il 
risultato è ottenuto con un processo iterativo di calcoli successivi che si avvicina sempre 
più alla soluzione finale e termina quando i valori di tensione e corrente trovati per ogni  
nodo ed in ogni ramo approssimano almeno allo 0,1% il valore asintotico finale. Significa 
che ogni procedimento di calcolo converge ad un risultato con uno scarto massimo dello 
0,1% e lo mostra come soluzione in uscita sotto forma di grafico.

10.5  Modelli primitivi
Il  programma contiene un gran numero di componenti cosiddetti  “ Primitivi ” cioè che 
simulano il comportamento fisico di ciascun tipo di componente, resistenza, condensatore 
diodi, transistor (NPN/PNP), JFET, ecc.:ma utilizzano parametri iniziali di default riportati in 
una  lista  detta  MODELCARD.  Per  poter  simulare  un  componente  specifico,  occorre 
sostituire  nella  Modelcard  i  parametri  di  default  con  quelli  reali  del  componente, 
operazione  che  viene  eseguita  in  Target  quando  si  assegna  un  modello  ad  un 
componente. Come  esempio di modelcard, scegliere il diodo 1N4007 che è già dotato di  
modello di simulazione. Fare M2 nella casella del componente a sinistra, sotto Component  
Name.  Poi  Symbol,package,3D simulation > Show simulation model  > Edit.  Appare la 
Modelcard ma i valori di default sono stati sostituiti con quelli reali del diodo 1N4007.
I  componenti  primitivi  più  usati  già  compresi  nel  programma SPICE,  sono  resistenze 
condensatori  induttanze,  induttanze  accoppiate,  diodi,  transistori  (BJT),  FET  (JFET) 
Mosfet (MOSFET).
Per  vedere  la  lista  dei  primitivi  in  Target,  scegliere  nella  finestra  Components,  un 
componente  dotato  di  simulazione.  M2  sulla  sua  casella  >  Symbol,  package,3D, 
Simulation > Show simulation model > Select. Si vede una lista figurata che contiene i 
modelli sia dei sub-circuiti che dei componenti primitivi.
Per quanto riguarda la scrittura dei modelli nel listato, si comincia con una lettera iniziale 
identificativa del tipo di componente R,C,L, K ecc. ) riconosciuta da SPICE rispettivamente 
come resistenza, condensatore, induttanza, induttanza accoppiata. La lettera è seguita da 
uno o più caratteri alfanumerici, es.: R1, C7, Lp. Poi seguono i nodi espressi con uno o più  
caratteri alfanumerici, es. 3,5, n1, in, out. ecc. La cifra “0” è riservata alla terra o massa del  
circuito. Il circuito deve avere sempre una terra di riferimento, altrimenti il programma dà 
errore.
Infine viene indicato il valore del componente.
Uno spazio separa  ogni informazione fornita. Lo spazio può essere seguito da altri spazi.
Per i  condensatori  e le induttanze viene richiesto anche il  valore iniziale “IC “  (  Initial  
Condition  )  di  tensione per  il  condensatore e di  corrente per  l’induttanza al  momento 
dell’inizio della simulazione. Di default vale zero. Se si lascia in bianco vale 0.
Di seguito sono riportate le tabelle esplicative, con esempi di scrittura di ogni riga.
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10.6  Componenti passivi

Componente Sigla Sintassi di scrittura Esempi
Resistenza R RX  n1  n2  valore R1   1    n1    1K
Condensatore C CX  a1  b2  valore   IC Cps    a1    n1    25p    IC=3V
Induttore L Lx   1    2    Valore   IC L1    1    2    11mH    IC=11mA
Induttore 
accoppiato

K Kx    Ly  Lz   Valore del coeff. 
di accoppiamento.(0<K<1 )

Ktrasf   L1   L2    0.999

Con X  si intende uno o più caratteri alfanumerici maiuscoli o minuscoli

10.7  Diodi e componenti attivi a stato solido.

Componente Sigla Sintassi di scrittura Esempi
Diodo D DX  n1  n2  Nome D3 12  13  1N4148

Dr   n2  n3  Drev
Transistor BJT Q QX  Nc  Nb  Ne  Nome Q2  3    2     4   BC337

Qa  n1  n2  n3  BC547
JFet J JX   Nd  Ng  Ns  Nome J1   n1  n2  n3  J310

Js   d    g    s    JM1
Mosfet M MX  Nd  Ng Ns  Nb  Nome 

Nb è il terminale del substrato
Di solito coincide con il drain

M13   2  7  5  2  IRF830

La scrittura del listato di cui sono stati dati alcuni esempi ha solo lo scopo di informare il  
programma che i dispositivi D,Q,J  ecc. sono collegati ai nodi indicati, ma non sono ancora 
stati  assegnati  i  parametri  specifici  di  ogni  dispositivo.  Per  i  componenti  passivi  basta 
assegnare loro il valore numerico. Per quelli attivi, dopo aver scritto le righe informative dei 
nodi bisogna aggiungere le righe dei parametri.  Quindi nel listato vengono aggiunte le  
righe seguenti. 
Cominciano sempre con .MODEL ( punto model)  per informare che si  sta scrivendo il  
modello; segue il nome del componente che può coincidere con la sigla del dispositivo o 
altro, infine la lettera identificativa del tipo di componente ( D per diodo, NPN/PNP per 
transistore npn/pnp, J per fet M per mosfet.) Segue fra parentesi la serie di parametri che  
può essere molto lunga . Se un parametro non è riportato il programma assegna il valore  
di  default.  Per informarsi  sul  significato di  ogni  parametro riferirsi  al  manuale originale 
SPICE.  Si  avvisa comunque che detti  parametri  non sono quelli  che siamo abituati  a 
leggere nei data sheet, come ad esempio α o β o i parametri ibridi hFE, hfe, hie ecc. dei 
transistori. Solo pochi parametri coincidono con quelli  a noi familiari.  Ad esempio per i 
diodi, IS rappresenta la corrente inversa di saturazione, ma tutti gli altri non li troveremo 
mai specificati nei data sheet. Per fugare ogni delusione o scoraggiamento, il problema 
non sussiste perché i valori dei parametri si trovano riportati sul web per ogni componente 
e  una  volta  copiato  il  modello,  Target  lo  elabora  immediatamente  e  assegna 
automaticamente  la  lunga  lista  di  valori  ai  rispettivi  parametri.  Vedere  l’esempio 
successivo.

Scrittura del modello di un diodo
.MODEL 1N4148 D(IS=0.1P RS=16 CJO=2P TT=12N BV=100 IBV=3.867E-10)
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Scrittura del modello per transistore npn e pnp
.MODEL  BCXXX  NPN(IF=  NS=  ISE=  NF=   BF=..lunghissima  serie  di 
parametri)
.MODEL BCYYY PNP(IF= NS=  ISE=  NF=  BF=..lunghissima serie di 
parametri)

Per i modelli degli altri componenti riferirsi al manuale di SPICE 3F5.
Di seguito è riportato un esempio di listato per un diodo 1N4148.

D1  n1 n3 IN4148    ; riga per assegnare i nodi n1,n3 al diodo
............... ; il primo nodo è sempre l’anodo
...............
...............

* segue la riga che assegna i parametri del 1N4148 al modello.

.MODEL 1N4148 D(IS=0.1P RS=16 CJO=2P TT=12N BV=100 IBV=3.867E-10)

10.8  Assegnare un modello a un componente primitivo in Target. 
Con l’esempio che segue si spiega come assegnare in Target il modello del transistore 
BC337-40 inizialmente non dotato di modello di simulazione.
Apriamo la finestra Components, facendo M1 sull’icona dell’amplificatore operazionale.
In  Target components cercare BC337. Nella casella a sinistra accanto alla sigla BC337 
fare M2 > Symbol,Package,3D,Simulation > Edit simulation model. Alla richiesta di creare 
una copia USER rispondere Si. Nella casella a sinistra accanto a USER fare M2  Si apre 
la finestra Models for BC337. M1 su Search. Si apre una finestra in due sezioni, destra e 
sinistra. Nella sezione di destra fare M1 sulla freccia blu e scegliere la ricerca su Google. 
Nella pagina di internet scrivere BC337 nella casella  Model Spice e cercarsi il modello, 
es.: quello fornito da Philips. Copiare il listato in un file di testo e salvarlo col nome BC337.
Copiare di nuovo il listato, tornare nella finestra Simulation model browser e M1 di nuovo 
sulla freccia blu di destra > Reload from > Clipboard. A questo punto avviene il miracolo! 
Target si copia tutti i parametri e sono tanti. Inoltre appare una casellina grigia col nome 
del componente come indicato nel listato, ad es. QBC337. Per vedere la lista dei parametri 
M2 > Edit/Show. Appare la lunga fila di parametri.
M2  di  nuovo  >  Import. Con  questo  passo  importiamo  a  sinistra  il  nuovo  modello. 
Rispondere Si  alla  eventuale richiesta di  Refresh. A questo punto abbiamo inserito  in 
Target il modello di simulazione del BC337.
Tornare  alla  finestra  Components e  fare  M2  nella  finestra  di  BC337  a 
sinistra.>Symbols,Packages,3D Simulation > Edit simulation model. Nella finestra Models 
for BC337 M1 su Select. Appare la lista dei primitivi. Scorrere fino a trovare il simbolo del 
transistore. Nella casella  Modelcards in alto a destra scegliere il nome, nel nostro caso 
QBC337. Immediatamente Target sostituisce ai  valori  di  default   i  parametri  propri  del 
BC337. 
Nella casella Pinassignment trascinare il numero 1 da sinistra a destra nella casella gialla 
collettore, 2 in quella della base, 3 in quella dell’emettitore. OK. Chiudere tutte le finestre. ( 
non importa inserire Level).
Ora abbiamo un transistore dotato di modello di simulazione e pronto per essere importato 
in un circuito.

62



10.9  Sorgenti di tensione e corrente.
SPICE  contiene  anche  i  modelli  primitivi  di  sorgenti  di  tensione  e  corrente,  sia 
indipendenti,  cioè  autonome,  che  dipendenti  da  altre  tensioni  e  correnti  pilota.  La 
dipendenza può essere lineare, ma è prevista anche una dipendenza non lineare.
Tutte  queste  sorgenti  sono  già  riportate  nella  lista  dei  modelli  primitivi  di  Target, 
menzionata prima, ed è interessante andarla a scorrere voce per voce. I modelli in Target  
permettono all’utente di importarli nello schema da simulare e di assegnare loro i valori 
richiesti.

10.10  Esempio di assegnazione dei parametri ad una sorgente.
Ad es.: per importare una sorgente sinusoidale, M11 sull’icona delle sorgenti nella barra 
verticale a destra nella lista  Components.   Si apre la finestra  Components e a sinistra 
appare la finestrella  Components name, che riporta vari tipi di sorgenti. Scegliere quella 
sinusoidale e importarla.  Per assegnarle i  valori  che ci  interessano, M11 >  Simulation 
Value > Edit. Appaiono tutti i parametri da personalizzare. La lista verticale di sinistra è 
riservata ai parametri necessari per fare una simulazione AC. Questa simulazione riporta 
in un grafico l’ampiezza in funzione della frequenza, dell’uscita del circuito sotto esame. Il  
segnale  sinusoidale  in  entrata  ha  una  ampiezza  come  specificata  nella  casella  AC 
magnitude. ( vedi 8.7 )
Per tutti gli altri casi lasciare a zero.
Nella  colonna  centrale  si  richiede  il  valore  di  V0  che  rappresenta  una  eventuale 
componente continua della sinusoide. Se si vuole una sinusoide simmetrica all’asse delle 
ascisse inserire 0.
Nella casella VA viene riportata l’ampiezza della sinusoide della sorgente. La casella Freq.  
serve per impostare la frequenza della sinusoide.
Nella  lista  a  destra  è  richiesto  TD che  rappresenta  il  ritardo  in  sec.  con  cui  parte  la  
sinusoide dal momento di inizio della simulazione, mentre THETA rappresenta il Damping 
factor, cioè il fattore di smorzamento nel caso che l’ampiezza della sinusoide si attenui con 
il tempo.
Poi si passa al Pinassignment per collegare la sorgente allo schema elettrico.
Se si  vuole assegnare direttamente l’ampiezza alla sinusoide, senza passare per tutta 
questa  trafila,  si  fa  M11 sul  componente,  e  appare  la  finestra  Change symbol.  Poi  > 
Simulation value > Edit e nella casella VA fare M1 sull’icona della calcolatrice e scrivere 
COMPONENTVALUE. Non scrivere direttamente nella casella di VA ma in quella della 
calcolatrice. Infatti in quest’ultima vanno scritti i valori letterali e le formule, mentre nella 
casella di VA solo numeri.
Chiudere tutte le finestre  OK-OK-Close-OK. Ovviamente se si chiudessero con un click 
sulla crocetta rossa in alto a destra le modifiche non verrebbero effettuate.
D’ora in poi si potrà assegnare l’ampiezza subito nella casella Value di Change Symbol.

10.11  Scrittura delle istruzioni di una sorgente
Per scrivere noi stessi le istruzioni di modelli di simulazione, ci occorre conoscere come 
inserire le sorgenti nel listato del modello.
La sintassi per la scrittura di queste sorgenti è riportata nei manuali di SPICE 3F5 cui si  
rimanda per la lettura. Qui si riportano solo alcuni esempi di scrittura che ci serviranno nel 
seguito.
Le  sorgenti  sono  suddivise  in  indipendenti,  dipendenti  linearmente  e  dipendenti  non 
linearmente. 
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10.12  Sorgenti indipendenti in continua e periodiche.
Di  seguito  è  riportata  la  sintassi  di  scrittura  delle  sorgenti  indipendenti  di  tensione  e 
corrente sia continue (DC) che alternate (AC) e periodiche.
Sintassi Esempio
Vxx n+ n- DC  valore Vcc  3  0  DC  12
Vxx n+ n- AC ampiezza fase Vin n1 n2 AC 1  45 SIN( 0 1 1K 0  0 )

Vmis 12 4
Nel primo esempio dopo Vcc e l’indicazione dei nodi, il primo positivo, il secondo negativo, 
DC sta ad indicare che trattasi di una sorgente continua. 12 rappresenta il valore in volt.  
L’espressione DC è opzionale e si usa quando la tensione è costante nel tempo, come nel  
caso di un alimentatore DC. Se il valore della tensione è zero, si può omettere 0. ( vedi  
terzo esempio Vmis )
Una tensione di  valore nullo è utile in quanto si  può usare come amperometro!  Infatti 
SPICE calcola sia la tensione che la corrente che scorre in ogni componente. Se nella 
sorgente, la tensione è posta nulla, la sua introduzione nel circuito non lo perturba, non ha 
effetto, mentre SPICE calcola comunque la corrente che scorre nella sorgente.
Nel secondo esempio si vede che trattasi di una tensione alternata  ( AC ) di ampiezza 1 di 
fase 45°, di forma sinusoidale. Fra parentesi è indicato prima una eventuale componente 
continua  ( 0 ) sovrapposta alla sinusoide,  poi l’ampiezza ( 1 ) poi la frequenza in Hertz ( 1 
K ) infine il ritardo con cui parte ( 0 )  e il fattore di smorzamento nel caso l’ampiezza si  
attenuasse con il tempo.
Per le sorgenti di corrente la sintassi è identica; cambia solo la V iniziale che diventa I.

10.13  Sorgenti dipendenti lineari
SPICE contiene il modello di 4 sorgenti linearmente dipendenti:
i = g.v v = e.v i=f.i v=h.i
con g, e, f, h costanti rispettivamente trans conduttanza, guadagno di tensione, guadagno 
di corrente e trans resistenza.
La sintassi è la seguente

• Sorgente di corrente controllata da tensione. “G”
Sintassi Esempio
Gx n+ n- nc+ nc- valore G1  2  0  3  7  9mmho
Sigla G seguita da alfa numero, nodo positivo, nodo negativo della corrente, nodo 
positivo, nodo negativo della tensione pilota, valore della trans conduttanza 
espresso in mho, che è l’inverso di ohm. 1 milli mho = 1 mmho = 1 mA/V.

• Sorgente di tensione controllata da tensione. “ E ”
Sintassi Esempio
Ex  n+ n- nc+ nc- valore E1  2  0  3  7  2.0
Sigla E seguita da alfa numero, nodo positivo, nodo negativo della tensione, nodo
positivo, nodo negativo della tensione pilota, valore del guadagno di tensione. 

• Sorgente di corrente controllata da corrente. “ F ”
Sintassi Esempio
Fx   n+  n-  nomeV  valore F2  3  5  Vmis 10
Sigla F seguita da alfa numero, nodo positivo, nodo negativo della corrente, nome 
della tensione percorsa dalla corrente pilota e che è usata come amperometro, 
guadagno di corrente
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• Sorgente di tensione controllata da corrente. “ H ”
Sintassi Esempio
Hx   n+  n-  nomeV  valore H9  2  0  Vmis  0.5K
Sigla H seguita da alfa numero, nodo positivo, nodo negativo della tensione, nome
della tensione percorsa dalla corrente pilota e che è usata come amperometro,
valore in ohm della trans resistenza. 
La direzione positiva della corrente di controllo è sempre dal nodo positivo 
attraverso la sorgente di tensione usata come amperometro, al nodo negativo della 
stessa.

10.14   Sorgente non linearmente dipendente .  “ B “
La sorgente può essere una tensione o una corrente. La dipendenza viene espressa da 
una funzione matematica.
Sintassi Esempio
Bx  n+  n-  funzione B3  5   7   I=3*sin(3*V2)+4

Bn n1 n2    V=5*cos(Ip^3)
BX n1 n2    I= cos(v1) + sin(v2)
B1 3  4   I=17

Se c’è la lettera V significa che trattasi di sorgente di tensione, se c’è la I significa che è 
una sorgente di corrente.
Le funzioni matematiche comprendono oltre alle 4 operazioni aritmetiche, l’elevazione a 
potenza, la radice quadrata, tutte le funzioni trigonometriche, i logaritmi in base dieci e in 
base “e” . La lista è la seguente:
Abs  sqrt log  ln  asinh  cosh  sin acos  atan  exp  sinh 
acosh  tanh  asin  cos tan.
Inoltre sono contemplate anche le seguenti funzioni:

10.15  Funzione URAMP
Funzione molto utile per rappresentare dispositivi attivi non compresi tra quelli  primitivi, 
come i tubi elettronici, ancora molto apprezzati dagli audiofili.
Quando l’argomento x è negativo la funzione è nulla. Quando è positivo la funzione è 
uguale  al  valore  dell’argomento.  In  un  diagramma cartesiano,  per  x  negativo  è  zero.  
mentre per  x  > 0 è  rappresentato  da una retta  uscente  dall’origine e inclinata di  45° 
rispetto alle ascisse.
Questa  funzione opportunamente modificata,  serve  egregiamente per  rappresentare  la 
caratteristica ad es. di un diodo a vuoto, di un triodo, di un pentodo ed altri dispositivi più 
moderni.
Funzione “u” (  gradino unitario )
Il valore della funzione è uno per t > to. E’ zero per t < to. 

10.16  Sub-circuiti
Fino  ad  ora  abbiamo  conosciuto  solo  i  componenti  primitivi.  Esistono  però  molti  altri 
componenti che non sono compresi tra i primitivi. Per simularli occorre creare dei circuiti 
appositi  realizzati  con  più  componenti  primitivi  racchiusi  in  un  contenitore  ideale  con 
terminali di ingresso e uscita che andranno collegati allo schema elettrico esterno.
Creeremo così una macro che verrà letta dal programma come un nuovo componente, e 
sarà eseguita secondo le istruzioni riportate nel modello.
Le istruzioni iniziano con . SUBCKT ( punto subckt ) che informa il programma che iniziano 
le istruzioni del sub circuito.
Segue il nome che abbiamo assegnato al sub circuito.
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Seguono i numeri  o lettere che indicano i nodi assegnati  al  sub circuito che andranno 
collegati ai terminali dello schema elettrico.
PARAMS: informa il programma quali sono i parametri del sub circuito, cioè variabili cui 
dobbiamo assegnare di volta in volta un valore, es.: valori dei componenti, numeri spire, 
coefficienti di accoppiamento ecc..
I  parametri che verranno impiegati nel modello debbono essere tutti  dichiarati all’inizio,  
dopo PARAMS. I valori numerici assegnati ai parametri, sono valori iniziali di default, ma 
saranno da noi modificati per ogni nuovo progetto, inserendoli a mano nella apposita lista  
dei parametri, quando apriremo di nuovo la simulazione. Se, per qualche voce, va bene il  
valore di default assegnato nel listato, lasciare la scritta default.
Se, nella scrittura dei parametri,  una riga non è sufficiente, si va a capo, si mette il segno 
+ e si continua.

10.17 Regole per la scrittura delle istruzioni
• Il sub-circuito deve iniziare sempre con .SUBCKT seguito dal nome e dai nodi che 

lo collegano con l’esterno. Può seguire la definizione dei parametri se esistono.
Segue la descrizione dei componenti.

• Quei  componenti  che intendiamo considerare parametri,  e  solo  quelli,  dovranno 
essere riportati nella lista dopo l’espressione PARAMS: . Indicheremo la loro sigla e 
un valore iniziale di default che modificheremo per ogni nuovo progetto. Es.: R1= 
5K. I  parametri  non sono solo componenti;  possono essere qualsiasi valore che 
interviene nella descrizione del sub-circuito, quali numero spire di un componente 
avvolto, frequenza, periodo, guadagno, ecc.. Tali valori interverranno nelle formule 
che seguono nelle istruzioni successive.

• Se una riga non è sufficiente per accoglierli tutti, i parametri continuano in righe 
successive anteponendo + all’inizio di ogni riga.

• Tutti  i componenti racchiusi nel sub-circuito debbono essere dichiarati, affinché il  
programma li  possa utilizzare  e possa interpretare  lo  schema dei  collegamenti.  
Perciò è necessario scrivere una riga per ciascuno che contenga la sigla ( R1, Ra,  
C1, Ct, D1, Q1 ecc..) cui seguono, espressi con caratteri alfanumerici,  i nodi di  
collegamento,  e  infine  il  valore  del  componente.  Il  primo  nodo  scritto  è  quello 
positivo  in cui entra la corrente. Tutte queste indicazioni sono separate da spazi 
bianchi, uno o più di uno indifferentemente.
Quei componenti, cioè elementi dotati di nodi, già inseriti nella lista dei parametri, 
dovranno anch’essi essere dichiarati al pari degli altri componenti, per indicare al  
programma i loro nodi e il valore anche se già attribuito in Params. Es:: R1 n1 n2 
{R1}. Spiegazione: n1, n2 sono i nodi.  Racchiuso  tra  parentesi  graffe  è  la  sigla 
stessa R1 il cui valore è già stato assegnato precedentemente tra i parametri

• Se il valore è un numero, si può scrivere tale e quale. Se è un valore letterale o una 
formula,  occorre  racchiudere  l’espressione  fra  parentesi  graffe.  Es.:  {C3}, 
{Lp*n^2}.

• L’impostazione  dei  parametri  si  effettua  con  M11  sul  sub-circuito  >  Change 
Symbols > Simulation value > Edit > Parameter. Se un valore di default va bene 
come è, lasciare la scritta Default.

• Oltre  alle  righe  di  dichiarazione  dei  componenti,  nel  listato  di  un  sub-circuito 
seguono  le  dichiarazioni  delle  sorgenti,  e  le  istruzioni,  come  ad  es.:  .MODEL 
descrittive  delle  caratteristiche  di  componenti  primitivi  a  stato  solido, 
precedentemente  già dichiarati. Per altre istruzioni si rimanda al manuale originale.

• L’ordine con cui vengono inserite le righe dopo PARAMS è libero 
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• .ENDS è obbligatoriamente l’ultima riga e informa il programma che la descrizione 
del sub circuito è terminata. Quando il sub circuito è inserito in un altro sub circuito, 
occorre far seguire a ENDS il nome del sub circuito che è finito. Se non inserito in 
altro sub circuito non è necessario aggiungere il nome dopo .ends.

10.18  Esempio di sub circuito: simulazione di un trasformatore
*
.SUBCKT TRASFALIM 1 2 3 4 PARAMS: Np=300 Ns=30 Rp=100K Rs=1
E 5 4 1 2 {Ns/Np}
F 1 2 VM {Ns/Np}
VM 5 6 0
Rp 1 2 {Rp}
Rs 6 3 {Rs}
.ENDS

Spiegazione:
Dopo  .SUBCKT segue il nome TRASFALIM e i 4 terminali 1,2,3,4.
PARAMS (senza  il  punto  iniziale,  ma  con  :  dopo  )  informa  che  vengono  dichiarati  i 
parametri Np,Ns,Rp,Rs e viene loro assegnato un valore provvisorio di default.
Nelle righe successive sono riportate tre sorgenti, le prime due ( E,F ) dipendenti e la terza 
( Vm ) indipendente.

E 5 4 1 2 {Ns/Np} ; tensione ai terminali 5,4 al secondario proporzionale a quella ai 
nodi 1,2 al primario. Il  fattore di proporzionalità è il  rapporto spire {Ns/Np}. Notare che 
Ns/Np è fra parentesi graffe trattandosi di espressione letterale e non di un numero.

F 1 2 VM {Ns/Np} ; corrente  nel  primario  che  entra  nel  nodo  1  e  esce  dal  2, 
comandata dalla corrente nel secondario misurata dall’amperometro Vm = 0V connesso 
tra i nodi 5,6. Il fattore di proporzionalità è {Ns/Np}.

Rp 1 2 {Rp} e Rs 6 3 {Rs} sono le resistenze in serie al primario e al secondario 
di valore {Rp} e {Rs}.

.ENDS ; Terminano le istruzioni del sub circuito.

10.19  Esempio di modello di diodo Zener.

*
*
**********  Diodo Zener BZX85C9V1  **************************
*
.SUBCKT BZX85C9V1 A K
D1 A  K  DF
D2 n1 A  DR
Vd K  n1 8.4

.MODEL DF D ( IS=522.2E-18 N=1.004 RS=.12 KF=1 XTI=3 EG=1.11
+ CJO=96.83E-12 M=.3303 VJ=.7662 FC=.5 BV=9.215 
+ IBV=.4354 TT=93.78E-9 )
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.MODEL DR D (IS=2.88f RS=13.1 N=3 )

.ENDS

               
Spiegazione:
Il modello si realizza con due diodi Df e Dr  collegati in controfase e una tensione Vd.
Il diodo Df simula il diodo Zener polarizzato direttamente. Il diodo Dr simula il diodo Zener 
polarizzato inversamente. 
La tensione Vd = 8,4 V sommata alla  tensione di soglia di Dr polarizzato direttamente e  
alla caduta sulla resistenza interna del diodo, parametro RS, simula la tensione di Zener.
Righe: D1 A  K  DF  , D2 n1 A  DR ; i diodi sono dichiarati e assegnati ai 
rispettivi nodi.
Vengono poi forniti, con l’istruzione .MODEL,  i parametri caratteristici dei due diodi.

10.20  Esempio di simulazione di pentodo EL84
E per finire… un tuffo nel passato romantico dei tubi elettronici.
*
* Piedinatura Zoccolo     > Modello
* _______________________  
*   7 Anodo A
*        9 Schermo S
*        2 Griglia G
*        3 Catodo K
*
*--------------------------------
*
.SUBCKT EL84 A S G K
*
* Corrente di catodo
*
Bat  at  0 V=0.636*ATAN((V(A)-V(K))/15)
Bgs  gs  0 V=URAMP((V(S)-V(K))/19+V(G)-V(K)+(V(A)-V(K))/1400)
Bgs2  gs2 0 V=V(gs)^1.5
Bcath cc  0 V=V(gs2)*V(at)
*
* Corrente Anodica
*
Ba A   K I=3.2E-3*V(cc)
*
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* Corrente di schermo
*
Bscrn sc  0 V=V(gs2)*(1.1-V(at))
Bs  S   K I=2.0E-3*V(sc)
* Corrente di griglia (approssimazione! - non modella bassi va/vs)
*
Bg   G   K I=(URAMP(V(G)-V(K)+1)^1.5)*50E-6
*
* Capacità
*
Cg1 G K 10.8p
Cak A K 6.5p
Cg1a G A 0.5p

.ENDS 

Spiegazione:
Dopo .SUBCKT, e il nome, segue la lista dei nodi del subckt ( A,S,G,K ) che andranno 
collegati ai rispettivi piedini dello zoccolo della valvola come rappresentato nello schema 
elettrico.
Le righe successive servono a rappresentare  le caratteristiche del tubo elettronico tramite 
sorgenti dipendenti non lineari ( B ). Cxy sono le tre capacita interelettrodiche.
Si vede come la funzione URAMP venga utilizzata per adattarsi il più possibile alla curva 
caratteristica da rappresentare.
In genere queste funzioni vengono ricavate automaticamente da appositi programmi che 
catturano il disegno della curva caratteristica rilevata nei data sheet, riproducono una loro 
copia  della  curva,  la  convertono  in  lista  di  numeri  infine  forniscono  le  istruzioni  in 
linguaggio SPICE 3F5, PSPICE o altri.

Nota importante!
Spesso si trovano in internet modelli in cui la tensione fra due punti 1,2 è rappresentata 
con V(1,2). Ad esempio la tensione fra anodo e catodo è scritta V(A,K).
Il programma di simulazione in Target rifiuta questa sintassi. Occorre al posto di V(A,K)
scrivere  V(A)  -V(K)  facendo  dopo  molta  attenzione  alle  parentesi  (  V(A)  -V(K)  )  che 
dobbiamo aggiungere per non modificare l’espressione matematica della funzione.
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11 - APPENDICE C
       SIMULAZIONE DEI TRASFORMATORI

    11.1  La simulazione dei trasformatori in SPICE 3F5
Spice non contiene fra i suoi componenti il modello del trasformatore, tutt’al più contiene il 
modello di due o più induttanze accoppiate, con fattore di accoppiamento K.
Per simulare un trasformatore abbiamo due possibilità

1. Utilizzare il modello primitivo delle induttanze accoppiate
2. Creare un sub circuito che simula il comportamento del trasformatore ideale, cioè 

senza perdite e aggiungervi i componenti che simulano dette perdite.
Questo  secondo  metodo  è  nettamente  più  adatto  del  precedente  per  la  possibilità  di 
valutare le perdite nel rame, nel ferro e quelle per flusso disperso.
I  primi  due esempi che seguono utilizzano il  fattore di  accoppiamento,  mentre il  terzo 
riporta la simulazione di un trasformatore tramite un sub circuito contemplando anche le 
perdite.

11.2  Esempio di simulazione: trasformatore di alimentazione
La simulazione si riferisce a un modello semplificato di trasformatore e non tiene conto 
delle  varie  perdite  rappresentate  nello  schema  equivalente  completo.  Pertanto  il  suo 
impiego  è  limitato  a  trasformatori  di  alimentazione  funzionanti  a  50Hz  supponendo 
assenza di flusso disperso dal primario al secondario, e nulle le correnti di Foucault nel  
ferro.
Il  trasformatore  che  andremo  a  disegnare,  non  è  dotato  di  modello  primitivo  di 
simulazione; pertanto dovremo crearne uno noi stessi. Se siamo in fase di progetto e il  
trasformatore non è ancora realizzato, dovremo ricavare dal calcolo i parametri richiesti 
dalla simulazione. Se disponiamo di un trasformatore simile, potremmo anche, in prima 
approssimazione, ricavare parametri simili tramite misura su detto componente e adattarli 
a quello che vogliamo simulare.

11.3  Disegno dello schema elettrico.
Dapprima  disegniamo  lo  schema  elettrico  del  progetto;  per  il  trasformatore  possiamo 
utilizzare  lo  schema  di  uno  già  fatto,  purché  con  singolo  secondario,  ad  es.: 
EE20_Pri230V-Sek24V/21MA della libreria di Target.
Si apre un nuovo progetto e si importa il trasformatore nello schema.
Poi si completa lo schema elettrico come in figura.

70



Fig.11.1

Come resistenza di carico R1 da 10 Kohm, si usa una già dotata di modello di 
simulazione, come ad es.: R_MET_10K_0207. Non importa se la potenza di targa non è 
quella appropriata ad un funzionamento reale.
La sorgente di alimentazione è V_SINUS, anch’essa dotata di modello, ma che dovremo 
impostare a 230Veff.
M11 sul simbolo della sorgente. Nella casella value si mette 230 Veff. Poi M1 su 
Simulation values > Edit. Nella casella AC magnitude si mette 0. Nella casella VA si mette 
l’ampiezza (230 x 1.42)= 325 V. Nella casella FREQ si mette 50 Hz. Chiudere tutte le 
finestre.
Poi occorre importare il simbolo della massa. Si effettuano i collegamenti.
Il modello di simulazione utilizzato richiede che entrambi gli avvolgimenti siano collegati 
galvanicamente a massa.

11.4 Ricerca dei parametri di simulazione.
Nella figura seguente è rappresentato, a sinistra lo schema elettrico e a destra il circuito 
equivalente  del  trasformatore  semplificato  con  funzionamento  a  frequenza  di  rete  e 
utilizzato dal modello di simulazione in oggetto.

Fig.11.2

• Lp rappresenta l’induttanza al primario ottenibile dal calcolo a progetto oppure, con 
grossolana approssimazione, misurando con un adatto induttanzimetro, su un 
trasformatore simile, l’induttanza ai morsetti primari, con secondario aperto.

• Rp rappresenta la resistenza DC del conduttore primario, ottenibile dai calcoli o 
dalla misura, su realizzazione simile, con ohmetro applicato  ai morsetti primari.

• Ls si ottiene allo stesso modo di Lp, riferendosi ai morsetti del secondario.
• Rs rappresenta la resistenza DC del conduttore secondario, ottenibile dai calcoli o 

dalla misura con ohmetro ai morsetti secondari.
• K è il coefficiente di accoppiamento tra gli avvolgimenti del trasformatore e potremo

valutarlo con buona approssimazione  0,999. 
Con l’occasione si ricorda che K= M / √ (Lp.Ls) con M induttanza mutua.

      Abbiamo ora i parametri necessari per scrivere il modello del trasformatore.
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11.5  Modello di trasformatore di alimentazione
Il trasformatore che abbiamo importato nello schema elettrico, non è ancora dotato di 
modello di simulazione e dobbiamo scriverne uno noi stessi.
Il listato del modello che assegneremo è quello riportato di seguito che potrà essere 
copiato e incollato. 
Copiare il modello che segue in un file di testo con un nome a piacere ad es.: 
TRASF1SEC.txt.

*
*Simulazione di un piccolo trasformatore di alimentazione
*
.SUBCKT TRASF1SEC 1 2 3 4 PARAMS: Lp=28.2H Ls= 0.154H Rp=412 
+ Rs=2 K=0.999
*
* Avvolgimento primario
Rp 1 np {Rp}
Lp np 2 {Lp}
* Avvolgimento secondario
Rs 3 ns {Rs}
Ls ns 4 {Ls}
* Coefficiente di accoppiamento
K Lp Ls {K}
.ENDS

________________________________________________________________________
Spiegazione del listato.
Un asterisco davanti ad una riga indica che trattasi di un commento e non avrà effetto sul 
programma di calcolo.
.SUBCKT informa il programma che si tratta di un subcircuito, una scatola con 4 terminali 
che verrà letta dal programma come un nuovo componente, e sarà eseguita secondo le 
istruzioni riportate nel modello.
TRASF1SEC è il nome che abbiamo assegnato al subcircuito. Possiamo sostituirlo a 
piacere con altro.
1 2 3 4 sono i nodi assegnati ai terminali del sub-circuito rappresentato nello schema 
equivalente a destra in fig.11.2 e che andranno collegati a quelli dello schema elettrico del 
trasformatore.
PARAMS: informa il programma che segue la lista dei valori dei parametri del sub-circuito 
di Fig.11.2. Quelli assegnati sono valori iniziali, ma potranno essere modificati per ogni 
progetto, inserendoli a mano nelle apposite caselle dei valori di default, quando avremo 
assegnato il modello. ( vedi 11.5). Se la riga non basta, si va a capo e si mette +.
Segue la lista dei componenti. 
Prima viene indicata la sigla di ciascuno, es.: Rp, poi i due numeri rappresentativi dei nodi 
del circuito equivalente( 1, np ), infine il valore 100 ohm.
Quando il valore è un parametro, cioè può variare a seconda di quanto gli verrà assegnato 
di volta in volta ad ogni nuovo progetto, allora si scrive il valore letterale, racchiuso tra 
parentesi graffe {Rp}. Fra parentesi graffe potremo anche inserirvi una formula.
Lp,Ls sono le induttanze del primario e secondario, legate dal fattore di accoppiamento K.
.ENDS informa il programma che la descrizione del sub-circuito è completa.
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11.6  Inserimento del modello nel componente
Fare M11 sul disegno del trasformatore. Si apre la finestra Change Symbols. M1 su 
Simulation value > OK I understand the message> Search.
Si apre la finestra Simulation model browser , composta da due sezioni. Nella sezione di 
destra M1 sulla freccia blu, M1 su Reload from... > Files with (P)spice models.
Cercare il file .txt che abbiamo precedentemente creato e aprirlo. 
Immediatamente appare nel pannello di destra il nome del modello caricato TRASF1SEC.
M1 sulla casellina accanto > Import. Il modello è ora importato e appare nel pannello di 
sinistra. Chiudere.
M1 su Select e poi M1 sull’icona del subcircuito rappresentata da un quadratino nero con 
freccette rosse. Si apre la finestra Subcircuit. M1 sulla freccetta della casella Subcircuit e 
selezionare il nome TRASF1SEC. Ora per curiosità possiamo aprire la casella Edit ed 
andare a controllare il listato del modello che abbiamo importato.
Tornati in Subcircuit, andare nella casella Parameter.
Qui sono elencati i parametri del trasformatore con accanto la scritta DEFAULT.Vuol dire 
che vengono adottati dal programma quelli del listato. Quando dovremo cambiare 
trasformatore, al posto di DEFAULT scriveremo i nuovi valori.
M1 nella casella Pinassignment . E’ giunto il momento di assegnare ai nodi del circuito 
equivalente del modello, rappresentati nel quadro giallo a destra, quelli del simbolo del 
trasformatore come disegnato nello schema elettrico e riportati nel riquadro di sinistra.
Per trascinamento si sposta ogni numero da sinistra a destra, rispettando gli schemi.
Chiudere. Si torna in Models for Tr1. La casella LEVEL può essere trascurata. OK
Siamo tornati nella finestra Change symbol. Nella casella value possiamo scrivere  ad es.: 
la potenza apparente 10 VA. Chiudere. Il modello è stato ora assegnato al componente 
disegnato nello schema elettrico.

11.7   Simulazione
Prima conviene assegnare ai singoli collegamenti dello schema elettrico, nomi intuibili. 
M11 sul collegamento che dal generatore va al piedino 1 del trasformatore e scrivere ad 
es.: p. Al collegamento del piedino 6 assegniamo la sigla s.
Per iniziare la simulazione, M1 sulla bacchetta magica e poi su quella rappresentante le 
sinusoidi.
M1 su Extended settings for transient analysis. Inserire nelle caselle dei tempi partendo 
dall’alto: 100m,50m,1u,5u. Deselezionare Use initial condition. Chiudere.
M1 nella casella Select particular voltage and current.  M2 nel riquadro basso Add > 
Voltage against ground. M1 sui due collegamenti p e s. 
Tornati nel riquadro basso si troveranno scritti i due segnali V(p) e V(s). M2 su V(s) > 
Show immediately, per visualizzare solo la tensione di uscita al secondario.
Siamo finalmente giunti al momento della simulazione. M1 su Start simulation. Se tutto è 
andato bene deve apparire l’immagine seguente.
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fig.11.3

Il colore della traccia viene deciso automaticamente dal programma. Per cambiarlo fare 
M1 su View > Graph e selezionare ogni traccia assegnando nelle caselle di destra il colore 
preferito e lo spessore.

11.8   Analisi della simulazione
La simulazione si riferisce a un piccolo trasformatore da 10 VA, 230 -15V.
La resistenza di  carico di  10Kohm è molto  elevata ed è come se il  secondario  fosse 
aperto. Pertanto quello che vediamo è una situazione a vuoto.
Proviamo ora a cambiare la resistenza con una che assorba 10 W dal trasformatore.
Operiamo per tentativi  e supponiamo che sotto  carico il  valore di  picco della tensione 
scenda a 20 V. La resistenza da inserire  è 202V / (2x10 W) = 20 ohm.
Poichè Rs =2 ohm, dovremo inserire una resistenza di 18 ohm.
Quello che vedremo è

fig.11.4
Ci siamo andati vicino perchè il valore di picco è sceso a 19.5V e la potenza erogata è 
19.52 / (2x20 ) = 9,5W. 
La corrente che scorre nella resistenza di carico sarà: 19.5V /  18ohm= 1,08 A.
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Detta corrente, volendo, può essere visualizzata:  Simulation  >  Edit selection > Add > 
Current .
M1 col  cursore  su  una  estremità  della  resistenza  di  carico.  Poi Show immediately e 
deselezionare la tensione di carico in modo da vedere solo la corrente.
Torniamo ora ad esaminare il listato del modello di simulazione. Nasce una domanda: tra i 
parametri forniti al programma si nota che manca il rapporto di trasformazione n=Ns/Np, 
che definisce la tensione al secondario data quella al primario. Come fa il programma a 
fornire la tensione di uscita richiesta?
La risposta è che il rapporto di trasformazione è stato fornito senza accorgersene quando 
abbiamo indicato Lp ed Ls. 
Infatti  Ls / Lp = n2 ed è per questa relazione che il programma è in grado di fornire la 
tensione di uscita.
Nel caso precedente Ls / Lp = 0,154 / 28,2 = 5,46.10-3          n = √ (5,46.10-3) = 0,074.
Se è più comodo in alternativa possiamo  indicare nel listato il valore di Lp e di n :

*
* Simulazione di un piccolo trasformatore di alimentazione
* con indicazione del rapporto di trasformazione “n”.
*
.SUBCKT TRASF1SEC 1 2 3 4 PARAMS: Lp=28.2H n=0.074 Rp=412 
+ Rs=2 K=0.999
*
* Avvolgimento primario
Rp 1 np {Rp}
Lp np 2 {Lp}
* Avvolgimento secondario
Rs 3 ns {Rs}
Ls ns 4 {Lp*n^2}
* Coefficiente di accoppiamento
K Lp Ls {K}
.ENDS

Se inseriamo questo listato nel trasformatore vedremo che il risultato della simulazione è 
lo stesso.
Nota: è’ comunque necessario, anche se non è più riportato tra i parametri, continuare a 
inserire l’induttanza Ls e il suo valore verrà espresso con la formula Ls = Lp*n^2.

75



11.9   Simulazione di trasformatore di alimentazione con due secondari
Si prende ora in considerazione un trasformatore di alimentazione con due avvolgimenti 
secondari. Nell’esempio è stato simulato uno da 6 VA.
Seguendo il percorso di quanto già fatto con il trasformatore a singolo secondario, si parte 
col  disegno dello schema elettrico.  Per il  trasformatore si  utilizza uno qualunque della 
libreria  di  Target,  purché  abbia  due  avvolgimenti  secondari,  come  EE130_PRI230-
SEK2X15V/33MA. Non importa che il trasformatore sia dotato di modello di simulazione 
perché lo inseriremo noi.
Per le resistenze di carico si usano quelle già dotate di modello di simulazione come ad 
es.: R_MET_100-OHM_0207.
Il generatore è esattamente quello dell’esempio precedente impostato a 230 Veff.

Fig.11.5

Il modello di simulazione da inserire nel trasformatore con due secondari è il seguente:

*
*
*
*Simulazione di un piccolo trasformatore di alimentazione 
*con 2 secondari isolati tra loro.
*
.SUBCKT TRASF2sec 1 2 3 4 5 6 PARAMS: Lp=5 Rp=100 n1=0.1 n2=0.05 
+ Rs1=1 Rs2=1 K1=0.99 K2=0.97 K3=0.95
*
* Rapporto spire n1 = Ns1/Np  n2=Ns2/Np
*Induttanza secondario Ls1= Lp * (n1)^2  Ls2= Lp*(n2)^2
*
*
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R24 2 4 1E9 ; R24,R26 sono necessarie per riferire
R26 2 6 1E9 ; a massa tutti i tre avvolgimenti
*
* Avvolgimento primario
Rp 1 np {Rp}
Lp np 2 {Lp}
* Avvolgimento secondario 1
Rs1 3 ns1 {Rs1}
Ls1 ns1 4 {Lp*(n1^2)}
* Avvolgimento secondario 2
Rs2 5 ns2 {Rs1}
Ls2 ns2 6 {Lp*(n2^2)}
* Coefficienti di accoppiamento
K1 Lp Ls1 {K1}
K2 Lp Ls2 {K2}
K3 Ls1 Ls2 {K3}
.ENDS
*
*

Nel listato sono state aggiunte due resistenze R24 e R26, comprese nel subcircuito e non 
visibili  nello  schema,  di  valore  molto  elevato,  che  collegano  il  morsetto  basso  2  del 
primario,  nello schema già collegato a massa, con i  rispettivi  morsetti  bassi 4 e 6 dei  
secondari.  Questo accorgimento è reso necessario dal  programma di  simulazione che 
impone che tutti gli avvolgimenti abbiano un riferimento galvanico ( cioè DC ) a massa.  
Potevamo eliminare le due resistenze, ma avremmo dovuto collegare a massa tutti i tre 
avvolgimenti.  Infatti  nell’esempio  con  un  solo  avvolgimento,  non  c’è  la  resistenza  tra 
avvolgimenti dato che sono entrambi collegati a massa.
Una  volta  inserito  il  modello  nel  simbolo,  come  già  fatto  nel  trasformatore  con 
avvolgimento  singolo,  dovremo  assegnare  ai  parametri  del  modello  i  valori  reali  del  
trasformatore. I valori misurati sul campione reale sono i seguenti:
Lp = 24.12 (H)
Rp = 818 (ohm)
n1 = 0.068
n2 = 0.068
Rs1 = 7 (ohm)
Rs2 = 7 (ohm)
K1 = 0.99, K2=0.97, K3=0.95
Questi valori vanno sostituiti al posto di DEFAULT, nella finestra Subcircuit senza bisogno 
di scrivere anche l’unità di misura. 
Occorre poi  eseguire il  Pinassignement,  cioè collegare i  piedini  del  modello con quelli 
rispettivi dello schema elettrico del trasformatore che abbiamo importato nel disegno.
Piedini dello schema Piedini del modello

1  >   1
5 >   2
6 >   3
7  >   4
9 >   5
10 > 6

A questo punto il modello è inserito e possiamo chiudere tutte le finestre.
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Assegniamo valori  intuibili  ai  collegamenti  dello schema elettrico, e apriamo la finestra 
della simulazione. Vanno rinominati anche i morsetti  bassi dei due secondari in quanto 
non a massa.
Si inseriscono gli stessi tempi dell’esempio precedente 100m,50m,1u,5u.
Poi si va nella casella Edit selection e si scelgono i valori di tensione delle due uscite, da 
visualizzare all’oscilloscopio, tenendo conto di quali conduttori sono a massa e quali non.
Premendo Start simulation si dovrebbe vedere la seguente immagine.

 Fig.11.6
Assegnare ai grafici i colori che ci aggradano. Vew > Graph selezionare e inserire i colori a 
destra.
Le ampiezze dei secondari sono circa 19 V. Si noti che un secondario ha ampiezza minore 
dell’altro perchè ha un coefficiente di accoppiamento K=0,97 invece di K=0,99 dell’altro.
I loro valori efficaci sono quindi 19 :1,42 = 13,38 V su un carico di 100Ω. 
La potenza assorbita da ciascun secondario è Ps=13.382 /  100 = 1,79 W. La potenza 
assorbita dal primario, supponendo che l’efficienza del trasformatore sia η= 0,8
Pp= η.2.Ps Pp= 0,8x2.1,79 = 2,86W. Il trasformatore è piuttosto sottoutilizzato. Si poteva 
impiegare un trasformatore di 3 VA.
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11.10  Il trasformatore ideale
Il trasformatore ideale è rappresentato da un circuito equivalente che rappresenta un 
trasformatore privo di perdite. Si tratta ovviamente di una astrazione in quanto non è 
possibile realizzare tale macchina. Tuttavia è utile perché permette di costruire il circuito 
equivalente del trasformatore reale, aggiungendo al trasformatore ideale alcuni 
componenti dissipativi che simulano le perdite esistenti in quello reale.
Il simbolo del trasformatore ideale è iI seguente :

Fig.11.7
I due semicerchi che si intersecano rappresentano il simbolo che svolge la funzione  di 
trasformazione delle tensioni e delle correnti..
L’induttore L1 simula l’induttanza di magnetizzazione, cioè l’induttanza  offerta 
dall’avvolgimento primario a secondario aperto. In questa situazione il trasformatore 
richiama solo la corrente “ im “ in quadratura con la tensione al primario, quindi senza 
assorbimento di potenza. Quando al secondario viene collegata una resistenza di carico, 
circola in essa una corrente i2 che viene trasferita dal trasformatore ideale al primario con 
ampiezza i’1 e in fase con la tensione al primario.  
Si definisce “ rapporto di trasformazione”  il rapporto n = Ns / Np.
Il trasformatore ideale svolge due funzioni :

• la tensione trasformata al secondario è e2 = n.e1

• nel primario è indotta una corrente  i’1 =  n.i2 

11.11  Circuito equivalente del trasformatore reale
Per tener conto delle perdite che inevitabilmente riguardano un trasformatore reale, 
occorre inserire nello schema equivalente di quello ideale, gli elementi dissipativi che 
simulano tali perdite.
Le perdite si suddividono in perdite nel rame, perdite per flusso disperso e perdite nel 
ferro.
Le perdite nel rame sono quelle dovute alla resistenza galvanica ( misurabile con un 
ohmetro) del conduttore che costituisce ogni singolo avvolgimento. Si simula introducendo 
una resistenza Rp in serie al primario e una Rs al secondario. A frequenze più elevate, 
compaiono anche le perdite per effetto pelle e per prossimità da conglobare nella Rp.
Le perdite per flusso disperso sono dovute alla parte del flusso magnetico prodotto 
dall’avvolgimento primario che si disperde in aria senza concatenarsi con l’avvolgimento 
secondario. Le variazioni di questo flusso magnetico disperso creano per la legge di 
Faraday - Neumann delle tensioni di autoinduzione al pari di quelle create da quello 
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concatenato col nucleo; tali tensioni si aggiungono in serie all’avvolgimento primario. 
Anche il secondario, quando è percorso da corrente, produce un flusso magnetico che si 
concatena col primario, ma anche qui, in piccola parte si disperde in aria. Le tensioni di 
autoinduzione per flusso disperso, al primario e al secondario si simulano introducendo in 
serie agli avvolgimenti le induttanze simboliche Lp, Ls 
Perdite nel ferro: Si distinguono in 
Perdite per correnti di Foucault ( eddy currents) correnti vaganti che si disperdono nel 
nucleo magnetico. 
Perdite nel  nucleo durante il ciclo di isteresi dovute all’attrito del movimento alternato di 
allineamento dei dipoli magnetici elementari.
Di entrambe le perdite se ne tiene conto inserendo una resistenza complessiva  Rfe in 
parallelo alla induttanza di magnetizzazione.
Si può ora disegnare il circuito equivalente completo del trasformatore, valido per basse 
frequenze ( in cui non intervengono apprezzabili effetti capacitivi ):

Fig.11.8
Come si vede al circuito del trasformatore ideale sono stati aggiunti i componenti 
dissipativi che simulano le perdite.
I due punti neri indicano il verso degli avvolgimenti e delle tensioni e correnti.

11.12  Simulazione del trasformatore ideale con il sub-circuito.
Per simulare il trasformatore in alternativa all’impiego delle induttanze accoppiate occorre 
servirsi di un sub circuito che riproduce il circuito equivalente che si vuole simulare.
Dapprima simuleremo il trasformatore ideale, riferendosi al suo circuito equivalente, poi 
simuleremo il trasformatore reale sempre partendo dal suo circuito equivalente.
Tale modello si  può realizzare usando le “sorgenti  linearmente controllate” funzioni già 
conosciute ( 10.13 ) e presenti in Spice come elementi primitivi, vale a dire sorgenti di  
tensione o di corrente funzioni lineari di una tensione o una corrente, o viceversa. Delle 4  
funzioni linearmente dipendenti quelle che adesso ci interessano sono :

• la funzione lineare di tensione E, pilotata da una tensione con fattore di 
proporzionalità “ n “.

• la funzione lineare di corrente F, pilotata da una corrente, con fattore di 
proporzionalità “ n “.
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Con queste funzioni  possiamo simulare la funzione di  un trasformatore ideale perfetto 
( perfetto significa senza flusso disperso ). Infatti dette funzioni sono impiegate in un sub 
circuito che svolge le due funzioni del trasformatore ideale e cioè  e2 = n.e1   ,    i’1 =  n.i2.
Il circuito racchiuso nel sub circuito è rappresentato in fig.11.9

Fig.11.9
La E fornisce in uscita, tra il nodo 5 e 4 la tensione al secondario del trasformatore Vs = n. 
Vp  Il coefficiente di proporzionalità della funzione lineare è n  e Vp, tra i nodi 1,2 è la 
tensione al primario che funge da controllo della funzione E. 
La F fornisce tra i nodi 1,2 la corrente I’p , pari a n volte quella al secondario Is che è  
misurata dall’amperometro Vm. Si realizza così la funzione I’p = n.Is.
Il listato è dunque il seguente:

*
* Questo modello serve a spiegare come simulare un trasformatore 
* ideale, usando in un sub circuito, una tensione al secondario
* "E" controllata dalla tensione ai nodi 1 2 e con un fattore di
* proporzionalità n=Ns/Np. Analogamente viene impressa una
* corrente a primario "F" controllata dalla corrente misurata da
* VM=0, e proporzionale sempre a n= Ns/Np.
*
*
.SUBCKT XFRM 1 2 3 4 PARAMS: Np=300 Ns=30 Rp=100K Rs=1 Lm=20H
E 5 4 1 2 {Ns/Np}
F 1 2 VM {Ns/Np}
VM 5 6 0
Lm 1 2 {Lm}
Rp 1 2 {Rp}
Rs 6 3 {Rs}
.ENDS
*
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Rp e Rs sono necessari al programma per prevenire condizioni di singolarità  Notare che 
qui Rp è in parallelo al primario.
Sia l’avvolgimento primario che il secondario devono essere collegati galvanicamente a 
massa direttamente o tramite resistenza di alto valore.

11.13 Simulazione di trasformatore reale in bassa frequenza
La  simulazione  di  cui  sopra  rappresenta  il  trasformatore  ideale  con  accoppiamento 
perfetto, cioè senza flusso disperso. Per realizzare un modello che tiene conto del flusso 
disperso e delle perdite, occorre riferirsi al circuito equivalente completo che introduce i  
componenti dissipativi rappresentativi di dette perdite e le reattanze induttive per simulare 
l’effetto del flusso magnetico disperso.
Si fa riferimento al circuito equivalente di fig.11.8 che qui si riporta per comodità e con i  
nodi che serviranno nel sub-circuito.

Fig.11.10
Il listato del modello che simula il circuito equivalente di fig.11.10 è il seguente:
*
*
*****************Trasformatore reale**************
******con flusso disperso e perdite nel nucleo****
*
.SUBCKT Xfrm  P1 P2 S1 S2 PARAMS: Np=300 Ns=30
+ Rsp=100 ; Resistenza in serie a prim.
* ; dovuta alla res. del conduttore
+ Lsp=30n ; Induttanza in serie a prim.
* ; dovuta al flusso disperso primario
+ Lm=20H ; Induttanza di magnetizzazione
+ Rfe=50K ; Resist. in parall. dovuta
* ; a perdite nel ferro
+ Rss=1 ; Resist in serie a second.
+ Lss=20n ; Indutt. in serie a secondario
* ; dovuta a flusso disperso secondario.
*
*********  Primario
*
Lsp P1 n1 {Lsp}
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Rsp n1 n2 {Rsp}
Lm n2 P2 {Lm}
Rfe n2 P2 {Rfe}
*

*********  Secondario
*
E n4 S2 n2 P2 {Ns/Np} ; Tensione al second. comandata
* ; dalla tensione fra (n2-P2) e con 
* ; coeffic proporz. Ns/Np
Vms n4 n5 0 ; Tensione nulla, serve per misurare la
* ; corrente che scorre da n4 a n5.
F n2 P2 Vms {Ns/Np} ; Corrente nel primario comandata
* ; da corrente nel secondario
* ; coeff. proporz. Ns/Np
Rss n6 S1 {Rss} ; Resist serie secondario
*
Lss n5 n6 {Lss} ; Indutt. in serie secondario
* ; per flusso disperso generato
* ; dal secondario
.ENDS
*
*

Lsp è l’induttanza che simula il flusso disperso dall’avvolgimento primario
Rsp è la resistenza galvanica del conduttore primario.
Rfe è la resistenza che simula le perdite nel ferro che valgono Pfe = Vp2 / Rfe con Vp 
valore efficace della tensione primaria.
Lm  è  l’induttanza  di  magnetizzazione  misurabile  con  un  induttanzimetro  collegato  al 
primario, tenendo il secondario aperto.
Lss è l’induttanza dovuta la flusso disperso dall’avvolgimento secondario
Rss è la resistenza galvanica del conduttore secondario.
Vms è l’amperometro che comanda F
Ep, Es rappresentano le tensioni presenti nel circuito equivalente ideale

Il grado di accoppiamento qui non si esprime con il coefficiente k, ma viene definito dal  
valore  delle  induttanze  Lsp,  Lss;  più  alte  sono,  più  basso  è  il  coefficiente  di  
accoppiamento.
Le  perdite  nel  rame  sono  rappresentate  da  Rsp,  Rss  ,  resistenze  misurabili  con  un 
ohmetro.
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11.14 Simulazione di trasformatore reale in alta frequenza
Il circuito equivalente sopra esaminato è valido quando il trasformatore è utilizzato con 
frequenze basse. Quando si vuole utilizzare con frequenze elevate, oltre a aumentare le 
resistenze galvaniche del conduttore per l’effetto pelle e per quello di prossimità, occorre 
valutare anche le capacità distribuite tra le spire del conduttore, sia primario Cp che 
secondario Cs e quelle tra avvolgimento e avvolgimento. Cps.
Il circuito equivalente per alte frequenze è il seguente ( fig. 11.11 )
La differenza dello schema rispetto al circuito equivalente per bassa frequenza sta solo 
nella introduzione delle tre capacità Cpp, Cps, Css.

Fig.11.1
Il relativo modello di simulazione è:
*
************* Modello di Trasformatore per HF  ************
*con flusso disperso e perdite nel nucleo
*
.SUBCKT Xfrmcompleto  P1 P2 S1 S2 PARAMS: Np=300 Ns=30
+  Rsp=100  Lsp=30n  Lm=20H  Rm=50K  Rss=1  Lss=20n
+ Cp= 2pF ; Capacità parassite primario
+ Cps=10pF ; Capacità parass. prim.- second.
*
*********  Primario
Lsp P1 n1 {Lsp}
Rsp n1 n2 {Rsp}
Lm n2 P2 {Lm}
Rm n2 P2 {Rm}
Cp n2 P2 {Cpp}
Cps n2 n3 {Cps}
F n2 P2 Vms {Ns/Np} ; Corrente nel primario
*
*********  Secondario
E n4 S2 n2 P2 {Ns/Np} ; Tensione al second. comandata
Vms  n4 n3 0 ; Tensione nulla, serve per misurare la 
corrente
Rss n3 n5 {Rss} ; Resist serie secondario
Lss S1 n5 {Lss} ; Indutt. in serie secondario

84



.ENDS
*
Non compare la capacità al secondario Cs in quanto di solito ha valori trascurabili 
( trasformatori con Vs<<Vp )  .
Nota: I  modelli  di  trasformatori  reali  sin  qui  considerati  simulano  le  perdite  e  il 
funzionamento  in  alta  frequenza.  Tuttavia  se  si  richiede  una  simulazione  completa 
occorrerebbe  valutare  anche  il  comportamento  non  lineare  delle  caratteristiche 
magnetiche del nucleo, in particolare la possibilità della sua saturazione.
Gli esempi sopra riportati suppongono che il nucleo lavori solo nella zona lineare del ciclo 
di isteresi, del resto come deve avvenire in funzionamento normale.
Se il funzionamento del circuito in cui è inserito il trasformatore presupponesse la sua 
entrata in saturazione ( es.: Inverter a saturazione di nucleo ) allora i modelli precedenti 
non sarebbero più utilizzabili. Se vogliamo simulare tali circuiti occorre introdurre nella 
simulazione un apposito sub circuito che simula il comportamento del nucleo.
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12 - APPENDICE D
Simulazione di una batteria

12.1  Creazione di un nuovo simbolo. Batteria
Può tornare utile, quando si esegue una simulazione, disporre del simbolo di una batteria  
per assicurarci  che, almeno a batteria ragionevolmente carica, la tensione fornita sotto 
carico  sia  sufficiente  ad alimentare  il  circuito  che intendiamo realizzare,  senza che si 
creino  abbassamenti  di  tensione  tali  da  rendere  irregolare  il  funzionamento.  Si  tenga 
presente che creeremo solo  il simbolo e non un componente reale dotato di Package da 
disegnare sul circuito stampato; lo scopo è quello di utilizzare il simbolo solo per effettuare 
la simulazione del progetto, così che, a progetto realizzato, saremo sicuri che potrà essere 
collegato a quel tipo di batteria, senza che nascano problemi di funzionamento.
Per creare il nuovo simbolo, si apre un nuovo progetto: M1 su New project > Project file  
name > Batteria. M1 su Single sided PCB with schematic > OK.
Utilizzando l’icona del lapis sulla barra orizzontale, disegnare un simbolo come quello di 
figura e aggiungere i piedini. 

Fig.12.1
Scrivere l’espressione !VALUE richiamando sulla tastiera le virgolette ( ” ) che aprono la 
finestra del  testo.  Poi  nella  casella  Function al  centro  in  basso,  scegliere  Component  
value. OK
Racchiudere  con  M11  tutto  il  disegno  in  un  rettangolo.  Posizionare  il  puntatore 
esattamente sulla crocetta del piedino 1 e premere y. Ripetere e premere x.
Si  apre  la  finestra  Export  Symbol.  nella  colonna  di  sinistra  scegliere  Battery.  Nella 
sottostante casella,  Insert  component  name > English > Batteria.  La casella  Package: 
lasciare bianco in quanto vogliamo solo creare un simbolo.  Component prefix: Br. Save 
component.
Il  simbolo  è  stato  importato  nella  libreria  My  Components.  Aprendo  la  finestra  dei 
componenti si dovrebbe ritrovare la voce Batteria. Nella finestra a sinistra fare M2 nella 
riga di Batteria. Nella finestra che si apre fare M1 in Import component in my component  
list > Libreria personale. Libreria personale è quella che avevamo creato in precedenza e 
dove avevamo inserito tutti i componenti di nostro abituale interesse.

12.2  Limiti del modello di simulazione adottato.
Assegneremo al  simbolo appena creato,  un suo modello di  simulazione,  da noi  stessi 
scritto. Tale modello è molto semplice, ed ha uno schema equivalente costituito solo da 
una  resistenza  interna  fissa  Rint  e  da  una  sorgente  di  tensione  costante  Vi  che 
rappresenta la tensione a vuoto,  cioè a batteria  scollegata.  La resistenza immaginaria 
interna Rint è responsabile  della caduta di tensione della batteria quando è collegata al 
carico. 
In realtà tale resistenza è tutt’altro che fissa, ma dipende almeno dalle seguenti condizioni: 
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• dal tipo di batteria, al piombo, a zinco-carbone, alcalina, agli ioni di litio ecc.
• dal modello
• dalla capacità in A/h della batteria
• dallo stato di carica attuale.
• dalla temperatura

Tuttavia, possiamo notare che ad es.: le batteria alcaline, che sono le più usate nei piccoli  
progetti, mantengono abbastanza costante la loro tensione e resistenza interna durante la 
scarica  per  poi  crollare  bruscamente  a  fine  vita,  per  quanto  riguarda  la  tensione  e 
impennarsi  per  quanto riguarda il  valore della  resistenza.  Inoltre  potremmo trovare un 
modo per misurarla su un campione reale carico, così da ottenere un valore aderente alla  
realtà  almeno  a  batteria  ragionevolmente  carica.  Con  queste  premesse  il  circuito 
equivalente che si propone è il seguente

Fig.12.2

Alla resistenza fissa Rint assegneremo un valore misurato nel seguente modo:
Misuriamo prima la tensione a vuoto Vv di un esemplare carico. Poi collegheremo una 
resistenza Rc di valore noto alla batteria. Misureremo la caduta di tensione a carico Vc, 
quindi scollegheremo subito per non scaricare la batteria.
La tensione a vuoto, meno quella a carico Vr = Vv – Vc rappresenta la caduta di tensione 
sulla resistenza interna, mentre la corrente che circolava era Ic=Vc/Rc.
Il valore della resistenza interna è  Rint = Vr / Ic.
Il valore di Rint trovato verrà inserito nel modello di simulazione e la caduta di tensione 
della batteria, che si avrà quando collegata al circuito di progetto, simulerà molto bene 
quella reale almeno finchè la batteria si mantiene sufficientemente carica.

Esempio: Pila alcalina marca Duracell da 9V, in condizione: carica.

Tensione a vuoto Vv = 9,66V Res. carico impiegata Rc= 105 Ω 
Tensione a carico Vc=9,30V Corrente Ic= Vc/Rc Ic=88,5mA
Rint = (Vv-Vc)/Ic Rint = ( 9,66 – 9.30 ) / 0,0885 = 4,067 Ω

12.3   Scrittura del modello di simulazione.
Scriviamo noi stessi il modello di simulazione, che è quello riportato di seguito, da copiare 
in un file di testo per poi importarlo nel simbolo della batteria.
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Intanto  notiamo  che  nel  programma  di  simulazione  di  Target  non  esiste  un  modello 
primitivo  della  batteria  cui  assegnare  valori  personalizzati.  Dovremo  pertanto,  come 
modello, usare un subcircuito.
*
**************************************************
* Modello approssimato di batteria
* 
.SUBCKT Batteria p n PARAMS: Rint=1 Vv=12
Rint p x {Rint}
Vv   x n {Vv}
.ENDS

Breve spiegazione:
Una  riga  che  comincia  con  l’asterisco  viene  considerato  commento  ed  ignorata  dal 
programma.
Dopo la scritta  .SUBCKT segue il suo nome (  batteria), i piedini di collegamento con 
l’esterno  (p,n)  e  i  parametri  PARAMS: usati  nel  subcircuito  Vv e  Rint cui  dovranno 
essere assegnati i valori effettivi.
Le righe successive contengono il nome del componente interno al subcircuito (  Rint, 
Vv ) seguito dai nodi di collegamento e dal suo valore che può essere, come in questo 
caso  assegnato  direttamente,  oppure  ottenuto  tramite  espressione  matematica  fra 
parentesi graffe. Si noti il nodo interno ( x ) che collega in serie Rint e Vv.
Infine .ENDS chiude il  modello

12.4  Assegnazione del modello al simbolo
Nella  finestra  dei  componenti  selezionare  Batteria.  Nella  riga  di  Batteria  fare  M2  > 
Symbol,package,3D,simulation > Edit simulation. Si apre la finestra Model for batteria.
M1 su Search>M1 su freccia blu destra > Reload from > Files with Pspice model. Cercare 
il file di testo ove è stato copiato il modello e aprire. Nel pannello di destra appare il nome 
Batteria.  Nella  casellina  di  spunta  accanto  fare  click  M1  >  Import. Rispondere  si  al 
messaggio Now refresh e chiudere. 
Nella finestra principale Models for batteria selezionare Select > Device Subcircuit. ( icona 
con quadretto nero e ingressi rossi ai lati ) Nella casella Subcircuit cercare il nome Batteria 
e selezionarlo. Con questo si è importato il modello batteria nel simbolo. 
Pinassignment  :  trascinare 1 da sinistra  nella  casella  gialla  a destra,  davanti  a  p  e 2 
davanti a n. Il modello è ora perfettamente operante.
Chiudere tutte le schede.
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12.5   Simulazione
Disegnare lo schema elettrico seguente. Per la resistenza ne occorre una già dotata di 
modello di simulazione come la R_carbon_100-ohm_0207cui modificheremo il  valore in 
105 ohm.

                                        
Fig.12.3

Assegnare un nome intuibile al conduttore che va da +batteria a resistenza, facendo M11 
su di esso.
Aprire la simulazione. Assegnare 10s nella casella Simulation for seconds.
M1 sulla casella Edit selection. M2 > Add > Voltage against ground.
Selezionare la tensione della batteria. Poi, per la corrente che scorre in R1 selezionare 
current. M2 su tensione e corrente e M1 su  Show immediately.  M1 su Start simulation. 
Deve apparire la seguente immagine.

Fig.12.4

Si osserva la tensione a carico di 9,30V come da aspettativa, e una corrente non leggibile. 
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Per leggerla occorre fare M1 su View > Graph, e deselezionare la tensione. Quindi View > 
Zoom e inserire il campo 80m - 100m.

Fig.12.5

La corrente che appare è circa 88,5 mA come calcolato. 
Possiamo ora assegnare a R1 un valore diverso, ad es.: 470 Ω. Otterremo una caduta di 
tensione di circa 9,55V, mentre la corrente che leggeremo è 20,5 mA che potrebbe essere 
quella di un circuito da noi progettato, ove questa  batteria è stata inserita.

Fig.12.6
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13 - APPENDICE E
Modelli di simulazione complessi

( Capitolo riservato a chi ha già acquisito le nozioni precedenti )

13.1 Introduzione
Ci proponiamo in questo capitolo di scrivere noi stessi un listato complesso, per simulare 
non  un  singolo  componente,  ma  un  intero  circuito  comprendente  elementi  passivi  e 
amplificatori operazionali. Vorremmo a titolo di esempio scrivere il listato di un intero filtro  
audio attivo del secondo ordine, contenente al suo interno alcune resistenze, capacità e 
un amplificatore operazionale tipo LM358.
Dapprima eseguiremo una simulazione tradizionale su un circuito con componenti discreti.
Poi considereremo lo stesso circuito racchiuso in un perimetro e tenteremo di scrivere il 
listato che lo rappresenta come se fosse un modulo integrato di filtro passa basso con un 
ingresso ed una uscita, e con la possibilità di programmarlo, cioè di cambiare i parametri  
caratteristici, quali la frequenza di taglio e il guadagno dello stadio.

13.2  Filtro audio passa basso del 2° ordine.
Lo schema che vorremmo simulare è il seguente.

fig.13.1

Si tratta di un filtro audio attivo passa basso del secondo ordine, cioè con frequenza di 
taglio a 3 dB e decadimento di 12 dB per ottava. Ciò vuol dire che, salendo di una ottava  
dalla frequenza di taglio, cioè salendo al doppio della frequenza di taglio ( 1 ottava = 2 
volte la frequenza di riferimento ) il segnale di uscita si attenua a 12 dB cioè se in ingresso 
è applicato 1V e il guadagno dello stadio è 1, in uscita, dopo una ottava, il segnale cade a  
0,25V.
Con i valori assegnati ai componenti passivi dello schema, si ottiene un filtro passa basso 
del 2° ordine con frequenza di taglio ft =10 KHz. e guadagno dello stadio A = 1. 
Brevemente con il seguente esempio si forniscono la procedura e le formule di progetto. 
Si fissa la frequenza di taglio ft = 10KHz, il guadagno A = 1, il fattore di merito Q = 0,714 e  
imponiamo C2 = 1nF.
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Si calcolano R3, R2, R1, C1 con le seguenti formule ove le resistenze sono in KΩ e le 
capacità i nF.:

R3
10

3

....4 π ft Q C2  
R2

R3

A 1
R1

R3

A
C1 ....4 C2 Q

2
A 1 10

9

Eseguendo i calcoli si ottengono i valori assegnati nello schema.
Se disegnamo questo circuito e lo simuliamo, in Extended > AC Analysis, otterremo una 
risposta in frequenza come in fig. 13.2

       
Fig.13.2

Come  richiesto,   il  guadagno  per  frequenze  basse  è  unitario,  la  frequenza  di  taglio 
misurata a 3 dB ( cioè ove il segnale cade a 0,707 ) è 10KHz e il segnale, un’ottava sopra, 
cioè a 20KHz cade a 0,25V.

13.3 Net list per modulo di filtro passa basso programmabile.
In alternativa al metodo tradizionale sopra esposto, potremmo scrivere la net list ( listato)  
dell’intero  circuito  con  lo  scopo  di  creare  un  modulo  integrato  di  filtro  p.basso 
programmabile,  cioè  una  scatola  chiusa  con  ingressi  e  uscite  e  con  la  possibilità  di 
impostare i parametri desiderati. 
Il  listato inizia con l’assegnazione di un nome, poi con la dichiarazione dei componenti 
passivi e dei loro nodi; dovremmo quindi inserire l’amplificatore operazionale il cui listato è 
rappresentato da un sub-circuito che dovremo poi alimentare con tensione duale. Infine 
scriveremo  l’istruzione  .ENDS  per  il  sub-circuito  e  END  per  terminare  l’intero  listato. 
Dovremmo poi far acquisire a TARGET il listato che abbiamo scritto.
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E’ a questo punto che ci accorgiamo che il programma accetta solo modelli di componenti 
primitivi, sub-circuiti o insiemi di sub-circuiti ( Device List ) ma non prevede la possibilità di 
acquisire  un  intero  listato.  Non sapremmo come farglielo  accettare,  e  se  ci  proviamo 
inserendolo come sub-circuito, il  programma lo taglia facendo apparire solo la parte di  
listato del sub-circuito.
Se siamo determinati e vogliamo comunque realizzare questo modulo integrato di filtro, 
dobbiamo aggirare il problema e seguire le regole di TARGET. Separeremo lo schema in 
due parti  ciascuna delle quali  rappresentata da un sub-circuito.  Andremo a creare un 
nuovo  componente  complesso  realizzato  da  un  rettangolo  con  terminali  di  ingressi  e 
uscite. In questo nuovo componente inseriremo come modello di simulazione, non un sub-
circuito, ma due sub-circuiti, possibilità già prevista in Select > Device List.  

13.4  Scrittura del sub circuito della rete di componenti passivi.
Nella figura seguente è rappresentato lo schema di fig.13.1 in cui i componenti passivi 
sono stati separati dall’ampl.operazionale e inseriti in un rettangolo tratteggiato, mentre il 
solo oprazionale in un altro.

Fig.13.3
Ciascun rettangolo sarà rappresentato da un sub-circuito.
Nello schema sono riportati anche i nodi che impiegheremo nella scrittura dei sub-circuiti,  
e i reciproci collegamenti.
La net list della rete di componenti passivi è la seguente:
*
*
*********Filtri attivi del 2° ordine*********
***********Filtro passa basso****************
********Rete dei componenti passivi *********
*
.SUBCKT RetePbasso in GND out b PARAMS: f=10K A=1 Q=0.714 C2=1nF 
*
R3 a out  {1/(4*pi*f*Q*C2)}
R2 a b    {1/((4*pi*f*Q*C2)*(A+1))}
R1 in a   {1/(4*pi*f*Q*C2*A)}
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C1 a GND  {4*C2*Q^2*(A+1)}
C2 b out  {C2}
.ENDS

Spiegazione: Come si vede dallo schema, il sub-circuito ha 4 nodi: in, GND, out, b.
I parametri che imposteremo sono la frequenza di taglio f, il guadagno dello stadio A, la 
cifra di merito Q e la capacità C2 che fisseremo con valore arbitrario eventualmente da 
correggere  successivamente.  La  cifra  di  merito  Q=0,714  è  il  valore  ottimale  per  una 
risposta piatta senza picco di oscillazione sul finale, vicino alla frequenza di taglio.
Seguono le dichiarazioni degli altri componenti con il valore ottenibile dalle formule sopra 
menzionate. Pi greco ( π ) si scrive pi.

13.5  Sub-circuito dell’amplificatore operazionale
TARGET contiene tra i suoi componenti l’operazionale LM358 già completo di modello di 
simulazione.  Potremmo  utilizzare  questo,  già  disponibile,  oppure  cercare  sul  web  il 
modello più completo della National o un diverso tipo. Per ora useremo il  modello già 
contenuto in TARGET il cui listato è riportato di seguito solo per evidenza.

Dopo il nome LM 358 vengono forniti i nodi del modello 1, 2, 3, 4, 5. La corrispondenza dei 
nodi  tra  modello  e schema ( pinassignment )  purtroppo non è fornita  in  chiaro.  Verrà 
svelata, nel paragrafo 13.7 dove dovremo eseguire i collegamenti.
Disponiamo adesso dei due sub circuiti che ci permetteranno di creare un unico modulo di 
filtro.
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13.6  Creazione di un nuovo componente: Filtro P.basso integrato.
Dobbiamo ora creare un nuovo componente che è un modulo di filtro p.basso, realizzato 
inserendovi e collegando tra loro i due sub circuiti resi ora disponibili.
Si parte dal disegno del modulo dopo aver aperto e salvato un nuovo progetto.

                  
Fig.13.4

Si riconoscono le nomenclature dei nodi cui è stata assegnata una numerazione da 1 a 7.
Abbiamo dovuto sdoppiare il nodo b – inv  ( vedi schema fig.13.3 ) Infatti non è eliminabile 
perché esegue il collegamento dei due sub-circuiti e perciò deve essere menzionato, ma 
se si accomuna in uno solo, crea dei problemi di simulazione. Collegheremo esternamente 
il nodo b con inv.

13.7  Inserimento dei modelli di simulazione nel modulo
Dobbiamo a questo punto inserire nel nuovo componente i due sub-circuiti.
Copiamo  nel  Clipboard  il  listato  della  rete  riportato  a  pag.91,  poi  apriamo  la  finestra 
Components (  Tab F2 )  e  cerchiamo il  Filtro Pbasso integrato che abbiamo chiamato 
RetePbasso. M2 nella sua casella a sinistra >  Symbol, package, 3D, Simulation > Edit  
simulation model  > Search  > Freccia blu di  destra >  Reload from > Clipboard .  Deve 
apparire  il  nome  “RetePbasso”  preceduta  da  una  casellina  grigia.  Se  fosse  rossa  ci 
sarebbero  degli  errori.  M1 >  Import.  Il  modello  viene acquisito  in  libreria  e  passa nel 
riquadro di sinistra. Vi saranno messaggi vari di refresh da accettare.
Il primo sub-circuito è stato sistemato. Per quello dello LM358 controllare che sia presente 
scorrendo la lista nello stesso riquadro di sinistra.
L’inserimento dei due sub-circuiti nel modulo avviene con M1 su Select > Device list > Add 
> icona del sub circuito Device sub-circuit della lista dei Modelcards. Cercare nella casella 
Subcircuit il  nome RetePbasso e fare M1.  Poi  M1 su  Pinassignment e  si  eseguono i 
collegamenti  tra i  piedini  numerati  del modulo e i nodi della rete per trascinamento da 
sinistra a destra.
La corrispondenza è la seguente:

Piedini del modulo > Nodi del listato
2 in
7 GND
5 out
1 b

Salvare > OK.
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E’ giunto il momento di inserire il modello dell’operazionale LM358. Tornare nella finestra 
Model as a list of submodels. > Add > Device subcircuit > cercare LM358 e fare M1. Poi 
M1  su  pinassignment. Eseguire  i  collegamenti  come  fatto  prima  seguendo  la 
corrispondenza seguente:
Nodi dello schema elettrico Assegnazione
Nome  N° pin schema Nodi> Modello LM358

b 1 7   > 1 Ingresso non invertente
In 2 1   > 2 Ingresso invertente
Inv 3 4   > 3 Vp alimentazione +
Vp 4 6   > 4 Vn alimentazione -
Out 5 5   > 5 Uscita 
Vn 6
GND 7
Salvare e chiudere la  finestra della  simulazione.  Il  modulo è ora dotato di  modello  di  
simulazione.

Fig.13.5

13.8  Collegamento del modulo e collaudo.
Il  modulo  creato  come nuovo componente  integrato  dovrà  essere  collegato  al  mondo 
esterno come da schema precedente ( fig.13.5 ) che eseguiremo dopo aver aperto un 
nuovo progetto.
La resistenza R1 è necessaria solo per disporre del collegamento di  uscita, ma il  suo 
valore non influenza il funzionamento.
Abbiamo inserito le due sorgenti di tensione continua duali che vanno collegate ai piedini  
corrispondenti del modello e forniscono l’alimentazione all’operazionale in esso racchiuso.

96



E’ giunto finalmente il momento di eseguire il collaudo.
Alla  tensione sinusoidale in  ingresso assegnare 1 V sia  ad  AC magnitude  che a  VA. 
Frequenza  F=1KHz.
Sostituire il nome del collegamento di uscita con out e quello di ingresso con in.
Aprire la simulazione tipo Standard. In  Extended settings assegnare 10m-5m-5u-50u e 
deselezionare le condizioni iniziali.  M1 su  Edit selection > M2 su  Add > M1 su  Voltage 
against ground > out.
M1 su Start simulation. Deve apparire una sinusoide con ampiezza di 1V.
Si passa ora alla simulazione della banda passante.
Extended > AC analysis > Edit > Start frequency = 0 > End frequency = 20KHz > N° freq.  
points = 100.
Se tutto è andato bene dovrebbe apparire l’immagine sottostante ( fig.13.6 ) identica alla  
13.2, a conferma che abbiamo realizzato un modulo corretto.

 

Fig.13.6
 
Possiamo  anche  provare  a  cambiare  i  parametri  che  lo  governano,  quali  la  banda 
passante e il  guadagno. Fare M11 sul modello, poi  Simulation value > Edit > M11 su 
Device subcircuit ModPbasso. Impostare i nuovi valori sostituendo quelli di default.

97



13.9   Modulo di filtro passa alto.
Se  siamo  soddisfatti  di  quanto  fatto  finora  possiamo  anche  realizzare  facilmente  un 
modulo di  filtro  passa alto.  Sono forniti  di  seguito  lo  schema elettrico  e  le  formule  di 
progetto.

Fig.13.6

C2 C1 C3 .C1

A
10

9 R1
10

3

.....2 π f Q 2
1

A
C1 R2 .

..Q A 2
1

A
...2 π f C1

10
3

Capacità espresse in nF e resistenze in Kohm.
Per il progetto si fissa la frequenza di taglio f=10K, il guadagno A = 1, la cifra di merito Q= 
0.714 e si fissa arbitrariamente C1 = 1nF.
Possiamo quindi passare alla simulazione, prima di tipo standard poi Extended e 
visualizzare la risposta in funzione della frequenza.

Per creare un modulo di filtro passa alto come nel caso precedente si fa copia del 
componente “Filtro Pbasso integrato” e si modifica solo il nome del componente e nel 
disegno dello schema elettrico si sostituisce la scritta in alto con  “ Filtro P.alto integrato”.
Si sostituisce il sub-circuito solo per la rete dei componenti passivi perché quello 
dell’operazionale è identico. La net list è la seguente:

*
*
*****Filtri attivi del 2° ordine***
********Rete passa alto************
*
.SUBCKT RetePalto in GND out b PARAMS: f=10K A=1 Q=0.714 C1=1nF 
C2=1nF 
*
C1 in a    {C1}
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C2 a b     {C1}
C3 a out   {C1/A}
R1 a GND   {1/(2*pi*f*Q*(2+(1/A))*C1)}
R2 b out   {(Q*A*(2+(1/A)))/(2*pi*f*C1)}
*
.ENDS

La simulazione AC fornisce il seguente grafico della banda passante

   
Fig.13.7 

La frequenza di taglio a 3dB ( 0,707 vi ) accade a 10KHz come da richiesta  e il guadagno 
è unitario.
Per vedere la pendenza della banda passante per bassi valori della frequenza, impostare  
nella analisi AC i seguenti valori
Extended > AC analysis > Edit > Start frequency =0 > End frequency = 10KHz > N° freq.  
points = 100.
Si vede ( fig.13.8 )  che a 10KHz il segnale cade a 3dB ( 0,707 vi ) e ad una ottava sotto, 
cioè a 5KHz il segnale cade a 0,25 vi, essendo un filtro del 2° ordine.
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Fig.13.8

I due moduli, alto e basso possono essere collegati in cascata e programmati per formare 
un filtro passa banda programmabile.
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